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Chapter 1:  Introduction 

 

Introduction 
In this chapter 

Installing PrintSmith 8
Setting the User Environment 8
Starting PrintSmith 9

 

 

This guide is designed to assist you in setting up PrintSmith. There are many ways to set up and 
use PrintSmith. The following recommended set up is one of many correct ways to set up and use 
PrintSmith. 

The vast majority of the set up process depends on your pricing theories and methods. PrintSmith 
supports many pricing methods that can help you price to your marketplace. The goal of this guide 
is to help you set up PrintSmith for use in your business. 

Setting up PrintSmith takes approximately 40 hours of your time. This time can be improved upon 
with automated input of your customers’ names, addresses, account balances, etc. If you have 
your customer information in a computer database, we may be able to import that data for you. To 
import the data we need to have a tab delimited ASCII file of that information. Call PrintSmith for 
pricing and turnaround time. 

You should plan on several 3-4 hour sessions and be able to complete at least one major task per 
session. 

Throughout this guide, we illustrate the steps you should follow in setting up PrintSmith. The most 
common types of illustrations are screen captures of menu selections and active windows.  

The tasks that need to be accomplished are: 

• Setting System Preferences (see page 11) 

• Modifying Prices - press definitions, copier definitions, charges and stocks (see page 65) 

• Entering Customer Information (see page 171) 

• Going “Live” with PrintSmith 

Visit our web site at http://www.printsmith.com or call or email our EFI PrintSmith Customer 
Support line - we’re here to assist. 

EFI PrintSmith Customer Support - Email: printsmith.service@efi.com Phone: 888-731-2618 
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Installing PrintSmith 
PrintSmith is very simple to install and should take just a few minutes. Refer to the PrintSmith 
Installation Guide for detailed instructions on how to install all PrintSmith products. 

 

Setting the User Environment 
There should only be one PrintSmith application on your hard disk. If you would like to start 
PrintSmith from another place on your computer, create an alias (on the Macintosh) or a shortcut 
(in Windows) of the PrintSmith application. 

Creating a Macintosh Alias 
To create a PrintSmith alias: 

1. Select the PrintSmith application by clicking on it once. 

2. In the File menu, select Make Alias. A file with the same name as the PrintSmith 
program is created with the word alias after the name. Also note that the name of the 
file is in italics. 

3. Drag the alias icon to the location you desire: Desktop, Apple Menu Items, or 
Launcher. Placing the alias in the Startup folder is not recommended. 

 

Creating a Windows Shortcut 
To create a Windows shortcut: 

1. Select the PrintSmith application by clicking on it once. 

2. Click the right mouse button and select Create Shortcut from the menu. 

3. Drag or send the Shortcut icon to the location you desire: Desktop, etc. 

4. During the installation a shortcut is placed in your Start Menu under Programs > 
PrintSmith. 

You can use these procedures to put aliases or shortcuts wherever you find it convenient. To start 
PrintSmith simply double click the application or an alias/shortcut of the application.  

Note:  Never move the application from the PrintSmith Folder. If you need or want it elsewhere, 
always create an alias / shortcut. 
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Starting PrintSmith 
To start PrintSmith: 

1. Double click on the PrintSmith Application  icon within the PrintSmith Folder or your 
PrintSmith alias/shortcut (if you created one). Following a splash screen, the PrintSmith Log In 
window opens. 

 
Note:  If you receive a message about PrintSmith shutting down in x number of days the security 

device is not installed properly or you are using beta software.  
2. Leave the User ID and Password fields blank. PrintSmith ships with a disabled security 

system. Initially, you are not required to enter a User Name and Password. As part of the 
setup, you enable the security system, restricting the ability to access PrintSmith without 
entering a user ID and password. 

3. Click the OK button to enter PrintSmith. The PrintSmith Menus are displayed at the top of the 
screen. 

  

Note:  You may get a message referring to the last time you performed a Daily Closeout. Click 
the OK button to acknowledge the message. 
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System Defaults 
In this chapter 

Sales Tax or Value Added Tax (VAT) 11
Preferences 16
Table Editor 54
Default Waste Chart 60
System Security- User Definitions 61
Security Setup 62
Keyboard Shortcuts 63

 

 

Setting the system defaults should be completed first since these defaults are used throughout 
PrintSmith. After defining the system defaults, the remaining set up steps can be completed in any 
order. 

PrintSmith has several global variables you need to define. Since a new installation of PrintSmith 
has several of these defaults set up for you, you may only need to review the settings. In other 
cases you may need to change or define the settings to match you business practices.  

The system defaults are under the Admin and Pricing menus. These system defaults reside in 
several places within the PrintSmith Folder. 

Sales Tax or Value Added Tax (VAT) 
In order to properly calculate and report your sales taxes, you need to define your tax rates within 
PrintSmith. If you do not charge and collect sales tax, you should review the settings to ensure they 
are set to collect no tax (zero). 

This section covers: 

• Defining standard/default sales tax set up 

• Creating new tax tables to handle multiple tax jurisdictions 

• Addressing international and other tax issues 
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Defining Standard/Default Sales Tax 
The standard/default tax table can apply to everyone. Typically, the standard sales tax set up is all 
that you need to complete. However, if your business uses multiple tax jurisdictions or is 
international, you need to define these additional tax set ups. 

1. Select Sales Tax from the Pricing menu.  The Sales Tax window opens. The table 
that appears when you select the Sales Tax command from the Pricing menu is the 
Default tax table. All taxable invoices and customers use the Default table’s rate 
unless another tax table is assigned to an account, invoice, or estimate. 

 

 

Sales Tax Window 

 

The Tax Table ID field is a two 
character tax table identifier for 

the Tax Table selected in the 
Tax Table drop down field. 

The Tax Table drop down field 
provides a list of all defined tax 

tables. When the window is first 
opened, the Default tax table is 

selected. 

The Show checkboxes 
determine whether the line 
in the table is to be shown 
separately on an invoice or 
estimate. 

The Description field is the 
explanation of tax items, which 

is displayed when the Show 
button is enabled. Total Effective Tax Rate for 

this table is calculated using 
the line items. A Minimum Taxable 

Amount can be defined. 

 

2. Verify that the Default tax table is selected in the Tax Table drop down in the Sales 
Tax window. The Default tax table has no ID. Since the Default tax table is selected 
when the window first opens, the Tax Table ID field is empty. 

Note:  The default tax table is used whenever tax needs to be calculated and a special 
tax table is not specified. The default tax table is the most commonly used tax 
rate. You attach special tax tables in a customer’s account record and in the 
Document Totals window of an open document.  

3. Check the Tax Shipping option if the shipping amount entered in the Document 
Totals command in the taxable subtotal should be taxed. This setting does not apply 
to charge definitions used for shipping charges. For these charges, you can indicate 
when they are taxable using the Taxable button in the Charge Definition window. 

4. Check the Tax on Tax option if your tax district taxes other taxes. Normally, 
PrintSmith adds the rates in the tax table together to come up with the effective tax 
rate. If you check this option, PrintSmith calculates each of the tax rates. For example 
if the first rate were 6% and the second rate were 5%, the effective rate would be 
11.3% as PrintSmith would add 0.3% which is 5% of 6% (the first rate). 
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5. Check the Build Tax in Price option if you want to hide tax in the price for items and 

never show it separately. Enabling this option is one part of this set up – it tells 
PrintSmith to calculate and include the sales tax in each price of a price list.  

6. Enter up to five line items that are used to calculate the Effective Tax Rate. You can 
breakdown each tax table into five line items, such as City, State, County, Special 
Assessment, etc. Each line item consists of a Description, Tax Rate, and whether or 
not to Show the item on the invoice or estimate. 

Note:  Consider adding a small charge for chemicals and materials used, the same way 
an automobile company charges for small miscellaneous materials. Consider 
collecting a charitable donation on each sale.  

7. Verify the Effective Tax Rate. This rate is calculated based on the line items defined. 
If this rate is not correct, adjustments must be made to the line items. 

8. Set the Minimum Taxable Amount. 

Note:  A tax details report is available for any time period. Enter each differing tax you 
want to track separately.  

 

Creating New Tax Tables to Handle Multiple Tax Jurisdictions 
If you have more than one tax structure, you need to create additional tax tables. For each 
customer account with special tax requirements, a special tax table can be created and assigned to 
that account. You can also change the default tax table on any invoice or estimate to reflect special 
requirements.  

Note:  There is a practical limit of tax tables that is around 40 depending on other files added to 
the Prices folder. 

Example: A business in California has taxable and non-taxable customers. Some of these 
taxable customers have differing tax rates due to their government status or other special 
circumstances. The business is based in Los Angeles and when it delivers jobs to customers 
in Orange County, a different rate must be charged. Using different tax rates can be 
accomplished by adding an OC (Orange County) tax table. This tax table can be assigned to 
customers in Orange County. This tax table is also available to assign to an invoice or estimate 
for walk-in customers who reside in Orange County. 

To add a new Tax Table: 

1. In the Sales Tax window, enter a two (2) character name in the Tax Table ID field for 
the Tax Table to be added. The name of a Tax Table must be unique.  

2. Press the Enter key on the keyboard. The system searches for a Tax Table with the 
name entered. If no table exists, a prompt is displayed. 

3. Click the OK button. The new Tax Table is created. 

4. Enter the necessary tax information. 

5. Click the OK button when complete. 
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Once the new tax table is created, assign the tax table to each customer who uses this tax rate in 
the customer’s account record or in the actual document. To do this, enter the Tax ID in the Tax 
Table ID text box in the Accounts window and/or the Tax Table field in the Document Totals 
window. 

Note: For information on how to assign a tax table to a customer account, refer to the Tax Setup 
section, page 178. 

Using Tax Codes to Track Differing Groups with Similar Rates 
If you find that you have several taxes that are the same rate but for differing institutions, counties 
or other organizations, consider assigning tax codes in customer accounts and documents to track 
the differing groups.  

Example: You might have three counties in your state that all collect 8% tax. You could create 
one tax table at 8% and enter differing tax codes for the three counties for each customer and 
or document. Using different codes would present a report showing the amount of sales tax 
collected for the 8% rate and sub total for each tax code.  

Addressing International and Other Tax Issues 
Because PrintSmith is used throughout the world, there are many different options as to how tax is 
calculated, reported, and displayed. International customers may require tax on tax and variable tax 
rates. Some Canadian customers need to calculate PST and then add GST on top of that tax. Chile 
also has special tax verification procedures. Currently, you must create a separate tax table for 
each different tax rate. 

Note:  In simple tax situations, all of the check boxes are disabled, which is the norm throughout 
most of the United States. 

Using a Tax Rate of Zero 
It is not recommended that you set up tax tables with tax rates of 0% to handle tax exempt 
accounts or documents. Instead, use the No Tax button in the document totals area of the 
document or enable the Tax Exempt feature in the customer’s account. However, if you want to 
track a certain category of sales, you can use a tax table or tax code, which is assigned in the 
customer account or on individual documents. 

Note:  If you set up a 0% tax rate, the amounts are still considered taxable although no tax is 
calculated. This approach complicates the figuring of sales tax, as these sales are 
considered taxable with a zero rate tax. 

Showing More Than One Tax Rate on a Document 
When indicating more than one tax rate on a document, check the Show option for each separate 
tax you wish to display. Selecting this option also applies to receipts printed with the optional 
receipt printer. If there are additional taxes that are not marked as shown, they are grouped 
together in the standard tax amount. 

Multiple tax lines are computed for each document when the document is printed, and are not 
saved with the document, meaning that if you print an old locked document and the tax rate is 
different from when the document was last printed, the tax amounts for each line will not be correct 
although the total amount of tax will be. 

 
Page 14 



Chapter 2:  System Defaults 

 

Showing Taxes with Different Names 
In Document Preferences, there is a Print Tax Name From Table option in the Page panel. This 
prints the table’s description name on the document where Tax is normally displayed. Enable this 
feature to print the descriptions from the tax table. 

Printing the Tax Rate on Documents 
To display the actual percentage on a document, type the tax rate in as part of the description. 

Hiding Taxes in Prices 
If you decide to hide tax, make sure that you only have one tax table. You must enable the Build 
Tax in Price option so that prices are consistently shown with tax.  

In Document Preferences, you must: 

• Enable the Remove Tax Line option in the Page panel. 

• Enable the Hide Tax in Line Items option in the Body panel. 

In Preferences > POS > Receipts, you must also enable the Hide Tax in Line Items option so the 
receipt printer also hides tax in prices when it prints. 

Canadian Shipping Taxes 
Some provinces in Canada tax shipping differently. To support this, a special Canadian Shipping 
checkbox has been added to the tax table. Since it is somewhat unusual, it is only displayed if you 
hold down the <option> or <alt> key when selecting the Pricing > Sales Tax command. 
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Preferences 
The Preferences panel is where default rules are established. Preferences define: pricing, 
customer provided stock, blank stock, global paper markups, quantities for price lists, international 
settings (currency and numbers), etc. Preferences also includes many other system defaults.  It is 
recommended that you review all of the Preferences before you start using PrintSmith. Not all 
preferences are applicable to your business. However, you should consider each preference and 
its effects on your PrintSmith system. Preferences can be changed anytime. 

Note:  Some preferences are global while others are local preferences. This differentiation is only 
relevant in multi-user systems. Global preferences affect the master and all connected 
workstations. Local preferences can be modified and impact individual workstations. 

To open the Preferences window, select Admin > Preferences from the main menu.  Preferences 
are grouped into the following four areas: System, POS, Estimator, and Accounting. 

Defining System Preferences 
These system defaults establish rules about behavior, networking, company information, numbers, 
alternate currency, and international settings. 

Appearance 
The Appearance preference panel controls font usage and other aspects of PrintSmith’s overall 
appearance. 

 
Some customization of PrintSmith’s general appearance is possible by selecting the fonts and 
colors used. In some countries, it is desirable to use fonts other than the standards in order to 
provide characters or alphabets that are not supported by the underlying operating system. 

To reset the Appearance window to its initial settings, hold down the <alt/option> and <shift> keys 
when clicking on the Appearance item. 
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The following guidelines have been established for what you can do safely within this window: 

• Change the prompts on some edit fields to a different color. 

• Change the background color of the Account Info window when it’s opened with a Prospect 
Account selected. 

• Change any of the fonts to a different font of the same size. 

What you should NOT do: 

• Change a small font so it is bigger than a larger one. (Same size is OK.) 

• Change fonts to much larger sizes, (e.g. changing the Small Font to 18 points). 

• Make dramatic changes to fonts while other windows are open. 

 

Behavior 
In the Behavior panel, you can automatically invoke the User Log In command to sign people off 
the system in either a timed increment or upon execution of a Post command (cash register 
posting). Elimination of some warning messages is suggested after you have used PrintSmith for a 
while and no longer need these messages. 

Note: Having PrintSmith quit at a certain time, ensures that a complete backup is performed on 
a Windows master. 

 
Only Post Invoices Marked Ready 

When this option is selected, only invoices that are marked “ready for pick up or delivery” in the 
location window can be picked up. 
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Eliminate Some Warning Messages 

Warning messages that are useful when first using PrintSmith may become unnecessary in time. 
Enabling this feature eliminates the following most common messages: 

• Warnings at start-up about dates and doing daily closeouts. 

• Warning that documents and job tickets have already been printed. 

• Warning that the document is locked. 

• Asking if you want to print job tickets for invoice level charges (it always prints them). 

Initialize Printer Before Each Use 

This option resets the printer settings between items to be printed.  If it is not enabled, the printer 
setting remains from the last item printed.   

Note: This option applies to PC only. 
Enable Automatic Sign On 

This option ensures that everyone is signing in and that only the appropriate people have access to 
Admin functions (based on user security set up). When enabled, there are two features: 

• Seconds Of Inactivity To Trigger - This option sets an inactivity timer. Enter the number of 
seconds for the timer to run. If the timer expires without any activity (even moving the mouse), 
the Log In window displays. The standard value is 300, giving 5 minutes of inactivity. You can 
change it to anything greater than 4 seconds. 

• Trigger After Posting - This option opens the Log In window after a transaction is posted in 
the Cash Register. This is useful for ensuring that each counter person logs in with his/her own 
user ID for each transaction. 

Show invoices with firm due date of “today” at login 

If this option is selected, the Work In Progress report is displayed upon login when there are 
pending items that have firm due dates that are the same as the date you are logging into 
PrintSmith.   All pending items with Firm Due Dates are displayed in chronological order.   

Enable Automatic Quit 

The Enable Automatic Quit option is useful as a safety feature to prevent access to the system 
after business hours and ensures that backups are always complete. We have found that on 
Windows, many backup programs are unable to back up all files if PrintSmith is running. Enabling 
automatic quit with a shut down time solves this problem. 

Time of Day to Quit 

Enter the time of day for the system to shut down. Prior to shutting down, all users are notified of 
the impending shut down and given time to save their work. 

Shut Down Notification Message 

Enter the text of the message you want sent when PrintSmith is shut down. The standard text 
contains two characters “^0” which are replaced by the shut down time entered in the Time Of Day 
To Quit field. You can enter characters in as many times as necessary or leave them out entirely. 

Note:  Shut Down Notification is a local preference. 
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Company 
The Company panel is used to enter your company information. PrintSmith uses some of this 
information as the remittance address in the statement generator.  It is also used as the From 
address in the Delivery Ticket. 

 
Note: Company is a global preference that is established at the master only. 
 

 
Page 19 



EFI PrintSmith 7.2 │ Set Up Guide 

 

Business Calendar 
The Business Calendar panel allows for a fiscal year or a calendar year.  Additionally, work days 
can be set. 

 
 

Fiscal year starts first day of 

Select a month from the dropdown list.  This sets the current range of the fiscal year.   

Current Range 

Based on the month selected, the range for the fiscal year is displayed. 

Work Days 

Select work days by clicking on the days of the week.  Selected work days are displayed in black. 

Future dates exclude days that company is Closed 

Select this option to have job time estimates calculated based only on work days. 
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Network Setup 
The Network Setup panel determines how your WorkStations communicate over the network. See 
the Installation Guide on networking for more detail on which protocol would be best for your 
operation. In a stand alone environment, select the Disable Networking option. 

 
Note:  Network Setup is a local preference. 
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Numbers 
Unless you are outside of the United States, you most likely do not need to make any changes to 
these variables. If you need to make changes, please refer to the PrintSmith Reference Guide. 

 

Generally, the 
Always Round 
Down and Round 
Tax Up settings 
are off. 

 

There is an option to Round tax up. Generally, this option should remain off. The only case where 
we recommend enabling this option is in the state of Florida, where they have implemented a sales 
taxing system that can not be calculated by a formula but must use a table to look up actual tax 
amounts. The closest we could get to exactly matching their system by formula (based on the State 
of Florida tax departments’ unofficial recommendation) is to round all taxes up. 

Note:  Numbers is a global preference that is established at the master only. 
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Alternate Currency 
The Alternate Currency panel allows you to set up and use another currency system. It was created 
primarily to support the European Common Market currency standard, the Euro. The alternate 
currency system affects invoices, estimates, statements and receipts printed with the receipt 
printer. 

Unless you are in the European Community, you most likely do not need to make any changes to 
the default variables. 

 

Enter the conversion 
factor to ensure your 
system is reporting 
published conversion 
rates. 

 

Use Alternate Currency System 

When enabled, all receipts and amounts on invoices, estimates, and statements display the base 
currency amount and the alternate currency amount. For receipts, the alternate amount is always 
printed below the base currency. For documents, you can place the alternate currency in to a 
separate column or use the same method as the receipt printer. 

Format 

In order for the alternate currency to make sense, it must be formatted properly. In the example 
above, the Euro dollar sign (e) was added to the beginning of the format. 

Note: The Euro sign is surrounded by single quotes. As long as the symbol is surrounded by 
single quotes, it can be placed any where in the format text. 

Conversion Factor 

The conversion factor is a simple multiplier. The base currency amount is multiplied by this 
exchange rate to generate the alternate currency amount. 
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Round To 

If the base currency varies widely from the alternate currency (a very large exchange rate), you 
may wish to change rounding for the alternate currency. To change rounding for the alternate 
currency, enter the number of decimal places to round to. A negative number rounds up from the 
decimal point. For example, “-2” rounds to the nearest 100 units.  

Always Round Down 

Enable this feature if you always round down (remove excess digits and replace them with a zero). 
For example, if rounding to 2 decimal places with this option on, 1.991 and 1.999 both round to 
1.99. Whereas if the option off, they would round to 1.99 and 2.00. 

Note:  Alternate Currency is a global preference that is established at the master only. 
 

International 
The International panel is used for countries other than the United States of America.  

 
Use International Text Sorting 

The Use International Text Sorting option enables a sorting method that considers diacritical marks 
and other language specific constructs and glyphs when sorting. Although more accurate, it is 
much slower and should only be enabled when needed. 

Copy Resale # to PO# in Invoice 

The Copy Resale Number to Purchase Order Number in Invoice feature could be useful as a tool 
for storing contract numbers or long standing purchase orders in the customer account and 
automatically displaying them on invoices and estimates. 
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Use Chile Tax ID Verification 

In order for PrintSmith to be used in Chile, it must verify tax numbers, which are required on all 
invoices. When the Use Chile Tax ID Verification is enabled, PrintSmith enforces a specific format 
for the Resale ID and performs a special Modulo verification. PrintSmith reports the results of the 
Resale number entry as a good or bad Modulo. 

Note:  Use Chile Tax ID Verification is a global preference that is established at the master only. 
Disable Text Styles 

In order to support languages such as Portuguese, Polish, Japanese, Chinese, and Korean, where 
text styles such as bold and italics can render text unreadable (especially in smaller fonts), an 
international preferences panel is available. This preference panel disables all text styling in 
PrintSmith. When enabled, all text styling instructions are ignored. This includes user definable font 
settings. Select the Disable Text Styles option to disable styles such as bold and italics. 

Note:  The Disable Text Style is a global preference that is established at the master only. 
Disable non-taxable options for invoices, jobs, charges 

Selecting this preference disables the taxable checkbox in the Invoice, Estimate, and Charge 
windows.  This option is not intended for domestic use. 

 

Product Activation 
The Product Activation panel is used to activate optional PrintSmith products like Integrated Credit 
Card Processing and the Tracker Module. 
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Fiery Connector  
The Fiery Connector panel supports the Fiery integration. 

 
 

PrintNet Integrator IP Address 

This is the IP address of the machine on which the PrintNet Integrator has been installed for your 
shop. 

Note:   Do not include the port # in the field. 
Fiery Connector URL 

This is the address to which all Fiery messages are sent.  Use this format:  
http://##.##.##.##:9200/jdfConnector/jdfConnector  

Note:   PrintSmith must be restarted for the Fiery Connector settings to take effect. Verify 
communication with the PNI in EFPLA_Log.txt in the root or archive directory. 
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Palm Tracker 
The Palm Tracker panel supports the Symbol Palm Pilot with integrated bar code scanner in 
PrintSmith for updating the locations of jobs. To use it, you should install the Palm Desktop (or at 
least the HotSync manager portion) on a computer with either the PrintSmith Master or 
WorkStation. It could also be installed on a machine without PrintSmith as long as this location is 
available on the desktop of a machine with PrintSmith. 

 
This window specifies the location of the HotSync files and the frequency with which you want 
PrintSmith to check for changes. Once a schedule has been set, it is automatic; any time you 
perform a HotSync, the scan data is loaded into the location you specify, PrintSmith reads it 
automatically and updates the pending list with the new location information. 

Use Palm Pilot Tracking 

This checkbox has no direct affect on whether you can use your Palm units. It controls whether 
PrintSmith checks for any HotSync data. 

Palm User Path 

The Palm User Path field shows the location that PrintSmith checks for HotSync Data. It must be 
set after you have installed the Palm Desktop software. 

Browse 

Use the Browse button to locate the HotSync Application. PrintSmith uses this location to find 
HotSync data used to update job locations. 

Polling Interval 

This value is the time (in seconds) that PrintSmith should wait before checking for HotSync data. 
We recommend a minute as the minimum value. Setting it too low can seriously degrade network 
responsiveness and overall system performance. 
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Create Location File 

If you want your Palm units to display the location of the job, you need to transfer the location 
information to each of them. This button prepares a file and sets it up to be transferred to each 
Palm unit the next time a HotSync is performed. 

Check for Palm Data 

PrintSmith checks for Palm data at the polling interval you have specified. Clicking this button 
immediately checks for new data regardless of polling interval. 

Location Log 

When a location is updated, a log entry is now made which records the new location along with the 
date and time of the change. Report Writer is required to generate reports using the information in 
this file. 

 

Address Formatting 
The Address Formatting panel is used to control the format of addresses. 

 

List of All 
Defined 

Countries 

For Adding, 
Changing, and 
Deleting Countries 

Country 
Used When 
the Country 

Field Is 
Empty 

Sample of How 
the Selected 
Format Looks 
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The data in this window is stored in the Country table and can be modified to some degree in the 
Table Editor. Since this is based on a table, there can be at least 100 separate country definitions. 
Each country has an address layout, which is controlled using this layout editor. 

To use the layout editor, click the Add or Edit button.  The Address Layout window opens. 

 

Enter separator 
text 

 

Each row represents a possible address line. Each column represents address elements that can 
be placed on each line. Between each column is an edit field where you can enter up to 2 
characters of separator text such as a space or a comma with a space. If you do not enter any 
separator between address elements on the same line, there will not be any separation. 

All of the toggle switches have the same pop up menu containing an empty entry, followed by 
entries for all the possible address elements: Street1, Street2, City, State, Zip, and Country. All 
fields are optional. You need only specify the ones you want used in the address format. 
Separators are only used when there is at least one adjacent element being used. Each address 
element can be specified only once - if you choose an element that has already been selected, the 
new selection is accepted. The rest of the layout displays only one of each address element. 
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Defining Point of Sale (POS) Preferences 
POS or Point of Sale functions are controlled by the following preferences. 

Receipt 
The Receipt panel defines the message text and numbering sequence for the optional receipt 
printer. Enter your specific customer information if you are planning on using PrintSmith’s optional 
receipt printer. This panel is used to set the header and footer messages and where you set up 
receipt numbering and tax options. 

 
 

Header 

Enter the text to print at the beginning of each receipt. 

Footer 

Enter the text to print at the end of each receipt. 

Serial Numbers on Receipts Starting At 

Enabling this feature prints a serial number on the receipt. The edit field at the end of this function 
shows the serial number last used to print a receipt. Changing it starts a new sequence. 

Hide Tax in Line Items 

Enable the Hide Tax in Line Items option only if you are setting up the entire system to include tax 
as part of the price instead of showing tax separately. 

Note:  The Hide Tax in Line Items is a global preference that is established at the master only. 
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Cash Drawer 
If you have the optional receipt printer and/or cash drawer, the Cash Drawer panel is where they 
are enabled. Additionally, you can set these options locally at each computer enabling local 
preferences as necessary. 

 
 

If you have a cash drawer and receipt printer attached to a computer, you must select a Receipt 
Printer option from the dropdown list and check the Enable Cash Drawer option. 

Selecting the Print Receipts and Print Invoices options sets the default in the cash register to print 
either document. 

If these devices are connected to a workstation, select the Keep Settings Local option because the 
settings may change during a pricing update. 

All other options should work as set by default.  

Note:  This is a local preference established at each workstation, if the option is enabled. If a 
Cash Drawer and Receipt Printer are connected to the workstation then the Keep Settings 
Local option is recommended. 

 

 
Page 31 



EFI PrintSmith 7.2 │ Set Up Guide 

 

Cash Register 
The nine department keys in the Cash Register window are defined in the Cash Register 
Preference panel. Enter a name, followed by the sales category in which you would like to track 
those sales. The Rate field is designed for a flat rate. This rate is a default which can be overridden 
when the sale is entered in the Cash Register. Only one flat rate can be entered.  

 
Note:  The Cash Register is a global preference that is established at the master only. 
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Pending List 
The Pending List panel is used to customize the appearance of the pending list as it displays in the 
Pending Document window. You can experiment with these settings as much as you want; 
however, they are only updated when the Pending Document window is re-opened. Before 
changing these settings, be sure to close the Pending Document window. 

 

Set the order of 
appearance in the 

list by dragging the 
items up or down 

and selecting 
whether or not they 

are visible. 

Column Setup 

You can change the order in which the pending list columns display: 

• Change the column order in the list by drag and dropping the items 

• Double-click to change items from visible to not visible 

Show Document Type in Number 

Enabling this option includes “E#” as part of the document number for Estimates. If this option is 
disabled, the only way to determine the document type is to show the Type icon or note the color of 
the item. Invoices are shown in blue unless Past Due or Ready for Pickup coloring is on. 

Always Include Past Due Documents in Filter 

Enabling this option shows past due jobs in varying filters. 

Color Past Due Entries 

Enabling this option displays all late documents in the selected color. Those are documents where 
the Wanted By date and time have expired, unless marked ready for pick up or delivery in the 
Location function. 

Past Due Color 

Change the color for displaying past due items. 
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Ready for Pickup Color 

Change the color for displaying items ready for pickup. 

List Font 

Change the font specification for the pending list display here. 

Header Font 

Change the font specification of the column titles in the pending list window here. 

Note:  The Pending List is a local preference, meaning every computer can have a different 
looking pending list on a multi-user system. 

 

Defining Estimator Preferences 
This group of preferences focuses on how the Estimating engine manages sizes, defines product 
codes, organizes stock listings, and displays quantities. 

Estimator Behavior 
The Estimator Behavior panel determines such things as whether or not to close the source 
document after copying, and whether or not the paper calculator will open prior to the job menu on 
all printing, copying, and blank jobs. 

 
Close source document after copying 

Since multiple document windows can be opened at one time, you have the option to have the 
original document close after is has been copied, allowing you to work with the newly created 
document. To enable this option, check the Close Source Document After Copying box. 
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Enter Stock Cost in Estimator 

When enabled, the job window displays fields for the stock cost and units when using the Special 
Order and Customer Stock pricing methods. If the option is turned off, the stock cost and units 
fields are not shown in the Special Order job window. 

Can change address on ALL documents 

When you select the account, the customer name and address field is editable in order to enter the 
customer’s information. This option allows you to change the customer name and address on all 
documents. When the document is filed, the pending list displays the actual company name from 
the selected account. When it is printed the invoice address displays the information you have 
entered or changed. 

To use this effectively, set up your documents to display 2 addresses, the Invoice and Statement 
addresses. In effect, the Invoice address in the document becomes a shipping address and the 
Statement address in the customer account is used as the billing address. If statements are sent to 
a third address, create another customer account with the correct statement address and use it as 
a Master Billing account for statement generation and posting payments. 

Auto show Paper Calculator on new jobs 

When checked, the Paper Calculator opens after the stock is selected if the job method is printing, 
copying, blank stock, or list. 

Always use Stock’s Parent Size 

When this setting is enabled, the Parent Size field is locked on jobs where stock is selected from 
the stock database. Generally, we recommend enabling this setting to prevent the changing of the 
stock’s parent size without changing the cost of the stock. 

Although PrintSmith handles changing the Parent Size as an override, it makes sense to use the 
defined stock size if one is available for stock ordering. Otherwise, you could end up with a stock 
order report with multiple sizes for the same stock number. 

Calculate Re-Order date on invoice copy 

When this setting is enabled, PrintSmith looks for an invoice from history that is identical to the new 
invoice and calculates a date based upon the time elapsed between the new invoice and the 
invoice from history. This date is placed in the reorder field on the new invoice. Typically, this date 
is used to reorder every thirty days, sixty days, or ninety days, and so on. 

Validate sales rep 

When enabled, this setting notifies the user when a document, which contains a sales rep that has 
been removed from the system, is copied to a new document. You are prompted to select a Taken 
By name. 

Leave Folded size empty on new jobs 

When enabled the folded size is not entered in a job. When disabled, the folded size defaults to the 
finish size. 

Do not perform Costing during invoice POST 

Generally, this option is disabled to provide for automatic costing at pickup. If enabled, then only 
costed documents have costing information. Costing can always be updated or changed on any 
document. 
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Auto show Charges on new jobs 

Auto Show Charges option allows you to have the Charges window automatically displayed to the 
user after they tab off of the description field the second time. This feature is designed for new 
users who may forget to view the charges. 

Show (pre 7.1) single pass work and turn option 

Enable this option to show the single pass work and turn option. 

Never use preset press on stock changes 

Enable this option to never use preset press in Stock Definitions on stock changes. 

Add fixed waste for each pass (Affects historic documents) 

Enabling this option adds fixed waste for each pass. 

Add fixed waste for each color (Affects historic documents) 

Enabling this option adds fixed waste for each color. 

Calculate INK by Impressions, includes waste. (Affects history) 

When enabled, ink is calculated by impressions with waste included. 

Note: Please be aware that any changes to the previous three options affects historical 
documents. 

Normal due date (days) 

PrintSmith calculates an automatic due date if the number of future days from the date of the order 
is entered in this field. This feature is also valuable as an automatic follow-up date for estimates. If 
you add 5 days in this field and the 5th day lands on Saturday, PrintSmith sets the due date to the 
following Monday. 

Note:  The Normal Due Date is a global preference. 
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Estimator Printing 
The Estimator Printing panel determines if the invoice will close after the job tickets are printed, 
what the default invoice and estimate will be, and how the payment due date should be calculated. 

 
Close Invoice after printing job tickets 

Check this box to close the invoice window after the Tickets button has been selected to print job 
tickets. 

Close Invoices and Estimates after printing 

This setting determines whether or not an invoice or estimate will remain open after printing. If you 
want a document to remain open after printing it, uncheck this box. 

Default Invoice 

Select a document format to use when printing an invoice. If the customer account assigned to the 
document has a default format selection, the customer setting overrides the system setting. 

Default Estimate 

Select a document format to use when printing an estimate. If the customer assigned to the 
document has a default format selection, the customer setting overrides the system setting. 

Note:  Default Invoice and Default Estimate are local preferences to accommodate differing print 
drivers, printers, and platforms. 

Payment Due Date 

Set the default Payment Due Date to be from a number of days before due, from notified date, from 
completed date, from pickup date, from ordered date, from printed date.  The Payment Due Date 
appears at the bottom of the Invoice under the Total. 
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Paper Calculator 
The Paper Calculator is used in conjunction with pricing methods that require stock. The Paper 
Calculator panel allows you to enter default settings for using the paper calculator. These defaults 
can be overridden when working in the paper calculator itself. 

 
Gripper Edge 

This value is the amount of space required on one feed edge of the run sheet for the press to pick 
up the paper. It may be possible to ignore this due to the placement of the image on the page. So, 
this option should be enabled whenever needed. The size of the gripper edge normally comes from 
the Press Definition. If not specified there, the Paper Calculator preference panel is used. This 
amount can be changed on an individual job in the Paper Calculator window. 

Folio Edge 

This is the amount of space reserved on an edge of the run sheet for a booklet maker. It is used 
when folding signatures to offset the imposed image leaving one edge of the folded signature 
overhanging the other. 

The standard size of this edge is specified in this Preference panel but can be changed for any job 
in the actual paper calculator. 

Gutter 

This is the space between multiple images on a sheet. The first value is the vertical gutter; the 
second is the horizontal value. A gutter is most often used to add space in a folded piece. 
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Bleed 

A bleed is a specification that requires an oversize run sheet so that the ink can run off the edge of 
the final sheet. It generally increases the number of cuts, since the bleed must be trimmed off each 
finished sheet in addition to cuts needed to separate each image. You can specify the required 
bleed differently for each edge. 

Note:  Bleed is a global preference that is established at the master only. 
White Space 

The White Space field allows you to define the unused part of the run sheet when the image area is 
smaller than the run size.  

Always Attach Cut Diagram to Job Ticket 

This option attaches the cut diagram to the job ticket. This preference default can be changed in 
the Paper Calculator window. After a job is filed, the settings return to the default from the Paper 
Calculator Preferences panel. Double-clicking on the diagram opens an expanded view of the cut 
diagram. 

The gray area showing waste is an approximation and may not be accurate for large numbers of 
sheets out due to rounding of the sheet dimensions for display. 

Color Bar Width 

A color bar can be added to the to the cut diagram. The Color Bar Width field is used to specify the 
width to use for the color bar. You can control the edge used for the color bar even if you do not 
need or want to change the space for a gripper edge. After a job is filed, the settings default back to 
the Paper Calculator Preferences panel. 

Note: This is the only place this value is set.  It cannot be adjusted in the Paper Calculator. 
Back Trim, Parent 

If you plan to trim the edges from all four sizes of the parent sheet, enable the Back Trim, Parent 
option. It adds four cuts to the parent cut and centers the run sheet in the parent sheet. 

Trim 4 Sides 

The Trim 4 Sides option is similar to a back trim, except that it is applied to the run sheet. 
Frequently on large format presses, the entire image is centered on the plate in order to obtain the 
best ink coverage. After printing, the press sheet is trimmed down to remove the edges and 
ensures that the sheet is square before any other finishing is performed. 

Work and Tumble 

Enabling this option changes the cut out diagram for tumbling by showing two gripper edges and by 
changing the title of the Work & Turn option in the job window to read Work & Tumble. Should the 
other job specifications support Work & Tumble, that feature is manually selected in the job 
window. 

Except for a possible change in the number of sheets out due to the additional gripper edge, no 
other change to pricing is made as a result of this. If the other job specifications support Work & 
Turn, the option can be enabled in the job window to change the way the job is estimated from 
Sheetwise to Work & Tumble (or Work & Turn if this button is disabled.) 

 
Page 39 



EFI PrintSmith 7.2 │ Set Up Guide 

 
Grain Direction Options 

Grain Direction Options 
Options Effect 

  

Neither Grain direction is ignored and a best fit strategy is utilized without considering 
the possibility of rotating any sheets. 

Match Grain Grain direction is matched by forcing the calculation to base the sheets out on 
the order in which length and width are specified. Sheets are never rotated to 
improve the number of sheets out. 

Swing / Combination This uses a best fit strategy where sheets may be rotated in differing alignments 
to maximize the number of sheets that may be cut out. 

  

 

While the accuracy of the diagram and the number of cuts for each sheet is generally quite high, it 
may not be exactly correct in all circumstances. It is often possible to cut a particular sheet in many 
different ways to obtain the same results. The paper calculator shows only one way for each 
combination of sheet sizes and option settings. No allowance is made for the size and capability of 
the cutter, the operator, the length of the job, or the required precision. Therefore, the number of 
cuts for the run and finish size sheets should be considered proposals. If you wish, you can change 
the number of cuts for each sheet by overriding the number of cuts in this window. 

Note:  The number of cuts calculated in the paper calculator is used for both pre-press and 
bindery cutting charges. Overriding the number of cuts affects the cutting charges. 

Crouser or List Pricing 

When the Crouser or List pricing method is used, the Paper Calculator displays when you pick a 
stock. The Auto Show Paper Calculator On New Jobs option must be enabled in the Estimator 
Behavior preference panel for the Paper Calculator to automatically display. 
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Job Ticket 
The Job Ticket panel allows you select your job ticket preferences. You can use either the old style, 
the standard style, or customize your job ticket. 

In order to customize your job ticket, the optional Report Writer must be purchased. Report Writer 
is the tool used to perform the customizing, as well as to print the custom ticket. 

Determine if you want prices to show on your job tickets. You can use the optional bar code 
tracking system if you have purchased a bar code reader and set a special font. 

 
 

Custom Style 

This window assumes that a custom ticket has already been developed. One of the standard 
Report Writer reports is a customizable job ticket that is almost exactly the same as the current 
Standard Style ticket. To use this format as your job ticket, select the Custom Style option, and 
then select the applicable report. 
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A list of registered reports opens.  Select the Job Ticket report (Job Ticket.rpt). 

 

Job Ticket.rpt 

 

Show Amounts on Tickets 

When enabled, this feature prints the dollar amounts on the job ticket. When disabled, no prices are 
shown on the standard job ticket. 

Add Tracking Bar Codes 

If using the optional bar code reader, you need to enable this option to print the bar code on the 
standard job ticket. You also need to specify the font in Set Bar Code Font. The optional bar code 
tracking system allows you to update the status / location of every job in your shop. 

Show Customer External Reference Number 

This option displays the external reference number in the job ticket header. An external reference 
number might be an artwork file, an old account number, or any number entered in the customer 
account. 

Charge Description 
Charge Description Options 

Option Meaning 
  

Show Name When enabled shows the Name of the charge on the job ticket. 

Show Description When enabled shows the description of the charge on the job ticket. Users can 
easily change the description. 

Show Both If Different Shows both name and description if they are different. 

  

Note:  Charge Description is a global preference that is established at the master only. 
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Quantity Breaks 
Quantity breaks are a great marketing tool. The quantities entered are used in generating price lists 
on screen and for printing. You can generate a price list, for any job, with up to 40 quantities. The 
price list can be presented with price per each or price per thousand. Either way, it is a great tool to 
up-sell the customer by quoting a lower price per unit. Enter in your favorite quantities. Numbers 
preceded by a (-) minus sign have a divisional line above them in the price list. A zero in any field 
ends the list. 

 
Note:  Quantity Breaks is a global preference that is established at the master only. 
 

Tracking Locations 
Information previously specified in the Tracking Locations panel is now specified within the Admin > 
Table Editor window, in the Production Locations table. 
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Markups 
Markups are variables used in the estimating system. The Outside Services and Merchandise 
markups are used when in the respective pricing methods.  Markups are based on stepped cost 
amounts.  The first amount covers from zero to the specified cost, and the last amount covers 
anything above the last set cost. 

 
Note:  Markups is a global preference that is established at the master only. 
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Stocks and Sizes 
The Stocks and Sizes panel contains settings for In Stock, Special Order, and Customer Stock, as 
well as blank stock markup and formatting instructions. 

 
 

Stock Markup 

The Stock Markup is the default markup used for all stocks unless you specifically override the 
markup in an individual stock definition. A markup has a greater effect on high priced stocks than 
low priced stocks.  

Stock Weight, Name & Finish 

The Stock Weight, Name, and Finish field allows you to format and display the stock name and 
weight. This field is based on a concept of a block of text with placeholders for name, weight, and 
finish. These placeholders are replaced with actual weight, name, or finish when stock is displayed. 

Placeholder Meaning When Used In Stock Weight, Name, and Finish Field 
  

^0 Weight of the stock 

^1 Name of the stock 

^2 Finish of the stock 
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You have complete control over the contents of the text block. Clicking the question mark button at 
the end of the field pops up a list of sample formats. Selecting one of the samples inserts the 
format text into the field. 

Example 

For 50 pound offset stock, using a weight, pound sign and name format, enter the following: 

Format:  ^0# ^1 
Result:  50# Offset 
 
Other possibilities: 
Format:  ^1 ^0# ^2 
Result:  Offset 50# Vellum 

OR Format:  ^0gsm ^1 
Result:  50gsm Offset 

 

The resulting format appears on invoices, estimates, and stock order reports. 

Stock Points, Name & Finish 

The Stock Points, Name, and Finish field allows you to format and display the stock name and 
weight differently for stocks defined by points. This field is based on a concept of a block of text 
with place-holders for name, weight, and finish. These placeholders are replaced with actual 
weight, name, or finish when stock is displayed. 

Placeholder Meaning When Used In Stock Points, Name, and Finish Field 
  

^0 Point Size of the stock 

^1 Name of the stock 

^2 Finish of the stock 

  

 

You have complete control over the contents of the text block. Clicking the question mark button at 
the end of the field pops up a list of sample formats. Selecting one of the samples inserts the 
format text into the field. 

Blank Stock Pricing 

Set your markups for selling blank stock using the Blank pricing method. These quantities display in 
each new stock definition. However, changing them here only effects new stock definitions and not 
existing definitions. Existing definitions can be updated manually in each record to reflect new 
defaults entered or globally using Pricing > Change prices command from the main menu. This 
command updates the markup and resets the quantity breaks when the Re-Calculate Blank Prices 
option is enabled in Change Prices and Auto Calculate Blank stock is enabled in the respective 
stock definitions. 
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Customer Stock 

Enter in default stock cost, stock markup, and in units of for customer provided stock. These 
defaults can be overridden when entering a job in the estimator. 

Size Table to Use 

This drop down lists size tables that can be customized in the Table Editor under the Admin menu. 
These options include metric and conversion tables. 

Note:  This is a global preference that is established at the master only. 
 

Pricing Method 
The Pricing Method panel allows you to change the name and default sales category of the job 
pricing method. However, the way the pricing method calculates remains the same. For example, 
you could change the title of the first method to “whatever” and set the sales category to “other” but 
the method still calculates based on a combination of press and stock definitions, which is 
unchangeable. 

 

Pricing 
Method 
descriptions 
displayed in 
the Estimator 
column 

Options 
can be 
turned 
off/on 

 

Note:  Pricing Method is a global preference established at the master only. 
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Defining Accounting Preferences 
The following six preferences establish accounting sales categories, general ledger profiles, aging 
periods, customer default credit limits, credit card info, and journal entry defaults. 

Credit 
The credit limit field sets a default limit for ALL customers. Set this limit to your standard, most often 
used, lower credit limit. A credit limit of zero provides unlimited credit. Each customer account you 
create can have its own unique credit limit. 

Note: Credit limits unique to the customer account are set in the Credit Control panel of the 
Customer window. 

 
The Finance Charge is applied each time you generate statements and select the option to 
Calculate Finance Charge. Use this feature on a monthly basis; setting the finance charge to the 
amount you want to charge per month. 

Example 

1.5% per month = 18% annually. 

 

The Inactive Period marks an account inactive based on the time specified in this field. The 
inactive tool is great for keeping in touch with good customers. Set it to the number of calendar 
days of inactivity you would like to track.  

If you have money wired to you or you accept bank drafts you may want to select Remove drafts 
from deposit ticket to more accurately reflect the deposit. 

Note:  Credit is a global preference established at the master only. 
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Aging Periods 
Set your account aging periods in ascending order. Change the message to fit your business 
practices. These messages can appear on statements for each customer depending on their 
account status and whether you have selected it as an option when you generate statements (the 
Show Reminders option in Generate Statements function). 

 
Note:  Aging Period is a global preference that is established at the master only. 
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Sales Categories 
Sales categories are defined in the Sales Categories panel and PrintSmith always understands 
them by field number or position. If you elect to change the name of a sales category, all sales for 
that category remain in the respective numeric position. Select categories carefully and leave room 
for future expansion. PrintSmith has 40 customizable sales categories. You can change the names 
and what goes into each category. Once sales are recorded in a category, they stay in that 
numbered category. 

If you need more detail you can create sub-categories with Product Codes in jobs and on charges. 
Even further detail can be extracted from PrintSmith with Report Writer. Add a GL account number 
that matches your chart of accounts and/or your accounting software. PrintSmith exports a file that 
when imported into your accounting software transfers over sales and receivable information 
necessary for complete financial information. It also prints a sales ledger journal entry based on 
entered GL account numbers. 

 
 

Note:  Sales Categories is a global preference that is established at the master only. 
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GL Profiles 
The GL Profiles panel is used to define a link to the selected accounting package, as well as 
defining specific GL Account numbers that relate to the target accounting package. Enter in your 
matching general ledger account numbers. 

 

Select your 
accounting 
system from a list 
of supported 
packages. 

Note:  GL Profiles is a global preference that is established at the master only. 
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Credit Card Info 
The Credit Card Info panel is used to set up credit cards for use as a payment type in both the cash 
register and posting payments. Define each card you accept; as a result your daily closeout figures 
match your credit card system batch report. 

 
There are 10 possible credit card definitions. The first four are pre-defined and can only be 
changed in a limited way. 

Use 

Check this column to recognize the card in PrintSmith. Only those card definitions, which have 
been enabled, are included in the Credit Card menu used to enter payments. 

Card Title 

The Credit Card Title is the full name of the credit card. You cannot change the name of the first 
four cards. 

Abbrev. 

This field is the abbreviation of the credit card. It is used to identify the type of card. 

Code 

The Code field is a 2 character code used in the reference number field in Post Payments and the 
Cash Register to select the card in the credit card menu without using the mouse. It should be 
unique for each card. 
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ID 

The ID field is a number from 1 to 99 that must be unique for each card. It is used internally to 
identify the card type. It should always be the same number used by electronic credit card systems 
to identify the card. The first four ID’s cannot be changed and are set to the correct value for the 
cards listed. 

Activate Credit Card Approval Processing 

When this product is activated/purchased, this option enables the credit card integration features in 
PrintSmith. 

Note:  Credit Card Info is a global preference that is established at the master only. 
 

Journal Entries 
Journal entries use a document preference to define their appearance. Select the document format 
that best fits your needs or create a unique one for Memos. Enabling the Print Document option 
sets the default option to print a copy of the memo, which is recommended. 

 
Note:  Journal Entries is a global preference that is established at the master only. 
 

 
Page 53 



EFI PrintSmith 7.2 │ Set Up Guide 

 

Table Editor 
Tables add the ability to customize important parts of the PrintSmith user interface and expand 
other capabilities in a simple, easy to understand manner. Some of the most common uses for 
tables are quick fill fields, pop up lists, and pop up menus. The Table Editor is a tool designed to 
manage the contents of these tables and control how they are used. 

Select Admin > Table Editor from the main menu. Select the Job Title table. 

 

The selected 
table is the 
window title. 

Data for selected 
table 

The title of the window includes the name of the table currently being edited. The Tables field is a 
pop up menu containing a list of all the defined tables from which to select. In this list, disabled 
tables are in italics and the active size table is underlined. Next to the menu is a Properties button 
used to change how a table is applied. 

The bottom area of the window contains the table data. The actual data displayed varies with the 
type of table (see the next section) but shares some features: 

• Each table can contain at least 100 lines; some tables as many as 25,000 lines (also referred 
to as table elements). 

• All tables have an ID column. Each table element has a unique, non-editable, sequentially 
assigned ID, which permanently identifies the item. This ID is important because it is often 
stored in other parts of the PrintSmith database instead of the text in the name. Not only is this 
more efficient, it also allows changing the item to instantly affect everywhere it is used. 

• Tables can be sorted by clicking on one of the column headers. You can also drag items with 
the mouse to position items exactly as you wish. This feature is very useful for QuickFill fields 
because elements at the beginning are preferred over items at the bottom of a table. 

Editing Items 

Clicking on an editable element opens an edit field. You can also navigate around on the keyboard 
using <tab>, <return>, or an up or down arrow key. 

Adding Items 

New items can only be added immediately after the last defined element in the table. 

Deleting Items 

To delete items, click on their ID number in the ID column and press the <delete> key or backspace 
(Windows), or click the Delete Entry button. 
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Defining Table Properties 
The properties associated with a table are: the table ID (a unique identifier for the entire table), the 
table type, table title, whether the table can be used, and how the table is used. 

To view a table’s properties, with the table selected, click the Properties button.  The Table 
Properties window opens. 

 
ID 

This number is a unique ID for the entire table. For the most part you need not be concerned with 
table ID’s. However, since you can change the name of any table, the ID serves as a constant 
reference. 

Disable Table 

You can disable a table that is used for QuickFill fields or pop up lists if you do not want it to be 
used. This option changes all edit fields that use the table into standard edit fields. Table driven pop 
up menus cannot be disabled. 

Enable Size Translation 

This button is only used with Size tables that can be selected as the active size table. This option 
enables size translation for this table if and when it is the active size table. 

Title 

All tables have titles that can be up to 48 characters long. You can change the title of any table. 
Mostly this only affects how the table is listed in the Table Editor; however, there are a number of 
tables where this title is actually the title of a pop up menu or the prompt on an edit field. For 
example, the Sales Rep table title is also the prompt on all the fields that use this table - even if the 
table is disabled. 

Number of Entries 

This field indicates the number of defined entries in the table. Tables can hold a minimum of 100 
entries and some can hold up to 25,000. 
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Table Status 

The Table Status pop up menu contains 5 settings: 

Table Status 
Setting Definition 

  

Editable Most tables are marked as editable. There’s nothing special about this setting. 

Locked A Locked table does not allow additional entries to be added or its status to be 
altered. Existing items in the table can still be changed. An example of a locked 
table is the Phone Tags Table. There are only 4 numbers that can be tagged, so 
the table has 4 entries and is locked. 

Add Edit Command This setting adds an edit menu to the bottom of all pop menus and pop up lists that 
use this table. Selecting the edit command opens the table editor in a special mode 
just for editing that table. 

Add From Input This setting is useful only for pop up lists and QuickFill fields. It tells the system to 
add a new item to the table if the user types an entry into the edit field that isn’t in 
the list. PrintSmith asks before adding the item to a pop up list. Normally, this is the 
best setting for a QuickFill table if you want it to “learn” from user input. 

Add Fm Input & Edit This setting combines both an Edit command and the ability to add items based on 
user input. 

  

 

Sort By 

The functions in this menu are identical to those available by clicking on the column headers in the 
Table Editor window. 

 

Defining Table Type 
There are three basic types of tables: Keyed Tables, Size Tables, and Standard Tables. 

• Keyed Tables have a Key column where additional data can be entered. 

• Size Tables contain a size column (middle column) that expects sheet sizes for data entry.  

• Standard Tables are composed of an ID and a Name only. The middle column is left blank. 

Table Usage 
ID Name Usage 

   

14 Basic Sizes Size Table – not usable as an active size table. Shows the basic size 
for each of the paper types in the United States. 

15 Business Type Pop Up list used in marketing panels. 

30 City QuickFill Table for address editor. 

19 Common Interest QuickFill Table for address/contact/prospect editor. 

27 Contact Name Prefixes QuickFill Table for contact editor. 
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ID Name Usage 
   

28 Contact Name Suffixes QuickFill Table for contact editor. 

35 Country QuickFill Table for contact editor and also used to control addresses 
that are formatted in each country. Do not add entries to the Country 
table in the Table Editor - use the Address Format preference window 
to do this. 

6 Generic Colors QuickFill Table for stock picker window. 

42 Hold State QuickFill Table for pending document window/account info screen. 

39 Ink Color QuickFill Table for ink colors in job window. 

32 Job Title QuickFill Table for contact editor. 

17 Lead Source Marketing tables used as pop up lists in Customer and Contact 
marketing panels. 

26 Mailer Type QuickFill Table for address/contact/prospect editor. 

16 Marketing Date Labels Marketing tables used as prompts for dates in Customer and Contact 
marketing panels. 

36 Phone Tags Prompts for phone number fields in contact editor. 

57 Production Copiers Pop up menu for the Machine Name field in the Copier Definitions 
window.  Copier names are also used in the Employee Production 
Filter to determine which jobs are seen in the Tracker Console. 

41 Production Dates Dates of production by Production Location.  This list is used in the 
production data window. 

58 Production Exceptions Pop up menu for the Exception code field in the Stop Tracker Step 
window.   

54 Production Facilities The default Production Facility has been set as In House.  Supports 
the Tracker Module. 

50 Production Locations The name of a process that indicates what stage a job is at in the 
overall production process.  These can be customized based on your 
internal referencing system.   

56 Production Presses Pop up menu for the Machine Name field in the Press Definitions 
window.  Press names are also used in the Employee Production 
Filter to determine which jobs are seen in the Tracker Console. 

52 Production Priority Set based on your internal language and referencing system for 
indicating which jobs should take precedence.  These can be 
assigned to a job in the Tracker Production window. 

53 Production Stations The computer terminal where PrintSmith is running.  Supports the 
Tracker Module. 

40 Products Product list used as pop up menu in jobs. 

37 Report Categories Pop up menu in Report Manager for categorizing reports. 
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ID Name Usage 
   

33 Sales Rep  Used everywhere a Sales Rep is entered - usually as a pop up list. 

34 Ship Via Pop Up list for selecting shipping method. Fields using this pop up list 
do not allow user entry of data - it must come from list. 

3 Sizes – Metric CM Size Table. Metric paper sizes in centimeters. 

2 Sizes – Metric MM Size Table. Metric paper sizes in millimeters. 

4 Sizes – Metric IN Size Table. Metric paper sizes in inches. 

1 Sizes – United States Size Table. US sizes plus metric sizes in inches. 

20 Sport Interest QuickFill Table for address/contact/prospect editor. 

29 State QuickFill Table for address editor. 

8 Stock Colors QuickFill Table for Job and Stock Definitions. 

7 Stock Finish QuickFill Table for Stock Picker and Stock Definitions. 

9 Stock Grade QuickFill Table for Stock Picker and Stock Definitions. 

10 Stock Group QuickFill Table for Stock Picker and Stock Definitions. 

25 Type of Work QuickFill Table for address/contact/prospect editor. 

19-26 User 1- User 8 Marketing tables used as a pop up list in Customer and Contact 
marketing windows. 

38 Vendor QuickFill Table for Stock Definitions. 

31 Zip QuickFill for address editor. 
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Understanding Table Sizes 
PrintSmith can include many sizes - the list can hold 32,000 definitions. This method was 
introduced primarily for metric based systems (A4, A3, SRA2, etc.) but also has many uses on an 
imperial based system. 

 
Enter in a size to translate and then enter a name or text to use. The size to translate must be the 
same as the base system (e.g. If it is Metric Based in millimeters, all sizes to translate should be 
MM. x MM.). When enabled, the size can be entered either way. This feature is a helpful tool for 
certain sizes like Business Cards that may not be easily remembered. 

Products 

Product names can be assigned to any job. You can define 25,000 products to track. This 
information is available only with the Report Writer or Downloader (optional products). If you would 
like to track the number of reruns for example you would simply mark those jobs and then use the 
Downloader to extract that information for reporting as you desire. Refer to the Report Writer Guide 
for more information about this powerful utility. 
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Default Waste Chart 
When estimating printing, you need to estimate waste. The default waste chart is used by press 
definitions when generating a price unless specified otherwise. 

To open the default Waste Chart, select Pricing > Waste Chart from the main menu. 

You can have as many waste charts as you like but only one system default. Enter in your standard 
(default) waste assumptions by dragging the points on the line or by clicking the Enter Data button 
and typing the information into the table. 

 
This chart defines the waste amount for each printing job, unless the press has another waste chart 
assigned. When creating press definitions you can select different waste charts for each press.  

Note: PrintSmith displays the number of sheets wasted and the percentage of waste at each 
point on the graph when you click on a point with the mouse. 

Set the waste assumptions to your normal waste. Do not include run up or fixed waste as that 
information is defined in Press Definitions. Click the OK button to save the data and close the 
Waste Chart. 
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System Security- User Definitions 
The security system is shipped disabled, which means that anyone using the system can make 
changes to any part of PrintSmith. While this is very desirable as you start using the system, some 
level of security is recommended once you go live with PrintSmith. Select Admin > User 
Definitions from the main menu. 

 
The user currently logged in is shown with a bullet to the left of the name. The User Definition of the 
System Administrator (there can be only one) is shown in red with a diamond next to the name.  
The list is in alphabetical order. 

Although any user can be given access to the User Definition command, only the System 
Administrator has full use of the command. Specifically, only the System Administrator can change 
User Definitions that belong to the System Admin access group and only the System Administrator 
can assign User Definitions to the System Admin access group. Except for the System 
Administrator, you cannot change anything in your own User ID. The System Administrator 
password can only be changed using the Change Password command. This feature ensures that 
you know the old system password before you change it to a new one. 

Access Group 

Access Groups are defined in the Admin > Security Setup command. An access group is a list of all 
the commands available to members of that group. There are two pre-defined groups: System 
Admin, which always has all commands, and Minimum, which only has those commands needed to 
get in and out of PrintSmith (Quit and Log In). These groups cannot be changed in any way. 

Access Level 

This field used to be the principal security feature of PrintSmith. It is retained in this version solely 
to support access levels on customer accounts. 
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Lock Sales Rep Names 

This setting is useful in situations where you must ensure that the sales representative name 
assigned to an account and/or document is under management control. When enabled, a user can 
assign a Sales Rep to accounts and documents only if the field is empty and can not change the 
assignment thereafter. 

Not Allowed to Return Cash 

This setting prevents the user from cashing checks in the Cash Register. A transaction is rejected if 
the amount of change exceeds the total amount of cash. 

Security Setup 
Security Setup is an editor for access groups. Access Groups are lists of commands that members 
of the group are allowed to perform. Although most of these commands directly correspond to 
menu commands, there are many commands with no direct menu equivalents, such as preference 
windows.  Select Admin > Security Setup from the main menu. 

 

The access group 
shown in list Sorted by menu. 

Checked items are in 
the access group 

and available to 
members of the 

group. Indent shows 
commands that 
are not menu 
commands. 

Item is locked 
and can’t be 

changed. 

From the pop up menu select the access group you wish to edit. Add or remove check marks from 
individual commands. Those commands without check marks are not available to members of the 
group. As you make changes, items display in italics. When you save those changes using the 
Save command in the File menu, italics are removed. 

Items that cannot be changed show a Locked icon. Note that all items in the System Admin and 
Minimum group are locked. These two groups are pre-defined in PrintSmith and cannot be 
changed. 

Column widths can be adjusted by dragging the separators in the list header. The list can be sorted 
in different ways by clicking on the column by which you want it sorted. It is easier to edit the list 
when it’s sorted by menu. 
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Any access group can be copied using the Save As command. Since this list includes the System 
Admin group, we strongly recommend restricting this command to members of that group. 

Rename 

Select this feature to rename an access group. The groups created during the conversion process 
may have cryptic names that you want to change to something more logical and apparent. 

Delete 

You may find that there are more groups than you really need. This button deletes a selected 
access group. Any User Definitions that are members of a deleted access group are automatically 
assigned to the Minimum group, which effectively renders that User Definition unusable. 

Keyboard Shortcuts 
The Admin > Keyboard Shortcuts command allows users to customize keyboard shortcuts. 

 

Unsorted List 

Sorted By Key 

 

 

Functionally, this is very similar to Security Setup. You can sort the list by clicking one of the 
header columns. You assign a keyboard short cut by clicking in the key column next to the 
command you want to modify and type the single character shortcut you wish to use.  Shortcut 
keys that are system defined and cannot be changed are indicated with a small lock icon. 

Items that have been changed but not yet saved are shown in italics. When you select the Save 
command, these changes are immediately applied. 

Since most characters are already used, it is often useful to sort the list by the key values. For your 
reference and convenience, print out the window by selecting File > Print from the main menu. 

Note:  Keyboard shortcuts can only be defined at the Master on a multi-user system. They are 
read from the Master when the workstation initially launches. 
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Pricing with PrintSmith 
In this chapter 

Charges 65
Press Definitions 110
Copier Definitions 133
Stock Definitions 151

 

During this part of setting up PrintSmith, you start to enter and modify your pricing information. 
Once this information is entered you can test your pricing assumptions and make any necessary 
modifications. 

Charges 
Charge definitions are an extremely important part of the pricing system. PrintSmith supports ten 
different charge definition commands. The number of charges within each category is essentially 
unlimited (4,000,000,000 charges and categories combined).  

When the system is first shipped, there are six defined commands: Pre Press, Bindery, Production, 
Merchandise, Mailing Services, and Miscellaneous. You may rename these commands as needed 
to better describe your business. There are also four user-defined commands available. 

The names of the commands give you an idea of their intended use. They can be used to price 
items such as plates, negatives, bindery, typesetting, special markups, rubber stamps, shipping 
charges; anything you sell in your business. Charges are defined as items usually associated with 
a printing or duplicating job, but can stand alone if necessary. You can place any charge definition 
in any of the commands. We recommend you group them as follows: 

Pre Press - Any charge related to preparing a job for production should reside in Pre Press. Items 
like film, plates, typesetting, desk top publishing, and art work belong in this command. All charges 
related to activities before the job goes to production 

Bindery - Items associated with finishing a job; operations such as post press cutting, folding, 
scoring, drilling, stitching, padding, gathering, book assembly, packaging, even shipping. 

Production - Charges used while in production such as wash ups, extra plate burns, etc. can be 
grouped into this area.  

Merchandise - Work that is always brokered out, especially if you have price lists from the vendor. 
Examples: thermography, business cards, invitations, blueprints, letterpress work, color 
separations, office supplies, etc. 

Mailing Services - Mailing is becoming a greater portion of a printer’s business. This area is 
designed for charges related to mailing the final product(s). 

Miscellaneous - Anything else you regularly sell can be set up here. 
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The most important and frequently used charge commands are Pre Press, Production and Bindery. 
They can be attached to jobs, although they can just as easily be used alone. The remaining 
commands are designed more for invoice level charges although they can be attached to jobs as 
well. 

PrintSmith handles Pre Press cutting charges differently than Bindery cutting charges. It assumes 
that pre press cutting affects the parent to the run size and bindery cutting affects the run size to 
the finish size. In the Estimator, a cutting charge shows what size it is cutting from and to. 

Each of the possible charge definitions can be thought of as individual pricing formulas that you 
control and can plug into a job or quote. The formula for all charge definitions breaks down to: 

 

quantity x rate = price 
 

The power of charge definitions comes from the number of ways in which the quantity and the rate 
are derived and plugged into the formula. There are millions of different combinations possible.  

Charges are organized by command, category, and charge. This section defines how categories 
and charge definitions are managed, how to create them, and the ways in which they can be 
organized. Then, we show you how to set up charge definitions to generate the correct price. 
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Understanding the Charge Definition Window 
All charge commands are managed in one window: The Charge Definition Window. To open the 
Charge Definition window, select Pricing > Charge Definitions from the main menu. 

The Charge Definitions Window contains all charge definitions (Pre Press, Bindery, Merchandise, 
Mailing Services, Miscellaneous, Production, and any custom definitions). Charges and categories 
are organized in a hierarchical display. This hierarchy can be expanded and collapsed to view the 
application information with which the user is working. Functionality buttons are displayed across 
the top of each window. Additional information for the selected item is also displayed. 

Charge Definitions Window 

 

Functionality Icons 

Hierarchical Display 
of Charges and 

Categories 

Additional InformationIcon Indicating No 
Costing Has 

Been Defined 
Ability to Specify 
Waste Created 
When Setting Up a 
Job 

Ability to Hide 
Specific Charges in 
Printouts 

Waste Chart 

 

You control the categories in each menu command, the charges in each category, how each 
charge calculates a price, how it is presented to the user in the Estimator and even the name of the 
menu command. 
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Managing Commands 
Renaming Charge Menu Commands 
Charge Menu Commands can be renamed. To rename: 

1. In the Charge Definitions window, select the command to be renamed from the 
hierarchical list. The selected item is highlighted and a Command field and Add To 
Job Task List checkbox are displayed. The current name is listed. 

2. Enter a new name in the text field. Changes made are reflected in the hierarchical list. 

3. Click the Save button. After renaming an item, you must save in order to continue 
working in the Charge Definitions window. If you elect not to save the new name, the 
hierarchical list reverts back to the original name. 

Notes:  Avoid using punctuation marks in the title. In particular don’t use “;”, “^”, “!”, “/”, or “(”. Do 
not start the menu command with a left parentheses or a hyphen. 

 We recommend not changing the name of the Pre Press or Bindery commands as the 
corresponding buttons in the job window can not change to match the new menu 
commands. This will be confusing. 

 

Determining Whether or not to Show a Charge Command in Job Task List 
You can decide whether or not to display a command in the task list. By default, all defined charge 
commands are displayed in the Job Task List.  

1. In the Charge Definition window, select the applicable charge command from the 
hierarchical list. The Command name and an Add Command To Job Task List check 
box are displayed. 

2. Check or uncheck the Add Command to Job Task List option, as appropriate. 

3. Click the Save button. The charge command is displayed in the Job window if the 
option is enabled or the command is hidden if the option was unchecked. 

 

Defining a Custom Charge Command 
There are four user definable charge commands available. These custom charges labeled <Empty 
7>, <Empty 8>, <Empty 9>, and <Empty 10> can be used to create a charge command. By default, 
these commands are not displayed in the Task List. 

1. In the Charge Definitions window, select one of the four custom charge commands 
from the hierarchical list. The Command name and an Add Command To Job Task 
List check box are displayed. 

2. Rename the Command by entering a new name in the text field. 

3. Check the Add Command to Job Task List option if the command should be 
available within the Task List. 

4. Click Save. The newly named command is displayed in the hierarchical list. 

5. Add Categories. 
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Managing Categories 
When setting up your categories, make it as easy as possible to locate the charge you need. For 
example, have separate categories for cutting and folding but not for numbering and numbering 
with colored inks. 

When organizing categories for Pre Press and Bindery, list the categories in the same order as 
they are used (i.e. collating, binding, boxing, and delivery). Visually, the category list can serve as a 
mental checklist. Another option is to alphabetize the category list. 

In the other commands, frequently used categories could be placed at the top of the list so they are 
easier to select, especially from the keyboard. When you are selecting them in the Estimator, 
sixteen items are displayed at one time. For optimum results, make the most common categories 
the first sixteen items in the list. 

Try to avoid having too many categories containing only one or two charges. It is much easier to list 
all folding charges together in one folding category than to have a category for each type of folding. 

 

Organizing Categories 
Organizing categories is quite simple. Move any category to its proper position in the list by 
dragging the item to the place you want it moved.  

Note:  Changes to the organization of the list are not visible in the Estimator until you save/close 
the window. 

 

Creating a New Category 
To create a new category: 

1. In the Charge Definition window, select the command in which the category is to be 
created. 

2. Click the New button in the toolbar. The new item is displayed last in the command’s 
list of categories with a right pointing arrow. An un-editable Command field listing the 
name of the command the category is part of and a Category Title text box are 
displayed. The category title listed is <untitled>. 

3. Enter a new name in the text field. Changes made are reflected in the hierarchical list. 

4. Click the Save button. 

5. Move the category into the applicable order with the other categories.  
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Renaming Charge Categories 
Charge Categories can be renamed. To rename: 

1. Select the category to be renamed from the hierarchical list in the Charge Definitions 
window. The selected item is highlighted and an un-editable Command field listing the 
command name the category is part of and a Category Title text box are displayed. 
The current category name is listed. 

2. Enter a new name in the text field. Changes made are reflected in the hierarchical list. 

3. Click the Save button. After renaming an item, you must save in order to continue 
working in the Charge Definitions window. If you elect not to save the new name, the 
hierarchical list reverts back to the original name. 

Note:  Avoid using punctuation marks in the title. In particular don’t use “;”, “^”, “!”, “/”, or “(”. Do 
not start the menu command with a left parentheses or a hyphen. 

 

Duplicating Categories 
The easiest way to duplicate a category is to hold down the <option> or <alt> key and drag the 
category to a new location either in the same command or in a different command. Instead of using 
the drag and drop method of copying a category: 

1. Select the applicable item to be copied from the hierarchical list. 

2. Click the Duplicate button. A confirmation message is displayed.  

3. Click the Yes button to confirm duplication of the item. 

Note: You can also use Cut, Copy, and Paste commands in the Edit menu. 
 

Deleting Categories 
Entire categories can be deleted. To delete a category: 

1. Select the applicable category to be deleted from the hierarchical list. 

2. Click the Delete button. A confirmation message is displayed.  

3. Click the Yes button. A message is displayed identifying the number of charges that 
are affected by this action. 

4. Click the OK button. The applicable category is deleted (and no longer displayed in 
the hierarchical list of categories in the Charge Definitions window). 
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Managing Charge Definitions 
Charge definitions are the individual charges that reside in a particular Category. Charge definitions 
are used in pricing and contain additional information required for pricing, such as rates, price lists 
and minimum charges. 

There are three basic types of charge definitions; definitions that: contain all the information needed 
to generate a price, require additional information from the user, or use the job or document to 
which they are attached for pricing information. The latter type of charge is often referred to as Job 
Aware because it knows how to extract information from jobs for use in generating a price. 
Markups, Cutting Charges, and Ink Charge methods are Job Aware based methods. Generally, we 
recommend using Job Aware charges whenever possible because if you change the specifications 
on a job, all job aware charges immediately reflect this change, preventing many errors. 

 

Organizing Charges 
This procedure is identical to managing categories. Drag and drop the item to the desired position. 
Like categories, you can drag a charge definition in to a different command. Alternatively, drag it 
into the category list and drop it below the category you want the charge added to. In this case, the 
charge is added to the end of the list. 

 

Creating a New Charge 
Creating charges is easy. The following steps are the simplified process for creating a charge. 
Additional information is available in subsequent sections, where noted.  

1. In the Charge Definition window, select an existing charge within the category in 
which the charge is to be displayed.  

2. Click the New button. A copy is made of the selected charge. 

3. Enter a name for the newly created charge. 

4. Select a Method from the drop down menu. 

5. Select a Quantity. 

6. Select a Sales Category. 

7. Enter Pricing Data or select a Price List. 

8. Enter a Product Code. 

9. Enter Fixed Spoilage. 

10. Assign a Waste Chart, if applicable. 

11. Specify other charge definition information as needed based on the method selected. 

12. Define any relevant Preset Information. 

13. Click the Save button. The newly created chart can be organized in the list 
accordingly. 
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Selecting Charge Method  
The pricing method attached to a charge has a tremendous impact on how the charge is used and 
affects all the other settings in the charge definition. It is best to select the method first. Use the 
Method menu to select the pricing method to use with a charge definition. Each method is designed 
to handle certain types of pricing situations. Most charge definitions in Pre Press and Bindery use 
one of the job aware methods (Job Aware, Markup, Cutting Charge, Ink Charge). Most charge 
definitions in other commands use Always Ask. 

Charge Methods 

Method Definition 
  

Job Aware A Job Aware charge is strongly recommended for any item whose price is dependent 
on a quantity in the job to which it is attached. Job Aware charges ensure the price is 
always correct and when a quantity in the job changes, the prices for all job aware 
charges are automatically updated. 

Markup Markup charges are similar to Job Aware and can be used in situations where you 
want to mark up all or part of a job or an entire invoice. Anything you price by 
multiplying a total by a factor is a candidate for a markup charge. For example, to add 
a rush charge of 20% to the price of a job or invoice, a markup charge would be the 
ideal way to handle it. 

Flat Rate Flat Rate method is used for items where the price never varies. If you always charge 
$5 for delivery, you should set it up using the flat rate. 

Always Ask The Always Ask method can be used for any charge definition. It is best suited for 
charges where the quantity is not known beforehand, although you can preset a 
common quantity to make data entry a bit easier. 

Price List The Price List method is similar to Always Ask except the price is always taken from a 
price list (which must be created and attached to the charge) based on a quantity you 
enter. 

Rate List Rate List method is identical to Price List except the rate for the charge is taken from 
an attached rate list. This rate is then multiplied by the quantity you entered to 
generate the price. 

Cutting Charge A Cutting Charge is a special purpose, Job Aware charge, specifically intended to 
calculate cutting charges. It calculates pre press cuts (from Parent Size to Run Size) 
when a charge with this method is defined in the Pre Press command. It calculates 
finish cuts (from Run Size to Finish Size) when the charge is in the Bindery command. 
This method determines how many cuts are needed based on the two sizes, how 
many lifts, and multiplies it by a rate, which may come from an attached rate list. 

Ink Charge The Ink Charge method was developed to aid in estimating ink requirements and 
charging for ink. It is a Job Aware type of charge with special fields and capabilities 
best suited for calculating based on coverage for a particular job. It can be used for 
any charge that is based on square inches (or square feet). 

Shipping Charge The Shipping Charge method supports specifying shipping addresses of a job and for 
pricing based on the weight of a job. Job level charges use the weight of a single job 
and invoice level charges use the weight of all jobs on an invoice. Shipping charges 
attached to the control job in a multipart job includes the weight of all parts of the job in 
the calculation. You can override the weight in the actual shipping charge on a 
document if necessary. 
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Defining Job Aware Charges 
A Job Aware charge is priced using information from the job to which it is attached. There are many 
types of charges where the quantities in the job are important.  

Examples: A folding charge is dependent on the number of sheets to be folded. Sheet 
information is available from the job if the charge is attached to it. Other examples are Plates 
(number of colors and sheets), film, cutting, ink and so forth. 

Most prepress or bindery operation depends on one of the quantities in the job: folding, drilling, 
scoring, gathering, binding, and even boxing – with the notable exception of Typesetting, which 
rarely is directly dependent on the quantities in the job. If you have standard rates per page 
(especially if they vary with the quantity) then Job Aware could be used to define typesetting 
charges.  

 

Job Aware 
method 

Bindery 
Operation 

Aside from entering Quantity, Sales Category, Product Code, Fixed Spoilage, and other criteria; 
Job Aware charges need you to define: which quantities and how the quantities are used to 
calculate price, and whether or not the charge is a Bindery Operation. 
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Selecting Values to Be Used in Calculating Price 

• Select either Ordered or Press quantities. Only one should be selected. 

• Select either x Colors or x Sides multiplier.  

• Select either x Sheets (number of originals specified in the jobs) or x Signatures (the number 
of different run sheets or sheets / up). 

 

Marking as a Bindery Operation 

The Bindery Operation option provides an alternate calculation method that generates better 
results for most bindery operations, especially when large numbers of originals and relatively small 
ordered quantities are involved. The difference in the price generated by PrintSmith can be 
significant. 

Examples: 

A folding operation where the price is specified as $1.00 for each cut in sets of 500 and there 
is 1 fold to each set. The first job it is being applied to is a copying job with 10 copies of 100 
originals. A second job with 500 copies of 100 originals is shown as well. 

With the Bindery Operation option enabled, the price would be calculated as: 

 

Note that the generated price was the same even though in the first case 1000 sheets were 
folded and the second was for 50,000 sheets. The price is the same because folding was first 
figured for the 10 copies and then multiplied by the number of originals. This means that 10 
copies was the actual size of the set because each original is priced separately. 

In the second version the number of copies and the number of sets were identical, still one set 
per original. Since the number of originals was identical – so was the price. Any number of 
copies up to 500 generate the exact same price. At 501, the price would double because there 
would be two sets for each original. 
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Examples Continued: 

With the Bindery Operation button on, the price would be calculated as: 

 

The two methods are identical when the quantity ordered (or impressions) is any multiple of 
the set size. The difference between the two methods is most apparent when the number 
ordered is less than the set size and there are multiple originals. If “In Sets of” is 1 or not used, 
this button has no effect. 

Disable Bindery Operation for charges for calculating plates or any other operation where each 
original must be treated separately. In many bindery operations, like cutting or drilling, you can 
combine the entire job before performing the operation, and, in these cases, you should enable the 
Bindery Operation option for best results. 

In general, this option should not be enabled for pre press charges or any charge where the 
operation must be performed on each separate original. It should be enabled for most bindery 
operations where more than one original can be processed at once (like folding or cutting). 
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Defining Markup Charges 
Markup is also a Job Aware charge since these charges use other parts of a document to generate 
their price. However, Quantity is always set to No Quantity because PrintSmith uses various 
document or job totals automatically based on the type of markup and the quantity is therefore not 
under direct user control. 

 

Markup 
method 

No Quantity 

Types of 
markup 

Markups use the same basic formula as all other charges. The quantity is the marked up amount. 
PrintSmith always supplies this quantity and multiplies it by the rate. You never see the rate listed 
and cannot change it. A rate of 0 does nothing, a rate of 0.1 is a 10% markup, and a rate of -0.1 is 
a 10% discount. 

When customizing a markup charge, only the rate is used. You can also use the Minimum field to 
define a minimum markup. The material rate and set up are ignored if selected. You should not use 
In Sets for markups. 

You have a choice of four different types of markups from which to choose: Job Price, Charges, 
Entire Job, and Invoice. The type selected determines what amount is to be marked up using the 
rate contained in the charge definition (or an attached markup price list).  

Entire Job, Job Price, and Charges rely on information in the job and must be attached to a job in 
order to generate a price. Invoice markups must be attached to a document in order to generate a 
price. PrintSmith does not allow you to attach a charge to a job if the charge is an invoice markup. 
Likewise, you are not allowed to add job level markup charges as an invoice level charge. 
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Markup Types 

Job Price – Job Price marks up only the job price (which includes production charges, but not Pre 
Press or Bindery). 

Charges – Charges marks up only the charges on the job that belong to the same category (Pre 
Press or Bindery). This type of markup in Pre Press marks up all the Pre Press charges while a 
markup of this type in Bindery marks up all the Bindery charges. 

Entire Job – Entire Job type marks up the entire job price including all pre press and bindery 
charges. 

Invoice – Invoice marks up everything in a document including markups for individual jobs and 
charges, but not including other invoice level markups, the customer discount, or shipping charges 
entered in the Document Totals window. 

 

You can add more than one markup to a job or document. 

Example: You could add a Rush Charge markup and a Bid Discount to the same job or 
document. Multiple markups of the same type do not interfere with one another. They are 
independent. The Rush Charge and the Bid Discount both use the same amount. The Bid 
Discount does not discount the Rush Charge and the Rush Charge does not mark up the Bid 
Discount. 

 

Note:  In addition to or in place of the rate, you can set up a price list for a markup that acts as a 
variable discount. In this case, the amount being marked up is used to look up the markup 
rate in the price list - a dollar based variable discount.  
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Defining Flat Rate Charges 
Flat rate charges are useful for items where the rate always remains the same. 

 

Adjustable 
rate 

Flat Rate 
method 

Flat rate charges are, by definition, fixed fees. If, for example, you charged a flat $5.00 for 
delivering an order, you could define it as a flat rate charge. Set up, Material rate, and Minimum 
can be used. It is best to just enter the price in the rate. You should not use Sets with this pricing 
method as PrintSmith ignores it. 

By selecting the Adjustable Rate option, you can define a flat rate charge that allows you to change 
the rate instead of overriding the price. This method is preferred since overriding a price prevents 
PrintSmith from automatically updating the price if the document is recalculated and the rate is not 
updated on these charges when a document is recalculated. 

Note:  This method allows users who do not have authority to perform overrides to enter a price 
directly. 
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Defining Always Ask Charges 
Always Ask type of charge should be used for the majority of charges that do not require or cannot 
use job quantities. With this method, you supply the quantity when the charge is selected in the 
Estimator. 

 

Always Ask 
method 

If a charge does not need to be Job Aware, it can be set up using the Always Ask pricing method. 
As implied by the name, PrintSmith asks for the quantity. Decide what type of quantity to use 
(Number of Sets, Quantity, Time, No Quantity, or No. Sets & Setup). We recommend selecting 
Quantity (asks for a quantity) or Time (asks for a time start and a time stop). If Time is selected and 
both a start and stop are supplied, the quantity is the difference between the two times. If just one 
time is entered, the quantity is that time.  

 

Defining Price List and Rate List Method Charges 
Price and Rate List methods are virtually identical. They both rely on an attached price list to 
generate a price. The only difference is how the attached price list is used. 

Price List Method - The attached price list is always treated as a price list regardless of the pricing 
options selected for the price list itself. 

Rate List Method - The price list is treated as a variable rate list. Instead of looking up the price in 
the price list, it looks up the rate and plugs it into the standard formula: quantity x rate = price 

The pricing method in the charge takes precedence over settings in the price list itself. If you use a 
price list with this method, it is treated as a rate list. 
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Defining Cutting Charge Method Charges 
The Cutting Charge method is a special Job Aware pricing method designed strictly for cutting 
charges. It makes use of the parent, run, and finish sizes in the job to which it is attached and takes 
an intelligent count of the number of cuts. PrintSmith then records this count as the number of sets. 
In all other respects, this charge functions just like a Job Aware charge. 

 

Cutting Charge 
method 

To estimate cutting the Run from the Parent Size, the cutting charge must be placed in the Pre 
Press command. Since the Parent Size is the base size, PrintSmith also uses the number of parent 
sheets instead of “Press”. 

To estimate cutting the Finish from the Run Size, the charge must be placed in the Bindery 
command. When the charge is selected in the Estimator, the type of cut is indicated in the charge 
window. So, even if the charge is dragged to a different part of the job, it still shows what type of 
cutting charge it is. 

Note:  The number of cuts for any given size combination is an estimate and it may not be 
correct. There are a number of common situations PrintSmith does not consider when 
calculating cuts. Among them are stacking lifts on small jobs and restrictions due to the 
size of the cutter. Trimming bleeds can require twice as many cuts as normal. In addition, 
the cuts often require extreme precision. You might want to add a bleed cut charge by 
doubling the rate and setup, lowering the lift size somewhat, and accept what PrintSmith 
estimates for the number of cuts. 
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Defining Ink Charge Method Charges 
Ink Charge is a special pricing method designed to calculate the amount of ink used in a job. It 
uses the run size of the stock and a percent of coverage to estimate the number of pounds of ink 
required. 

 

Ink Charge 
method 

The Rate field 
changes to Price/lb 

for Ink Charges. 

The Sets field 
changes to Cover/lb 
for Ink Charges. 

Press and x Signatures 
are automatically 
selected for Ink Charge 
and cannot be changed. 

Note: For this method, Press and x Signatures are preset and cannot be changed. A selection 
should still be made regarding x Colors or x Sides. Also, notice that the Rate field has 
changed to Price/lb. and the Sets field to Cover/lb. 

Enter the retail price for each pound of this ink and estimate the number of square inches, 100% 
covered, by that pound. 

Although shown in pounds and inches, other units of measurement can be used just as effectively. 
For example, the price could be deciliters and centimeters of coverage. This type of charge can 
also be used to estimate based on square inches by presetting the coverage to 100% and disabling 
Cover/lb. Square feet calculations are as simple as setting Cover/lb. to 144 (the number of square 
inches in a square foot). 

Note:  Stock sizes must be specified in the same unit of measure as Cover/lb for correct ink 
calculation. 

 

 
Page 81 



EFI PrintSmith 7.2 │ Set Up Guide 

 
The percent of coverage and the run size of the sheet are used to determine the total number of 
square inches to be covered. When divided by the coverage per pound it gives the estimated 
quantity of ink that is needed for the job. The formula used to calculate the charge is: 

 

The important fields in this pricing method are Price/lb. (selling price for one pound of ink) and 
Cover/lb. (the number of square inches solidly covered by a pound of ink). The following table 
shows some sample coverage estimates for common types of ink. Your mileage will vary with the 
type of stock, type of ink, and press. You can obtain mileage figures from your vendor or check the 
ink packaging. 

Ink Mileage Samples 
Stock Type Enamel Offset 

   

Standard Black 425,000 275,000 

Rubber Based Black 435,000 225,000 

Transparent Dark Colors 330,000 225,000 

Transparent Light Colors 250,000 185,000 

Process Colors 350,000 225,000 

Varnish 400,000 N/A 

Tint Base  405,000 250,000 

Fluorescent 270,000 160,000 

Metallics 215,000 130,000 
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When the charge is added to a job, normally just the estimated percent of coverage on a page is 
entered. PrintSmith calculates the amount of ink. 

 

You can also enter the number of pounds of ink directly and PrintSmith calculates the percent of 
coverage. The number of pounds of ink determines the price of the job. 

The following table can be useful in estimating the amount of coverage on a page. 

Ink Coverage Guidelines 

Type of Page Coverage 
% 

  

Light composition 15 

Normal composition 20 

Normal composition, bold paragraph heads 25 

Medium composition 35 

Heavy composition or halftones 50 

Solids 100 

Reverses 60-90 

Process Color 20-50 
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Defining Shipping Charge Method Charges 
The Shipping Charge method supports specifying the shipping address of a job and pricing based 
on the weight of a job. Job level charges use the weight of a single job, and invoice level charges 
use the weight of all jobs on an invoice. Shipping charges attached to the control job in a multi- part 
job includes the weight of all parts of the job in the calculation. You can override the weight in the 
actual shipping charge on a document if necessary. 

 

Shipping Charge 
method 

The shipping price is based on the weight multiplied by a rate. Pricing can be set up the following 
ways: 

• Use the rate to multiply the calculated shipping weight. 

• Use a mark up which multiplies the rate. 

Use Shipping Charges on a Document 

Adding the shipping charge to a document presents the option to select the Ship Via method, the 
Ship To shipping address, and to override the shipping weight. 

Shipping Ticket 

When a document contains a shipping charge a shipping job ticket page is printed that details the 
shipping charge information. 
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Selecting Quantity 
There are a number of different quantity types available from which you select from the Quantity 
menu. Not all of the quantity types are available with each pricing method. 

Changing the quantity type affects how quantities are entered, but does not directly change the 
price. A quantity can be entered as Time or as Quantity and the same price would be generated. 
Two hours can be entered as time or as a quantity. It is more involved converting an hour and 
fifteen minutes (1:15 as time) to 1.25 hours, hence the time method of quantity entry. Each quantity 
type is illustrated using the Preset Info window to demonstrate what it looks like when the charge is 
actually used. 

Number of Sets 

Normally, the Number of Sets quantity type is only used with Job Aware charges. The price is 
based on basic totals from the job and then multiplied by a user entered quantity. 

 

Example: The charge is 3¢ for each staple. A job aware charge is able to determine how 
many “sets” need to be stapled together, if there is a single staple in each set. To set up a 
charge that can be used for any number of staples, set the quantity type to Number of Sets. In 
this example, a single staple is being priced. If you change Qty/set to two, the price is 
calculated for two staples by multiplying by two. 

PrintSmith figures out the standard quantity, which gets multiplied by a user-entered Qty/ set. If 
there is a setup charge in the definition, the setup is only added once.  

This is not normally used in Always Ask charges because it would be multiplying a user entered 
quantity by a quantity that is normally a user entered charge. Unfortunately, the standard quantity is 
not available for user entry with this quantity method so it would have to have already been preset 
in the definition to work. Set this up by starting with the definition set to use Quantity, using Preset 
Info to set the quantity, changing the quantity type to Number of Sets and using Preset Info to set 
the quantity to 1. We are unaware of any value to this type of setup; it’s almost always easier to just 
use Quantity on Always Ask charges. 

Note:  Always use Preset Info with this quantity type to ensure the default quantity is 1 or the 
most commonly used quantity so it generates a price when first selected. If left set to 0, no 
price is generated until you enter a quantity. 
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Quantity 

This is the most common quantity type. It is appropriate for any job aware charge except markups 
and flat rate.  

 
You enter the quantity, which is multiplied by the rate for the price. If the method is set to Job 
Aware, the quantity automatically calculates. 

Time 

Time is useful for defining charges where price is based on hourly rates.  

 
Instead of a single value, there is a start and stop time. Enter the time as HH:MM (hours and 
minutes). You can use a colon “:” or decimal point to separate hours and minutes. 1.3 is treated as 
1 hour and 3 minutes and 1.30 is 1 hours and 30 minutes. If both a start and stop time are entered, 
the quantity is the difference between the two. If only one time is entered, PrintSmith assumes this 
is the total time. The quantity displayed for the job is always in decimal hours (i.e. 1 hour 30 
minutes is shown as 1.5 hours). 

Note: PrintSmith understands that a 9:00 start time and a 4:00 stop time is 7 hours although you 
can also use AM and PM to further clarify things or use a 24 hour time. 
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No Quantity 

Selecting No Quantity is equivalent to using the Flat Rate pricing method. It is only appropriate for 
use with the Flat Rate or Always Ask methods. 

 
 

Number of Sets & Setup 

Number of Sets and Number Of Sets & Setup are used when you want to be able to enter a 
multiplier for the entire charge. Both function identically. The only difference is in how setup 
charges are handled. In Number of Sets, the setup charge is added only once. In Number Of Sets 
& Setup, it is added to each set. 

An example of this is for Drilling charges when you require a single charge that can be used for 
any number of holes and charge a set up for each hole. Enter the number of holes. PrintSmith 
calculates the normal quantity, adds setup, and then multiplies this by the quantity entered for 
the number of sets. Always use Preset Info to preset at least a 1 in the Qty/Set field. A zero 
generates a price of 0.00 unless there is a set up charge. 
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Specifying Other Options 
There are a variety of additional options available for each charge for handling special 
circumstances and enforcing how a particular charge is used in the Estimator. 

Hide Price Only 

Selecting the Hide price only option does not display the price underlined (it will be hidden), but the 
charge description is still displayed (not underlined) in the Invoice.  This is different from the Hide 
charge in printouts option, which hides the charge description and the price.  

Note: The Hide price option can also be set in the Update Charge window. 

Hiding Charges in Printouts 

Not all charges need to be included in the document (invoice and estimate) printouts. To hide a 
charge (not include it in a printed document), check the Hide Charge In Printouts option. Hidden 
charges are underlined. 

WARNING: If a charge definition marked as hidden is added to a document as an invoice level 
charge, it will be un-hidden (unless it is a markup). PrintSmith only allows job level 
charges and invoice level markups to be hidden and displays charges that are not allowed 
to be hidden because of how they are used. When this happens, PrintSmith warns you. 

No Overrides 

This option prevents anyone from overriding the quantity or price in the charge. Changing the 
quantity is treated as an override in job aware charges because PrintSmith generates the quantity 
automatically. 

 

Price cannot be edited 
if the No Overrides 
option is enabled. 
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Adjustable Sets 

When this button is enabled, you can change the set size on charges in the Estimator. This allows 
you to enter the number of sheets per lift in a cutting charge on the estimate. This option should be 
turned off most of the time. 

 

The In Sets Of 
Fields is displayed 
when the Adjustable 
Sets option is 
enabled. 

 

Adjustable Rate 

You want the flexibility of changing the rate on a charge. Enabling this option gives you this ability. 

 

The Rate field is displayed 
when the Adjustable Rate 
option is enabled. 

The Adjustable Rate option also affects how charges are handled when a document is recalculated 
or copied and prices are updated. PrintSmith assumes that this option is used for charges where 
you frequently change from the defined rate, and just use the rate in the charge as a starting point. 
When a charge with an adjustable rate is reloaded in the Estimator, the rate is left unchanged. 

If No Overrides is also enabled, the rate is displayed, but you can not change it. 
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Adjustable Material 

This option is rarely used simply because a material rate is extremely rare. Like the Adjustable 
Rate option, it allows the user to change the material rate in the Estimator. 

 

The Material and Material 
Quantity fields are displayed 

if the Adjustable Material 
option is enabled.

The example above shows a charge with both a rate and a material rate. This is how you would set 
up this charge. A material rate should only be specified in the unusual case where you need more 
than one rate and more than one quantity. 

Enabling this does not guarantee the material rate can be changed because there is room for a 
limited number of fields and this option has the lowest priority. Always use Preset Info to make sure 
that the data field is present. 

Do Not Discount 

This setting allows for charges, such as postage or shipping charges, to not be affected by 
discounts. When enabled, the charge is excluded from customer and markup discount charges. 
This type of charge is shown in the Invoice Window with a “∆” next to the price. 

Ignore Global Price Changes 

This setting results in the charge not being affected by global pricing updates done via the Change 
Price window.  For example, a 10% markup charge is not affected by a price increase, which could 
result in incorrect functionality. 

Excluded from Production 

With this option set, the charge is not displayed in the Tracker windows. 

Tracker Pre-Production 

This setting allows work to be done on an Invoice before the job is released to production. 
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Entering Pricing Data 
The pricing data entry portion of most charges is identical except for Cutting Charges and Ink 
Charges. In the Charge Definition window, there are six checkboxes with corresponding data fields 
in the pricing area. Each checkbox controls the field to the right. If the box is selected, the field is 
used for pricing. If the box is grayed-out, it cannot be used.  

 
Entering an amount in any field automatically enables the box associated with the field. Un-
checking a box hides the contents of the associated field. The information is not deleted. 

Setup - A Setup charge is added in addition to the standard price. It modifies the basic formula as 
follows: (quantity x rate) + setup = price 

Minimum - Entering a Minimum amount guarantees that the price generated for this charge is 
never below the minimum entered in this field. 

Rate – The Rate is the primary rate used for charges. This field is used in the majority of charge 
definitions. Alternatively, a rate list can be used to define a variable rate. 

In Sets - When the rate you enter is for a quantity other than 1, you need to specify the unit 
quantity. To enter a price such as 12.00 per thousand, you can enter 12 for the rate and 1000 for In 
Set. 

Example: When asked, many people communicate prices in sets (i.e., folding is 12.00 per 1000), 
but they actually charge for the service on a per piece basis (e.g., 0.012 each rather than 12.00 per 
1000). The difference is important. In the following table, 1001 folded would cost $24.00 (2 sets) if 
priced by the set, and 12.01 if priced per piece. You may wish to price in units of 10 or in some 
cases 100. 

Choosing a Set Size for Charges Example 
 Prices Using Different Set Sizes 

Quantity Ordered $12.00 per 1000 $1.20 per 100 $0.12 per 10 $0.012 each 
     

100 12.00 1.20 1.20 1.20 

250 12.00 3.60 3.00 3.00 

275 12.00 3.60 3.36 3.30 

1000 12.00 12.00 12.00 12.00 

1001 24.00 12.12 12.12 12.01 

1100 24.00 13.20 13.20 13.20 

2000 24.00 24.00 24.00 24.00 
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Material - Occasionally, you may encounter a pricing situation where you need more than one rate 
to properly price an item. Normally this would only occur on a job aware charge where two different 
In Sets are needed. Otherwise, you should simply add the rates together and enter them in the 
Rate field. 

Note:  Material should be used in conjunction with Rate. If there is only one rate, it should always 
be Rate. Never use Material over Rate. 

When the rate you entered is for a quantity other than 1, you need to specify the unit quantity. 
Turning this option on adds a field to the definition where you can specify that quantity. To enter a 
price such as 12.00 per thousand, you need to enable the Material Sets button. In the definition, 
enter 12.00 for Material and 1000 for In Sets Of value. 

In Sets - In Sets for material works the same as In Sets for Rate; except, of course, that it applies 
to the Material rate. 

Using Price Lists for Added Flexibility 

Price Lists add a lot of pricing flexibility to charges. You can add a price list to any charge, even if 
the pricing method does not require one. These price lists let you set up a job aware charge so that 
the rate it uses changes with the quantity. 

Price lists are controlled using the Price List button to attach, detach, delete, and create new price 
lists. It is not necessary to create a unique price list for each charge definition. Any price list can be 
shared by any number of charges. 

If you are creating a price list for use by a single charge definition, we recommend that you use the 
name of the charge as the name of the price list. It is also a good idea to avoid having price lists 
with duplicate names because it is very difficult to figure out which price list to use. 

Assigning Price Lists in the Charge Definitions Window 
Price Lists can be assigned to specific charges. To assign a Price List: 

1. Select the applicable charge from the hierarchical list. The selected item is highlighted 
and the additional details are displayed. 

2. Click the Price List button. A List window displays the available price lists. 

3. Select the applicable price list. The selection is highlighted. 

4. Click the Select button. The List window is closed and the selected Price List is 
displayed to the right of the Price List button. 

Note:  Remember to update the charge definition by clicking the Save button in the main 
definition window. 
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Creating a Price List 
If the charge does not have a price list, clicking the Price List button displays a list of all price lists. 

 

Assign Selected Price List 

Clear Assignment 

Create New Price List 

Delete Selected Price List 

Closes Window without Performing 
an Action 

You can create an unlimited number of price lists. However, you are probably able to operate with 
just a few since you can assign the same table to more than one charge definition. The Save As 
command in the File menu can be used to copy a price list and give it a new name. 

Note:  Changing a price list in any charge definition changes the base table, which may be 
attached to other charge definitions using that table. 

Clicking the New button opens the table definition window. 

 
Resize the window 

This window is used throughout the pricing system to set up price lists. It is also used for waste 
charts and speed tables. In this context, the window is used to specify the name of the price list.  

Use the zoom box to change the size of the window and show or hide configuration details. 

You must at least enter a name for the price list in the title field. It is best to use the same name for 
the price list as the charge definition it’s created for. It is easier to manage changes to a price list if 
it is only used once. There may be times when this is not appropriate. For example, if you are 
setting up a series of charges that price the same except a different setup or minimum is used on 
each charge, it makes sense to use the same price list. Similarly, if you are setting up a standard 
discount table that is to be applied to a class of charges such as book binding, a single price list is 
much easier to manage. 

Change how the price list is used and displayed by editing the set up options for the price list. 
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Properties of Price Lists 

Amount Type 

Each price list consists of two columns. The first column always contains a quantity. The second 
column contains a price if the Amount is Currency option is selected and a percentage if Amount is 
Percent is selected. 

Most often, the Amount Type selected only affects the appearance of the price list when it is open. 
It does not have any effect on the generated price. 

Interpolation 

Interpolation is valid with all types and changes the returned value, not how it is used. 

Example: You set up a book binding charge and for each book; you want to charge $3.00 for 
10 or less books, $2.75 up to 50, $2.50 up to 100, and $2.00 after that. You would set up a 
rate list without interpolation as follows: 

 Quantity Price 

     10 3.00 

   50 2.75 

   100 2.50 

   101 2.00 

The Interpolate button changes the rate used for the price of booklet jobs between 10 and 100 
because PrintSmith calculates intermediate rates or prices for quantities that fall between the 
quantities in the price list. For example, 75 books would use a rate of $2.875. 

Last Line Is Add’l Qty 

This option is used to determine pricing for quantities that exceed the final quantity listed. Use this 
option only with Amount is Currency. It adds an amount to the returned value to adjust the price for 
quantities that are greater than the last line in the charge. When enabled, the last line is used to 
generate a price when the quantity exceeds the last item on the list. If there’s no additional quantity 
on the price list and the quantity is larger than the last quantity listed, the last price on the list is 
used. A quantity of 2000 would be $95.00, in the left price list and a price of $100.00 in the right 
price list. This option should be off when the price list is used as a rate list. 
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Types of Price Lists 

The following table defines the various types of price lists available.  

Types of Price Lists 
Type Purpose Options To Be Selected 

   

A Add an amount to the price of the charge Amount Is Currency 
Last Line Is Add’l Qty 

 Determine the price of the charge Amount Is Currency 
Last Line Is Add’l Qty 
In the charge definition: turn off Rate button. 

B Determine rate based on quantity (e.g. 1 is $5, 10 is $4 
apiece, 20 is $3.50 apiece) and add it to the price of the 
charge. 

Amount Is Currency 
Use As Rate List 

 Determine rate based on quantity (e.g. 1 is $5, 10 is $4 
apiece, 20 is $3.50 apiece) 

Amount Is Currency 
Use As Rate List 
In the charge definition: turn off Rate button. 

C Function as a markup and/or discount table that modifies 
the price of the charge based on the quantity. 

Amount Is Percent 
Use As Rate List 

D Markup or discount the price of the job to which the charge 
is attached based on the quantity of the job.  This should 
only be used on Job Aware charges because the quantities 
in the job are needed to look up the discount rate. 

Amount Is Percent 
Use As Rate List 
Production Discount 
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Entering Data in Price Lists 
After entering the name of the table, enter the quantities and speeds, click the OK button and the 
new price list is created. 

 

<tab> key changes column 

<return> key changes line  

arrow keys on keyboard 
change selection 

The first zero quantity 
denotes the end of the 

list. 

 

As the quantity increases, so should the price. The entire list need not be used. At the very least, 
the first two lines must be defined. 

You can specify up to 15 different quantity/price combinations. When you enter the quantities, they 
should be sequential with the smallest quantity at the top of the list and at least the first two 
quantities specified. The maximum quantity does not need to be the largest quantity you will ever 
use. When the quantity in the job is larger than the largest value in the price list, the last price in the 
table is used. 
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Using Price Lists with Different Pricing Methods 

There are only two issues regarding price lists: the quantity used to look up the value, and what to 
do with the value that is returned. How each charge pricing method uses price lists is discussed 
below. 

Method Uses 
  

Job Aware Lookup quantity depends on charge specifications. If only material is used then the 
lookup quantity is sets x runs x originals, where sets is calculated using the material 
set count. If rate is also used the same calculation is performed using the rate set 
count and the material is ignored. If the quantity specified in the charge definition is 
Number Of Sets or Number Sets & Setup, the number of sets also multiplies this 
amount. The most important use of price lists with Job Aware charges is when you 
want the price to vary with the quantity, in effect, a quantity discount. Types A, B, C, 
and D are all recommended. 

Markups Lookup quantity is the job price, prep, bindery, production totals, the entire job or the 
entire amount of the invoice depending on what type of markup it is. Type B and C are 
recommended. Types A and D are not. 

Flat Rate This type of charge should not be used with a price list. 

Always Ask The lookup quantity is the number of sets. The quantity is calculated using the set 
count and the user entered quantity. Types A, B, and C are recommended as needed. 
Type D is not. 

Price List Forces the attached price list to type A. 

Rate List Forces attached price list to type B. 

Cutting Charge This method is calculated exactly the same as Job Aware charges. The only difference 
is that the Qty/Set: is set to the estimated number of cuts before processing as a 
standard “Job Aware” charge. If the charge definition is in the Pre Press command, it 
calculates cuts from the Parent Size to the Run Size. If it is in the Bindery command, it 
calculates cuts from the Run Size to the Finish Size. The lookup quantity is the number 
of lifts per cut. For example, if Sheets Per Lift was 500, quantity ordered was 1000 and 
number of cuts was 3 – the lookup quantity would be 2 (there are 2 lifts of 500 each). 
All types are valid; B is best for variable rate cutting. 

Ink Charge The number of pounds is used for lookup (rounded up for fractional pounds). All types 
are valid: B is normally recommended for variable ink charges. 

Shipping Charge The weight of the associated job or document. 
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Modifying a Price List 
Once a price list has been assigned to a charge, click the name of the assigned list to open. You 
can change the price list and click the OK button to save the changes. 

Note:  Remember, the price list may be used by other charge definitions and any changes you 
make affect those charges too. 

 

Removing a Price List from a Charge 
To remove a price list from a charge, click the Price List button. When the list selection window 
opens, click the Clear button. Remember to update the charge definition by clicking the Change 
button in the main definition window. 

 

Changing the Selected Price List 
To use a different price list, click the Price List button. PrintSmith opens the Price List. Select a 
price list, or click the Clear button to remove the existing price list assignment. 

 

Changing the Name of a Price List 
In order to change the name of an existing price list, you must open the price list. If it is already 
assigned to a charge, select the charge definition and then click the price list name. If it has not 
been assigned to any charge yet, you must assign it to one at least temporarily.  

When the window is open, resize the window so the name of the table is visible in an edit field. 
Click the edit field and type in a new name. When you click the OK button, the name is changed. 

Note:  Changing the name of a price list automatically changes the price list name on all charge 
definitions using that table. 

 

Deleting a Price List 
To delete a Price List, click the Price List button. When the Price List opens, select the Price List 
and click the Delete button. 

Note:  Remember, the price list may be used by other charge definitions. Before deleting a price 
list, make sure it is not being used by any other charge definition. 
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Assigning Waste Charts to Charges 
Even though there is a system wide waste chart, PrintSmith recognizes each type of charge can 
have different spoilage characteristics. To support this, each charge definition can have its own 
waste chart. 

The procedures for managing waste charts are nearly identical to those used for price lists. There 
are two steps to setting up a waste chart for a charge: creating the waste chart and assigning it to 
the charge definition. Once a waste chart has been assigned to a charge definition, the name of the 
waste chart is displayed to the right of the Waste Chart button. 

Assigning Waste Charts in the Charge Definitions Window 
Waste Charges can be assigned to specific charges. To assign a Waste Chart: 

1. Select the applicable charge from the hierarchical list. The selected item is highlighted 
and the additional details are displayed. 

2. Click the Waste Chart button. A List window displays available Waste Charts. 

3. Select the applicable Waste Chart. The selected item is highlighted. 

4. Click the Select button. The list window is closed and the selected Waste Chart is 
displayed to the right of the Waste Chart button. 

Creating a Waste Chart 
If the charge does not currently have a waste chart, clicking the Waste Chart button displays a list 
of all the waste charts in the system. 

 

Assign Selected Waste Chart 

Clear Assignment 

Create New Waste Chart 

Delete Selected Waste Chart 

Closes Window without Performing 
an Action 

Create as many waste charts, as you like. You can define a waste chart for each charge; however, 
it is likely that you can operate with just a few waste charts. You can assign the same waste chart 
to more than one charge definition. 

Note:  Changing a waste chart in one charge definition changes it in all the definitions using that 
chart. 
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Clicking the New button opens the Waste Chart definition window. 

 
This window is used throughout the pricing system to set up price lists. It is also used for speed 
tables. For waste charts, the button settings are determined by PrintSmith, and cannot be changed. 

Note: The Interpolate option has been grayed out and cannot be changed. Because it is 
enabled, PrintSmith calculates intermediate values if the quantity being looked up does 
not exactly match a quantity in the table. The result is a smooth curve. 

 
The entire list must be used. Run length must increase from top to bottom. As the quantity 
increases, the waste percentage should decrease in small enough increments. Avoid the number of 
wasted sheets becoming smaller on longer runs. 

A complete waste chart consists of 15 quantity/percentage combinations. The maximum quantity 
does not need to be the largest quantity you will ever run. When the quantity in the job is larger 
than the largest value in the waste chart, the last percentage in the chart is used. 

Use the File > Print from the main menu to print a waste chart. 
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Modifying a Waste Chart 
Once a chart has been assigned to a charge, click the name of the waste chart to open it. You can 
change the waste chart and click the OK button to save the changes. 

Note:  Remember, the waste chart may be used by other charge definitions and any changes 
you make affect those definitions too. 

 

Changing the Selected Waste Chart 
To use a different waste chart, click the Waste Chart button. PrintSmith opens the Waste Chart 
List. Select a new chart, or click the Clear button to remove the existing waste chart assignment. 

 

Changing the Name of a Waste Chart from the Charge Definitions Window 
In order to change the name of an existing waste chart, you must open the waste chart. If it is 
already assigned to a charge, select the charge and then click the Waste Chart Name. If it has not 
been assigned to any charge yet, you must assign it to one temporarily. 

When the window is open, resize the window so the name of the table is visible in an edit field. 
Select the edit field and enter a new name. When you click the OK button the name is changed. 
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Defining Preset Information 
The Preset Info window is used for several functions: customizing the prompts to more clearly 
describe the data to be entered, pre-loading the most common quantity on charges that are not Job 
Aware, and testing pricing. 

Note:  Do not use this window with job aware charges to test pricing. There is no job to pull 
information from and the charge has no source for the information it needs to calculate a 
price. 

To open the Preset Info window, click the Preset Info button. 

 
 

Setting Options in Preset Info Window 
Use it to preset several important flags that indicate whether the item is taxable, if the quantity 
should be displayed, if the job is brokered and if pricing is finished. This window is the only place 
where the finished, taxable, brokered, and display quantity buttons can be preset. 

Finished - This button is used to mark charges whose pricing is not yet complete. When selected, 
a “?” displays in the document windows total column for the charge. 

Taxable - Each line item on a document can be marked as taxable or nontaxable. This button is 
used to preset the tax status of each charge. It should only be turned off for those items that are 
never taxed since it can easily be changed in the estimator. 

Brokered - When marked, a “B” displays in the document windows total column. It is normally used 
to mark jobs and charges that have been sent out for production. It is never printed on invoices or 
estimates. 

Display Qty - Disable when all you want on the invoice is the name of the charge and perhaps the 
price. This is usually enabled. 

Show Notes - Each charge definition has a Description and a Notes field. Turn on Show Notes if 
you want the contents of the Notes field added to the description in the document. Disable if the 
Notes field is used for instructions on how to use the charge or information intended for production 
personnel. 
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Customizing Labels in Preset Info Window 
Perhaps its most important use is the ability to customize the labels on the data entry fields so that 
they are more intuitive. PrintSmith supplies a set of generic labels for each data entry field. 
Because they are generic, they don’t necessarily describe the data that’s required of the user. 
Changing the labels can decrease the amount of time it takes to train people how to use charges in 
the Estimator. 

Changing the labels shown could make a big difference to the user. It is not immediately apparent 
what Qty/set: means. Staples clearly describe what the information represents. <Option>+<shift> or 
<alt>+<shift> causes any custom labels to be removed. Clicking the Change button saves, wiping 
out any custom labels you have set up. It is useful for resetting the labels to their default values. 

 

Previewing Preset Info as it would Appear in the Estimator 
It previews how the charge appears in the Estimator when it’s actually used. Holding down the 
<option> or <alt> key when clicking the Preset Info button opens the window in preview mode 
(which is exactly the same way the charge is shown in the Estimator). In this mode, values cannot 
be edited. 

Since this window gives you a preview of the charge as it is used in the Estimator it can be used to 
test pricing. Enter a quantity and press <tab> to see the price. Make sure to restore the quantities 
to the values you want displayed when the charge is initially added to a job or document before 
clicking the Change button. 

Note:  If you use Preset Info to test the pricing on a job aware charge, it appears as though you 
are overriding the quantity. This override is temporary. When the charge is saved, the 
override is removed. There is no useful purpose served by overriding a job aware charge, 
it prevents the charge from doing its job. Use Always Ask charges if you need to preset a 
quantity on every job. 

 

Entering Quantities in Preset Info Window 
It lets you set up quantities for certain types of charges so that when selected, the most common 
quantity is already entered. 

Note:  Changes made in the Preset Info window are not permanent until the charge is saved in 
the main definition window. 
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Defining Costing Rules from Charge Definition Window 
Costing can be defined for a specific Charge. To define costing rules: 

1. Select the applicable item from the hierarchical list. The selected item is highlighted 
and additional information displayed.  

2. Click the Costing button. The application determines the last time the charge was 
costed in the Estimator and populates that information, acting as a starting point for 
modification. 

Note:  If the charge has not been costed, a No Costing  icon is displayed to the left 
of the item name in the hierarchical list, No Cost is selected as the default 
Costing Method, and the Status is New. 

3. Select the applicable Costing Method (No Cost, 100% Cost, Unit Cost, Time and 
Materials). Applicable fields and buttons become active based on the Costing Method 
selection made. 

Defining Unit Cost Costing 

Unit Cost can be defined by:  

1. Entering a Setup Cost (if any).  

2. Entering a Unit Cost, the cost of performing one unit of the charge.  
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Using a Rate Table to Define Unit Cost 

Unit Cost can also be defined using a Rate Table instead of Unit Cost. To use a rate table: 

Unit Cost and Rate Costing Method Example 

 

The Rate button is 
activated when Unit Cost 

is selected.

 

1. Click the Rate button. When Unit Cost is selected as the Costing Method the Rate 
button is activated. 

2. Select the applicable Rate table. The selected item is highlighted. 

3. Click the Select button. The List window is closed and the selected Rate table is 
displayed to the right of the Rate button. Variable is automatically entered as the 
value for Unit Cost. 
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Creating a Costing Rate Table 

If a new rate table is needed when defining unit cost: 

1. Click the New button in the list of available rate tables window. 

New Price List Window 

 
2. Select the Use As Rate List option. The Price column is relabeled to Price. 

New Rate List Example 

 
 

3. Enter the Quantity and Rate information. 

4. Name the rate table. 

5. Click the OK button. The newly created rate table is listed the next time you access 
the list of available tables. 
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Defining Time and Materials Costing 

To Define Time and Materials Costing: 

1. Enter Fixed Materials. 

2. Enter Unit Materials 

3. Enter Labor Rate. 

4. Enter Setup in minutes. 

5. Enter the number of Pieces/Hour. 

 

Using a Costing Speed Table to Define Time and Materials 

When Time and Materials is selected as the Costing Method, the Speed button becomes active 
and a Speed Table can be assigned.  

Time and Materials and Speed Costing Method Example 

 

The Speed button is activated 
when Time and Materials is 

selected.

 

To assign a Speed Table: 

1. Click the Speed button. A List window displays available Speed Tables. 

2. Select the applicable Speed Table. The selected item is highlighted. 

3. Click the Select button. The List window is closed and the selected Speed Table 
name is displayed to the right of the Speed button. 
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Modifying an Existing Charge 
To modify an existing charge: select it from the category, modify the definition, and click the Save 
button. 

Note:  When you first get started, you may make frequent changes. Once PrintSmith is running, 
use caution when changing charge definitions. 

It is easier to create a new charge than to completely change how an existing charge is used. 
When PrintSmith updates charges to use current pricing in a document, it locates the charge 
definition using an internal serial number assigned to the charge when it was created. When the 
charge is located, its current definition is copied to the charge in a document. If you reuse an 
existing charge definition, PrintSmith still updates the charge using the current definition. This 
practice could cause confusion and should be avoided. 

Example: A Folding charge, originally defined at 1¢ per sheet is changed it to Die Cutting at 
$25.00 each. When PrintSmith updates the pricing on an invoice, it changes the pricing for the 
folding charge to die cutting. The problem is that the original invoice text still indicates a folding 
charge.  

When PrintSmith updates a document’s charges, it compares the name of the charge in the 
document to the name of the charge definition. If they do not match, PrintSmith shows both the old 
and new names, and ask if you still want to update the pricing on that charge. For this reason, you 
should try to name your charge definitions exactly as you want them to be printed on an invoice or 
job ticket. Where possible, use the Notes field to modify the charge description without changing 
the name. 

It is perfectly acceptable to change a charge definition because you have changed how the charge 
generates a price. Always add a new definition when a new charge is needed. Never reuse an 
existing definition. 

Duplicating Charges 
There are several ways to duplicate or copy charges. The easiest method is to hold down the 
<option> or <alt> key and drag the charge to a new location, a different category, or even a 
different command. Change the name of the charge and click the Save button. 

When dragging a charge in to a different category, you must drag it below the category in the 
category list. If the category you are dragging to is in a different command, you can select the 
category in the destination command and then drag right into the charge list to place the charge 
exactly where you want. 

Deleting Charges 
To delete a charge, select it and click the Delete button. Alternatively, you can select it and then 
select either the Cut or Clear commands from the Edit menu. The Cut command saves a copy of 
the charge to the Clipboard and you can Paste it back into another command or category. Selecting 
a charge and pressing the <delete> key is the same as using the Cut command. 
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Using Charge Definitions 
Using charges effectively can make a big difference in how well PrintSmith works for you. When 
working in the Estimator, you normally attach charges to either a job or a document (Estimate or 
Invoice). Charges attached to a job are referred to as Job Level Charges and those attached to a 
document are referred to as Invoice Level Charges. 

When a charge is attached to a job, it is included in the total job price when you generate a price 
list or multiple quantities on a quote. Markup charges that mark up part of a job must be attached to 
a job. Markup charges that mark up an entire invoice must be attached to a document. Except for 
the restriction on markup charges, any charge from any command can be attached to a job or a 
document. 

The level at which the charge is attached is determined by the window that is open when the 
command is selected. If a job window is open when a charge command is selected in the Invoice 
menu, the charge is attached to the job. If a document window is open and no job window is open, 
the charge is attached to the document. If the Cash Register window is open and selected, the 
charge is added to the current cash register transaction as a “Quick-Est” transaction. If neither a job 
nor a document window is open, the charge is not attached to anything. This feature is useful if you 
want to quickly check the price on a charge. 

On some charges, you may also want to customize the labels for the charge so that when the user 
sees the charge in the Estimator there is no doubt what information is needed to price the job. An 
example might be a drilling charge where the user enters the number of holes. A normal setup for a 
drilling charge would show a field entitled “Qty/set:” for the number of holes. Changing the label to 
“# of Holes” would be much clearer. Labels can be changed within the Preset Info window.  

Overriding a price or rate should be avoided as that prevents PrintSmith from updating the prices if 
the document is used for a repeat order. When setting up a charge definition, set it up so it handles 
an entire range of situations without requiring you to override the price. 

Testing Pricing 
This is a key step before going on-line with PrintSmith. After you have entered your pricing 
definitions you should create estimates and generate price lists to ensure you are getting the prices 
you desire and the specifics entered work properly. A good way to verify your pricing is to take a 
sample of recent invoices and re-create them in PrintSmith. This process verifies your pricing is 
complete and provides familiarity in using PrintSmith. 

When you are ready to go live you can reset your system to eliminate all test invoices, estimates, 
etc. When you are starting out you might give everyone the ability to override prices. As you 
continue to modify your pricing and are confident that your assumptions are complete, restrict the 
ability to override prices. 

Printing Price Lists 
Now that you have completed your pricing assumptions you should test them by printing and 
reviewing printed price lists. PrintSmith provides several ways to print price lists. Price lists can be 
printed for all printing jobs, copy jobs, papers, etc. Use PrintSmith’s powerful price book generators 
to print price lists.  Select Pricing > Generate Price Book from the main menu. 
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Press Definitions 
Press definitions are a key component of PrintSmith’s powerful estimating engine. In press 
definitions, you define key variables of your company’s pricing practices that influence profitability. 

Setting Up Press Definitions 
The Press Definition window is where you enter the types of presses you have and define their 
running characteristics. While you may only have a few presses in your shop, you can define 
several presses to accommodate differing pricing characteristics of a given job. For example, tight 
registration, coated stock, carbonless forms, etc. can all run on the same press, but one may run 
slower, or take longer to set up, or require more waste. You can define up to 100 press definitions. 

Select Pricing > Press Definitions from the main menu.  The Press Definition window opens. 
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To print a report of all press definitions, select File > Print from the main menu. 

 
The report lists each press definition, its labor rate, labor markup, set up times, speed table, waste 
chart, wash up charges, and attached charges. 

Review the press definitions in PrintSmith. The Machine ID field in PrintSmith allows you to group 
press definitions for reporting work in progress. For example, you may define four different press 
definitions for your Heidelberg Quick-Master but only have one actual press. Entering the same 
Machine ID in those four definitions allows you to view work in progress for all four presses even 
though there is one piece of equipment. 

The Name of the press helps the user understand the specifics and assists them in selecting the 
correct press for the job. Name your presses to reflect the situations in which they are used. 

Define the maximum paper size that can be run on this press. PrintSmith warns you if the paper 
selected for a job exceeds the maximum paper size. 

For each press, you can define average impressions per hour or attach a variable speed table. 
The speed table lets you adjust the speed of the press based upon quantity produced. You can 
also attach a waste chart to each press definition. If no waste chart is attached, the press definition 
uses the default waste chart. 

Note:  It is recommended that you title Speed tables and Waste charts with a name that matches 
their characteristics (i.e. High Waste, Slow Speed, A.B Dick 9870, etc.). 
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PrintSmith allows you to attach up to 10 charges on each press. Whenever the press is selected, it 
adds those charges. For example, you could add Metal Plates, Ink, and Cutting to each press and 
they would be automatically included on all jobs estimated with that press definition. 

PrintSmith gives you the ability to track the sales generated from each press into a specific sales 
category.  

Example:  The following window shows the assumptions for a press named Hamada H234. 

  

This information will 
be used as the 
basis for costing 
printing jobs. 

A custom speed 
table and weight 

chart are 
assigned 

Three 
charges are 

attached. 

Verify the speed and waste tables by clicking on their respective buttons. Change the rates to meet 
your requirements. 

Click the Charges button to see which charges are attached. Add more, remove, or accept those 
assumptions. You can attach 10 charges to any one press. 

Developing Press Definitions should be a quick process. If you define the presses before you enter 
your stocks, you can assign a press definition to the paper definition in the set up. 

Note:  Plate fees should be added by attaching a Pre press charge. 
PrintSmith uses press definitions to determine production costs for jobs using the Printing pricing 
method. Press Definitions are also used with List pricing to estimate the run time of a job for the 
Work in Progress report. 
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You can define up to 100 different press definitions. A press definition defines how the job is run, 
the labor rate, press speed, waste, markups and preset charges. A press definition is not 
necessarily related to a single machine. You might have a special press definition for carbonless 
forms, envelopes, business cards, coated stock and so on.  

The buttons at the bottom of the window are used in conjunction with the selected press definition: 

 
Add/Change  

This button is used to save the current contents of the window. If you are creating a new press 
definition, it adds it.  If you are working with an existing definition, it changes it. 

Stock Price List  

The Stock Price List button allows you to generate a price list for any press definition. Before the 
price list is generated, you select the stock to be used with the press definition. It is particularly 
useful to tune your press definition for a particular stock without continually going back and forth 
between stock and press definitions. 

Press Price List  

The Press Price List button allows you to generate a price list for any press definition. This price list 
is exactly the same, as the one generated from Stock Definitions except it does not include a stock 
price. Use this to generate production price lists. These price lists can be useful for manually 
calculating an approximate price for a special order paper. 

Delete  

Deletes the selected press definition. 

Clear/Close  

If you have selected a definition, the Clear button erases the information leaving you with a blank 
window so you can create a new definition. The Close button closes the Press Definition window. 

 

Default Press Selection in the Estimator 
Set the Default Press by clicking in the Default column to the left of the press. This default is the 
press that PrintSmith uses when the stock definition does not have a preset press. Refer to the 
Organizing Press Definitions section, page 115. 
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Managing Press Definitions 
When the window first opens, you are ready to create a new press definition. To create a definition, 
fill in the data and click the Add button. After saving the press definition, the window clears so you 
can add another definition. The new press definition resides at the bottom of the list. 

Selecting an Existing Press Definition 
The top part of the window contains a list of the existing press definitions. Clicking once on any 
item in the list displays the definition. The Add button now reads Change because an existing press 
definition is selected. To update the definition, click the Change button. 

When a press definition is displayed, there is a Clear button, selecting it clears the definition from 
the window and presents a blank record so you can add another press. The button label then 
changes to read Close. Selecting it closes the press definition window. 

Creating a New Press Definition 
When the Press Definitions command is first selected, the window opens with an empty press 
definition. You add a press definition by filling out the text boxes and clicking the Add button. If the 
button in the lower left hand corner is the Change button you must first click the Clear button to get 
a blank definition. You can also use the New command in the File menu. 

Changing an Existing Press Definition 
To change a press definition, first locate the press in the list of presses at the top of the window. 
When you find the press you wish to change, click on the name and PrintSmith displays the 
definition. After you have made your changes, click the Change button to save them. 

Copying an Existing Press Definition 
The easiest way to duplicate a press definition is to select it, hold down the <option> key on 
Macintosh or the <alt> key on Windows, and drag the press you want to copy to a new location in 
the list. When you release the mouse, the press is copied. Enter a new name and save the 
changes. 

Existing Press Definitions can also be copied by selecting a press definition and clicking the Clear 
button or select the New command in the File menu. This action sets up a new untitled definition 
using exactly the same parameters as the definition you want to copy. Type in a new name and 
click the Add button. 

You can also use Edit menu commands to copy and paste definitions. To do this, click on the 
definition to be copied, select Cut or Copy from the Edit menu. Click the Clear button, and then 
select the Paste command from the Edit menu. 

New Definitions are added to the end of the list. You can move a new definition to a different 
position in the list by dragging. Refer to the Organizing Press Definitions section, page 115 for 
more information. 
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Deleting Press Definitions 
Find the press definition in the list and select it. When the definition is displayed, click the Delete 
button. 

When first setting up your pricing system you can safely delete any press definition. After you are 
up and running, we recommend more caution when deleting definitions. You can still delete any 
press definition, but you may want to keep definitions that have been used as a preset press in a 
stock definition or by the estimator in a job. 

If you would like to retain a definition but no longer use it, we recommend moving it to the end of 
the list. When you create a press job, a press definition is selected. When the job is saved, the fact 
that this particular press was used is part of the job. When the job is copied to a new invoice or 
changed in any way, PrintSmith selects the press definition from the pricing system and uses it to 
adjust the price. PrintSmith can find the definition even if you have changed the name or location in 
the press list, but not if it was deleted. When this occurs, PrintSmith warns you that the definition is 
missing and that a press needs to be selected. 

If you preset a press selection in a Stock Definition and then delete that press definition, PrintSmith 
automatically selects the default press. The user may not recognize this and an incorrect price 
could be given to the customer. 

On the other hand, if you make major changes to the pricing system, you may want to call attention 
to the fact that deleting some press definitions changed pricing. When you use an old job that was 
priced with the “old” pricing system, the Estimator warns you and recommends changing 
definitions. At this point, the user can select the proper press from a list. 

Organizing Press Definitions 
To change the position of a press definition in a list, click (and hold) on the press name and drag 
the entry to the desired position in the list.  Repeat this operation as often as you like until all of the 
presses are in the order you want.  
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Setting Up Press Definitions 
The press data entered is used by PrintSmith to estimate the amount of time needed for the job 
and the labor rate to apply. It determines the amount of setup time, the speed of the press and so 
forth. 

Name  

The Name field can hold up to 50 characters, identifying the press. 

Machine ID 

The Machine ID is a number from 1 to 255, identifying the machine. If you use more than one press 
definition for each real machine, you can identify the machine with a number. 

The Machine ID is used by Work In Progress to sort jobs by the machine the order will run on, 
rather than the press definition name used to price the job. 

Machine Name 

Select the Machine Name from a dropdown list.  Machine names are defined in the Production 
Presses table.  The Machine Name displays on the Job Ticket. 

Integrated device 

A future enhancement will allow presses to integrate with third party devices. 

Output Description 

Enter a description for the type of output for this printing process.  The Output Description appears 
on the Job Ticket. 

Production Location 

The Production Location field supports the Tracker Module.  Production Locations are defined in 
the Production Locations table. 

OEM Device ID 

The ID by which the device is identified. 

Max Paper Size / Min. Paper Size 

These fields are used to indicate the larges/smallest size paper that can be run on the press. The 
Estimator uses this to check for an improper press specification. You can leave it blank if this is not 
important to you. The Estimator still allows you to specify a press with a smaller/larger run size but 
reminds you that the run size is larger/smaller than that allowed by the press. 

Avg. Impressions  

The Average Impressions field defines the speed at which the press usually runs. The Estimator 
uses this value to determine how long it takes to run a job. You can override this value for a 
particular job in the job’s Production Data window. If you define a speed table for the press, the 
amount entered here is ignored, replaced with the word variable and the speed is taken from the 
table. 

Labor Rate  

The Labor Rate is the cost per hour to run the press. This value is used as the cost basis in the 
costing system. 
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Labor Markup  

The Labor Markup field is the markup on the labor rate when generating the production component 
of a print job price. The markup is multiplied by the labor rate to determine the charge for labor. 
This value is used as profit in the costing system. 

Minimum Labor  

The Minimum Labor field indicates the minimum number of labor minutes assigned to a job. Use 
this field when you want to charge a penalty for short runs on a particular press or establish a 
minimum price for using this press. 

Fixed Waste  

Fixed Waste is the number of sheets of spoilage to add to all jobs that use this press. This value is 
in addition to waste calculated as a percentage of the run, which is determined by a waste chart. 

Setup  

Setup is the number of minutes usually required to prepare the press for the first run of a job. 

# Heads  

The Number of Heads field is the number of print heads (impression cylinders) on the press. This 
field determines the number of passes needed to print a number of colors specified in the job. 

Setup Add’l Head  

The Setup Additional Head field records the additional time needed to prepare each additional print 
head on multi-color runs. (PrintSmith ignores unneeded heads.) 

Setup Add’l Run  

The Setup Additional Run field records the additional time needed to prepare for an additional run. 
This value should include the time for a plate change and run up. The Estimator uses this value for 
all passes after the first one. 

Washup Fee  

The Wash Up field records the dollar amount charged for each wash up. You specify the number of 
wash ups for each job.  

Work & Turn 2nd side setup 

The time it takes to turn stock over, reload it in the press, and register the 1st side to the 2nd side 
without changing a plate. 

Washup Minutes 

The time it takes to do the Washup of the press. 

Note: Do not use Washup Fee and Washup Minutes in the same Press Definition, as it will add 
both prices together in a job. 

Speed Table  

Generally, the longer the press run, the closer a machine gets to its rated speed. Because the 
press speed increases on long runs, it is more efficient and cheaper to produce each piece. You 
can use the speed table button to create a speed curve that adjusts the press speed for the length 
of the run. Refer to the Managing Speed Tables section, page 121, for additional information. 
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Waste Chart  

In addition to the system default waste chart, PrintSmith lets you define waste charts for each 
press. Refer to the Managing Waste Charts section, page 124, for additional information. 

Add Charges  

Each press definition can have up to 10 preset charges. The Add Charges button allows you to edit 
the preset charge list. If charges are already assigned to the press definition, the number of 
charges displays on the button as “(1) Charges…” Refer to the Adding Charges to Press Definitions 
section, page 119, for additional information. 

Sales Cat  

You can assign each press definition to a different sales category. This assignment is useful if you 
want to separate certain types of jobs in your sales summary based on the press definition used for 
the job. Use the Sales Cat pop up menu to select a sales category. 

Roll Fed / Perfector  

Checking the Roll Fed / Perfector option changes the method PrintSmith uses to calculate the 
number of passes in a job. On a normal press, an additional pass is needed for each side. On a roll 
fed press (with more than one head) or a perfector, you can print on both sides of the stock in a 
single pass. If this button is enabled, PrintSmith calculates additional passes only when the total 
number of passes exceeds the number of heads available. In this context, 1/1 (one color front and 
back) is the same as 2/0 (2 colors front, none on the back). Likewise, on a 4 head press, 4/0, 3/1 
and 2/2 all price the same way. Refer to the Setting up Perfectors and Roll Fed Presses section, 
page 128, for additional information. 

Gripper Edge 

The Gripper Edge value is the amount of space required on one feed edge of the run sheet for the 
press to pick up the paper. 

Target Pricing  

Each press definition has it’ own Target Pricing table. Target Pricing is a method of adjusting cost 
based pricing for market conditions at any quantity or job type. You can be as specific in adjusting a 
price for 1/1 pricing, a quantity of 1000, to exactly $15.15 while leaving all other prices unchanged. 
Then, when your costs change, the price is automatically adjusted while maintaining the same 
margins and market position. Refer to the Target Pricing section, page 129, for additional 
information. 
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Adding Charges to Press Definitions 
Charge definitions add a tremendous amount of flexibility to the PrintSmith Estimator. The six 
charge definition commands (Pre Press, Bindery, Production, Merchandise, Mailing Services, and 
Miscellaneous) can hold up to 60,000 different charge definitions. You can select any 10 of those 
charges and attach them to a press definition. When you select a press, the preset charges are 
automatically loaded. If you change to a different press, the charges that are attached to the old 
press are discarded and the new set of charges attached to the new press is loaded. 

To add charges to the preset charge list, click the Add Charges button. The Charge Selector 
window opens. 

          
 

The window is divided into two sections, the top section is used for making new selections and the 
bottom section displays the current selections and is used to remove preset charges from the list. 
The top part of the window presents a hierarchy. At the top level are the charge commands. Below 
each charge command is a list of the categories defined in the command window. Below each 
category are the charge definitions themselves.  

Double-clicking on one of the charge definitions adds it to the bottom of the list. You can preset up 
to 10 charges, which display in the bottom of the window. You can remove a preset charge by 
selecting it and clicking the Remove button. When a charge is attached to a press, the charge itself 
is not copied. The press definition remembers where to find the charge. If you change a charge 
definition, PrintSmith uses the latest definition when the charge is added to a job. 

Click the Close button when you have finished attaching selections. 
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Strategies for Using Preset Charges 
The biggest advantage to using preset charges is that it gives you the ability to quickly generate 
complex quotes in a consistent manner. Often, this means that complex quotes can be delegated 
to less knowledgeable employees with a much greater degree of confidence. It can also serve as a 
tickler – preset all the most common charges to each press and when entering a job, the user can 
delete any that do not apply to a particular job. It is often easier to recognize elements in a job that 
should not be there, than it is to see what you have forgotten to add. 

For example, if you are producing many direct mail jobs, you could add a metering charge to a 
press definition set up for envelopes. This may even prompt the user to go back to the customer 
and ask if they want the envelopes metered which may increase the value of the order. There are 
many different strategies for defining press definitions and deciding what, if any, charges should be 
preset in the press. 

One of the most common uses for preset charges is to add plates. When a press definition is 
selected you already know what kind of plate the job requires. If you use both metal and paper 
plates on the same press, it is a simple matter of setting up press definitions to match your decision 
process. A press definition such as “AB Dick - Metal” or “AB Dick – Tight Registration” and another 
“AB Dick - Normal” might be all you need to separate jobs requiring metal plates from jobs requiring 
paper plates. If you have different presses, presetting a plate charge with the proper sized plate 
eliminates a step in the estimating process. 

Be consistent in your use of preset charges. If only some of your press definitions have negs and 
plates automatically attached, expect the person entering the job to experience some level of 
confusion. Preset plate charges on all press definitions. 

The key is to title the press definition as appropriately as possible and attach the basic charges that 
make sense to the user. Group similar press definitions together in a well organized manner so it 
makes sense and is easy for your staff to make a selection. 
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Managing Speed Tables 
Speed tables let you set up presses with realistic throughput based on the length of the job. 
Generally, the longer the press run, the closer the machine can come to its rated speed since there 
are fewer stops for adjustment on a long run once the job is running properly. 

PrintSmith allows you to define speed tables that you designate in a press definition. When you add 
a speed table, the press is termed a variable speed press because PrintSmith uses the speed table 
to look up the speed based on the length of the job. 

There are two steps to setting up a variable speed press: creating the speed table and assigning it 
to the press. 

 

“Variable” means that 
speed is calculated 
based on job length. 

Speed Table button used 
to select tables to be 

assigned or edited. 
Name of Selected 
Speed Table 

 

Once a speed table has been assigned to a press definition, the Speed Table name is displayed to 
the right of the Speed Table button. Clicking the Speed Table Name opens the table for editing. 
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Creating a Speed Table 
If the press does not have a speed table, clicking the Speed Table button displays a list of all the 
speed tables. 

 

Assign Table 

Clear Assignment 

Create New Table 

Delete Selected Table 

Closes Window without Performing 
an Action 

You can create an unlimited number of speed tables. However, you are probably able to operate 
with just a few since you can assign the same table to more than one press definition. The Save As 
command in the File menu can be used to copy a speed table and give it a new name. 

Note:  Changing a speed table in any press definition changes the base table, which may be 
attached to other press definitions using that table. 

Clicking the New button opens the table definition window. 

 
This window is used throughout the pricing system to set up price lists. It is also used for waste 
charts. In this context, the window is used to specify the name of the speed table. For speed tables, 
PrintSmith determines the button settings and only the Interpolate button can be changed. 

Resize the window to show or hide the configuration details. 
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Interpolation 

Note the setting of the Interpolate button. Because it is enabled, PrintSmith calculates intermediate 
values if the quantity being looked up doesn’t exactly match a quantity in the table. For example, if 
you had a table with a quantity of 1000 and a speed of 4000 and the next entry in the table had a 
quantity of 2000 and a speed of 5000 and you wanted to find the speed for a run of 1500, 
PrintSmith would return a speed of 4500. Because 1500 is exactly in the middle of 1000 and 2000 
quantities, the speed, 4500, is half the difference between 4000 and 5000. 

You can, if you wish, disable this button. If it is disabled, the speed jumps to the next entry with no 
intermediate values. This setting can result in the price for 1100 being less than the price for 1000 - 
so we recommend you leave it enabled. 

Entering Data in Speed Tables 
After entering the name of the table, enter the quantities and speeds, click the OK button and the 
new speed table is created. 

 

<tab> key changes column 

<return> key changes line  

arrow keys on keyboard 
change selection 

The first zero quantity 
denotes the end of the 

list. 

As the quantity increases, so should the press speed, reducing the unit labor cost on longer runs. 
The entire list need not be used. At minimum, the first two lines must be defined. 

You can specify up to 15 different quantity/speed combinations. When you enter the quantities, 
they should be sequential with the smallest quantity at the top of the list and at least the first two 
quantities are specified. The maximum quantity does not need to be the largest quantity you will 
ever run. When the quantity in the job is larger than the largest value in the speed table, the last 
speed in the table is used. 

Normally, the press speed should increase at higher quantities, but it does not have to. You could, 
for example, reduce the effective speed when the quantity reaches the point where the press 
usually has to be reloaded. Higher press speeds result in shorter run times and a smaller labor 
charge. 
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Modifying a Speed Table 
Once a table has been assigned to a press, click the name of the assigned table to open. You can 
change the speed table and click the OK button to save the changes. 

Note:  Remember, the speed table may be used by other press definitions and any changes you 
make, affect those press definitions too. 

Changing the Selected Speed Table 
To use a different speed table, click the Speed Table button. PrintSmith opens the Speed Table 
list. Select a speed table, or click the Clear button to remove the existing speed table assignment. 
To see a graphical representation of a speed table, hold down the <option> key on Macintosh or 
the <alt> key on Windows and the <shift> key when you click on the Speed Table name. 

Changing the Name of a Speed Table 
In order to change the name of an existing speed table, you must open the speed table. If it is 
already assigned to a press, select the press definition and then click the speed table name. If it 
has not been assigned to any press yet, you must assign it to one at least temporarily.  

When the window is open, resize the window so the name of the table is visible in an edit field. 
Click the edit field and type in a new name. When you click the OK button, the name is changed. 

Note:  Changing the name of a speed table automatically changes the speed table name on all 
press definitions using that table. 

Deleting a Speed Table 
To delete a Speed Table, click the Speed Table button. When the Speed Table list opens, select 
the Speed Table and click the Delete button. 

Note:  Remember, the speed table may be used by other press definitions. Before deleting a 
speed table, make sure it is not being used by any other press definition. 

 

Managing Waste Charts 
Even though there is a system wide waste chart, PrintSmith recognizes each type of press can 
have different spoilage characteristics. To support this, each press definition can have its own 
waste chart. 

The procedures for managing waste charts are nearly identical to those used for speed tables. 
There are two steps to setting up a waste chart for a press: creating the waste chart and assigning 
it to the press definition. Once a waste chart has been assigned to a press definition the name of 
the waste chart is displayed to the right of the Waste Chart button. 
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Creating a Waste Chart 
If the press does not currently have a waste chart, clicking the Waste Chart button displays a list of 
all the waste charts in the system. 

 

Assign Selected Waste Chart 

Clear Assignment 

Create New Waste Chart 

Delete Selected Waste Chart 

Closes Window without Performing 
an Action 

You can define a waste chart for each press; however, it is likely that you can operate with just a 
few waste charts. You can assign the same waste chart to more than one press definition. 

Note:  Changing a waste chart in one press definition changes it in all the press definitions using 
that chart. 

 

Clicking the New button opens the Waste Chart definition window. 
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This window is used throughout the pricing system to set up price lists. It is also used for speed 
tables. For waste charts, the button settings are determined by PrintSmith, and cannot be changed. 

Note:  The Interpolate button has been grayed out and cannot be changed. Because it is 
enabled, PrintSmith calculates intermediate values if the quantity being looked up does 
not exactly match a quantity in the table. The result is a smooth curve. 

 
The entire list must be used. Run length must increase from top to bottom. As the quantity 
increases, the waste percentage should decrease in small enough increments. Avoid the number of 
wasted sheets becoming smaller on longer runs. 

A complete waste chart consists of 15 quantity/percentage combinations. The maximum quantity 
does not need to be the largest quantity you will ever run. When the quantity in the job is larger 
than the largest value in the waste chart, the last percentage in the chart is used. 

Use File > Print in the main menu to print a waste chart. 

Modifying a Waste Chart 
Once a chart has been assigned to a press, click the name of the waste chart to open it. You can 
change the waste chart and click the OK button to save the changes. 

Note:  Remember, the waste chart may be used by other press definitions and any changes you 
make, affect those press definitions too. 

Changing the Selected Waste Chart 
To use a different waste chart, click the Waste Chart button. PrintSmith opens the Waste Chart 
List. Select a new chart, or click the Clear button to remove the existing waste chart assignment. 

Changing the Name of a Waste Chart 
In order to change the name of an existing waste chart, you must open the waste chart. If it is 
already assigned to a press, select the press definition and then click the Waste Chart Name. If it 
has not been assigned to any press yet, you must assign it to one temporarily. 

When the window is open, resize the window so the name of the table is visible in an edit field. 
Select the edit field and enter a new name. When you click the OK button the name is changed. 
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Overview of Press Definitions and Estimating 
The press definition is used in the Printing and List pricing methods in the Estimator. A press 
always defaults in these jobs, but you have complete control over which press definition is used in 
any job and can change it at any time. When you select a stock from the stock list, if there is a 
press definition designated in that stock definition, that press is used in the job. If there is no press 
designated in the stock definition or the job is for customer stock or special order, the default press 
is selected. 

One obvious use for press definitions is to describe the various machines in your shop. Perhaps 
less obvious is that the press definition is another way of describing how a particular stock or job is 
run – how hard it is to set up, how fast it can run, and so on. With this in mind, alternative uses for 
the press definition could be to describe classes of jobs such as business cards, carbonless, and 
so on. The press definition is then used to describe the running characteristics of a particular job. It 
is also possible to use press definitions to specify production characteristics of some copiers 
although copier definitions are usually better suited for this purpose. 

Determining Press Production Values 
Your press definitions are very important, as labor is often the largest component in a printing job. If 
you use a price list from one of the commercial price list bureaus or from a franchise you may not 
have a clear idea what your production values are. This section provides some guidelines for 
developing these factors. 

First let’s examine the formula that PrintSmith uses to calculate the labor component of several 
types of jobs. For readability, some of the factors are abbreviated as follows: 

• aimp = 5000 Average Impressions/Hour 

• rate = 50.00 Labor Rate 

• markup = 1.5 Labor Markup 

• setup = 12 Initial set up time (minutes) 

• head = 5 Setup Add’l Head (minutes) 

• run = 8 Setup Add’l Run (minutes) 

• waste = 10% quantity x waste percent x number of passes (the waste percentage is taken 
from the waste chart) 

 

Calculating Your Labor Rate 
One way to calculate a reasonable labor rate is from your last 12 months income statement or 
budget if you are just starting out.  Add up all of your overhead items such as rent, utilities, phone, 
etc., adjusting them for any anticipated increases.  Then add up all your payroll expenses for non-
production employees, such as CSRs and accounting people, including a fair wage for you, and 
adjust the total for anticipated raises, taxes, benefits, and changes in work force. The markup on 
the base salary is usually between 20% and 40%.  This amount gives you a projected total for 
overhead and labor for the year.  Divide this number by the hours available in a year, which for one 
shift is usually 2,080 hours.  That gives you the overhead cost per hour.  You then need to assign a 
percentage of the hourly cost to each piece of billable equipment.  Usually prepress and bindery 
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are by the department and press and copiers are by each piece of equipment.  You can either 
determine these numbers by percentage of sales or square footage of the equipment. 

Then, determine the hourly rate for each production employee, such as pressman, prepress and 
bindery personnel. Start with the base hourly rate for each employee. Add to that a markup 
percentage to account for vacations, holidays, sick leave FICA matching, etc.  The markup is 
usually between 20% and 40%. 

The next step is to figure the replacement cost for each piece of billable equipment you have, such 
as presses, copiers, and bindery equipment.  To do this, take the replacement cost divided by the 
depreciation years, divided by 2080.  It is recommended that you depreciate prepress equipment 
by 3 years, press by 7 years, and bindery by 10 years. 

Now, add up the overhead, labor, and equipment costs for each of the departments or pieces of 
equipment to get a total cost. 

The final step is to determine just how efficient your shop is, that is, how much of this time can 
actually be charged to customers. In a very well run, very busy shop you may be able to charge 
70% of these hours to customers. In a new or recently expanded business, it may be as low as 
40%. A good figure to use is 60%. Whatever percentage you decide on, divide the hourly cost rate 
by the percentage (e.g. 25.00 /.60 = $41.66). This total is your Budgeted Hourly Rate and is what 
you should be using for hourly labor charges. 

Once you have this number, you should only have to review it when you are contemplating a price 
increase or if your business has changed significantly. This number is the only detailed calculation 
needed to set up press pricing in PrintSmith. PrintSmith will now tell you what your actual return is 
for each press and non-press hour. 

Note:  A quick way to find your labor rate is to multiply your average employee count by the 
number of hours you are open for business in a given period. Then divide your total 
expenses for this period by total hours and mark that up by your desired Gross Profit 
percentage. An even quicker way is to just take revenue for the period and divide by total 
hours. Neither method is foolproof, but both are useful ways of getting a “ball park” figure if 
you want to get started quickly. 

Setting up Perfectors and Roll Fed Presses 
As far as PrintSmith is concerned, the only difference between these presses and regular sheet fed 
presses is that they can print both sides of a sheet at the same time. The stock definitions for roll 
stock should be based on the sheet size as it comes out of the press. The stock price would be the 
price for a roll with units set to the approximate number of that size sheets you can get out of the 
roll (e.g. $350.00 in units of 25,000). Units is limited to a maximum of 32,000 - should that become 
a problem simply divide both by 10. In the previous example you would change the price to $35.00 
per 2,500. PrintSmith generates exactly the same prices. 

In general, the only difference between 4/0 (4 colors front, none on the back), 3/1 and 2/2 on a 4 
color roll fed press is in how the press is set up. As far as the press definition is concerned, simply 
make sure that the Roll Fed button is enabled in the press definition so PrintSmith does not charge 
for an extra pass to print on the second side if there are enough heads to do it in one pass. 

PrintSmith does not fully support perfectors. In most cases, it estimates correctly with the Roll Fed 
option enabled. A 1/1 job with 2 heads is OK, but a 2/0 may not be if your press is not capable of 
running it in one pass because PrintSmith only estimates 1 pass which is always correct for roll fed. 
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Target Pricing 
Over the past years, PrintSmith has worked with thousands of printers to adapt PrintSmith to many 
different pricing systems. What we have observed is that many printers have a good idea of their 
costs and a good idea of the value of the printing they produce in their market. Many times, the 
value (what your customer is willing to pay) of the printing has little or no relationship to your costs. 
Target Pricing was developed on the following assumptions: 

• Identifying and tracking costs for producing work is a good idea. 

• The price a customer is willing to pay for the work you produce may not reflect your costs to 
produce it. 

• Your pricing system should incorporate your costs and generate competitive prices at all 
quantities. 

• As your costs change, these costs should be reflected in your retail prices. 

Target pricing allows you to set up a pricing system that recognizes actual costs, generates prices 
based on market value at any quantity and automatically adjusts prices for changes in costs while 
still retaining a competitive orientation. This is accomplished using a target pricing table shown 
below. 

 

         

Graphs show pricing analysis for 
selected column.

Shows adjustments made 
from Estimated Costs. 

Estimated Profit 

Estimated Cost Components 

Click on the graphic to show 
an alternative view. 

 
Factors used to generate 
target table  
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The target pricing table gives you one place where you can look at an array of prices generated by 
PrintSmith using your specifications. You can review prices for single sided, multicolor, and process 
color work for up to 15 price points and adjust them. When reviewing these prices, it is also 
important to analyze the results to see how this changes your estimated profit. 

Note:  When reviewing these prices you must understand that what we show as profit is really 
just the difference between estimated costs and generated price. To the extent that you 
have identified all costs in your pricing system, it is generally accurate, but actual profits 
can only be reasonably determined from a Profit and Loss Statement over a period such 
as a month, quarter, or year. 

If you think that the price PrintSmith generates for a particular quantity in any column is too high or 
too low, simply type in a new price. When you press <tab> or <return>, the table is recalculated 
and a new analysis showing your new margins is displayed. From now on, jobs that match those 
specifications result in the price you entered. Refer to the How Target Pricing Works section, page 
131, for a detailed explanation. It is very important you understand how this works. 

Using Target Pricing 
To use Target Pricing, select a press definition. Add preset charges if you wish, and click the 
Target Pricing button. This option generates a target pricing table for the selected press. Before 
the table opens, you are asked to select a stock definition.  

Selecting a stock is optional. A target table based solely on production values to which the 
Estimator adds marked up stock and other charges is a very different, but valid approach. It is more 
difficult to determine pricing targets if all the necessary factors are not included in the price. One 
must also consider that the target pricing factor generated in this table is also applied to the stock 
cost and any charges added to the job unless you select the Ignore Charges button. Ignoring 
charges is the safest way to set up a target table because the factor generated by Target Pricing is 
smaller if charges are not included. If charges are included, the factor must be larger to account for 
the charge amounts because the target pricing adjustment does not include charges. Since only 
the job price is changed, reducing a $200 price by $50 requires a factor of 0.5 if $100 of the price is 
due to charges on the job. The factor is only 0.75 if there are no charges on the job. Either 
approach is correct, however, removing those charges from the job results in much less profit or 
even a loss since the job price may have been reduced too much to account for the charges. For 
this reason, it is probably best to only include charges that are always added to every job using that 
press (or stock). 

When initially setting up the Target Pricing Table, the quantities used are the same as those in the 
system waste chart. You can change them. As long as at least the first two quantities in the table 
are non-zero it can be used for target pricing. You can shorten the table by entering a zero in any 
quantity. 

These quantities are used to calculate five columns of prices: 1/0, 1/1, 2/0, 2/2, 4/0. Since each 
column has 15 different prices there are a total of 75 prices calculated. Depending on the 
complexity of the press definition and the speed of the machine, it can take several seconds to 
complete all the calculations. Many of these calculations have to be redone whenever you change 
the table, so you’ll find this window to be one of the slowest in PrintSmith. On a faster machine 
there is virtually no delay; systems may vary. 

The target pricing table is part of the press definition and is copied when a press is copied. The 
New menu command resets the entire table to standard prices with no target adjustments. Revert 
restores the table to its last saved value. Save saves all changes. Saving the table is independent 
of saving changes to the Press Definition. In other words, when the target table is saved, the 
change is permanent, even if you don’t save the press definition window to which it belongs. 
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How Target Pricing Works 
Most of the time, you will probably be working in the Target view of the table. This view shows you 
the prices generated by PrintSmith. When you enter a desired price, you are actually telling 
PrintSmith your target price. This target is used to calculate a discount on the generated price, 
which is used by the Estimator. Using a discount accommodates changes to stock cost and using 
different stocks with the same press definition. 

For example, changing a default target table price of $16.73 to $15.00 might result in a target factor 
of 0.9. Should stock prices change or you use that press with a different stock PrintSmith calculates 
the price and as a last step, multiplies the job price by the factor for the proper row and column. If 
the labor rate and stock prices were changed so that same job yielded a price of 100.00, a target 
factor of 0.9 would be used to reduce the price to 90.00. 

In addition to prices, target pricing options are controlled with the following buttons. 

Interpolate  

When enabled, the factor used to adjust the price on quantities, which do not match those in the 
table, is interpolated. The result is a smooth transition from one row to the next. This button also 
governs how the variance and profit analysis graphs are presented to show how this changes 
profits. 

Disable  

The target pricing table is not used for generating prices. 

Ignore Charges  

Ignores any charges attached to the press or stock when calculating the target table. Use this 
option to adjust basic production prices without changing press or stock definitions. 

Use Press Count  

The Use Press Count option is a look up factor using the press count instead of ordered quantity. 

Ignore Wash Up Charges  

The Ignore Wash Up Charges option does not apply the target adjustment to wash up charges. 

Ignore Stock 

The Ignore Stock option does not apply the target adjustment to stock. 
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The column selected for the discount factor is determined as follows: 

Target Table Column Selection 
Column Description Criteria 

   

1 One Pass One Side One color on the front with nothing on the back. 

2 One Pass Both Sides One color on the front and one color on the back. 

3 Multi-Pass One Side More than one color on front and none on back. 

4 Multi-Pass Both Sides More than one color on front and at least one color on the back. 

5 Process Color 4 or more colors on the front 

   

 

The target factor is generated from the estimated price, which may include charges. Charges are 
not affected by the factor, only the job price. The more charges there are on a job, the larger the 
target pricing factor has to be to adjust the entire price where you want it. The factor is calculated 
so that charges, when added to the price, equal the target price. 

Target pricing is an adjustment for market prices so that all calculations are based on the quantity 
ordered and on the number of colors, rather than passes. 

Note:  Be careful with preset charges, both on stocks and presses. These have a big impact on 
the target factor. Only use charges you are confident will be appropriate with all potential 
uses of the press definition. 

A target table must have at least 2 entries and the quantities must be in ascending orders. 

Target prices are color coded: 

• Blue indicates a price below standard but above cost 

• Red is a price below cost 

• Black is the standard price 

• Green is above standard 
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Copier Definitions 
Another major pricing method is defined using copier definitions. You might own only one copier 
but offer several differing pricing methods. Each definition can have its own formula, with a unique 
matrix, and attached charges. Using this format, PrintSmith can handle any pricing situation. You 
have the ability to enter 100 copier pricing definitions. 

Select Pricing > Copier Definitions from the main menu.  The Copier Definition window opens. 

 

Costing 
Information 
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Like charges and press definitions, selecting File > Print from the main menu prints a listing of 
copier definitions.  

 
 

Enter all of your copier costs into the costing field. 

Then select the pricing method you desire. This information is used for costing all copier jobs. 

A popular pricing method for copies is based on a matrix of copies and originals.  
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Select the 8.5 x 11 B&W Copy definition in the window. 

 

Add Charges button 

Sales Cat 

Edit Matrix 
button 

In this example, this copier is named 8.5 x 11 B&W Copy, runs at 90 copies per minute, uses the 
pricing method of Copies and Originals and has an ID of 2 - for reporting work in progress. 

Sales from this copier definition are recorded in sales category HS Copy. No charges are attached 
to the Add Charges button. The matrix used is the copy cost method. 

The copy markup is set to 1 and the stock price comes from the Copier 1 field in the stock 
definition. The second side is priced by counting as more originals. 

Click on Edit Matrix and the following table opens: 
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Enter your base copier rate. This is usually the base 20# bond rate. PrintSmith can automatically 
add a retail paper up charge to this matrix by looking back at the stock definition. Another popular 
method is to enter the basic click charge in this matrix and have PrintSmith automatically add the 
actual cost of the stock. There are many options! 

PrintSmith uses copier and stock definitions to determine the price for copier jobs. You can create 
up to 100 copier definitions to describe the various kinds of copier pricing styles in your business. 
For example, high speed, convenience, color, contract, engineering, large format are all possible 
pricing styles that can be set up in a copier definition.  

The buttons at the bottom of the window are used in conjunction with the currently selected copier 
definition as follows: 

 
Add/Change 

This button is used to save the current contents of the window; it creates a new copier definition, or 
updates the selected definition. 

Stock Price List 

The Stock Price List button allows you to generate a price list for any copier definition with a 
particular paper attached. This is particularly useful in setting PrintSmith up as you can “tune” your 
copier pricing for a particular stock without continually going back and forth between stock and 
copier definitions. 

Copier Price List 

The Copier Price List button allows you to generate a price list for any copier definition without 
considering stock cost. 

Delete 

Deletes the selected copier definition. 

Clear/Close 

If you have entered any data or selected a definition, the Clear button clears the name and sets up 
a new definition with the same pricing setup so you can create a new definition. The Close button 
closes the Copier Definitions window. 

Default Copier Selection in the Estimator 
Set the default B&W and default Color copier by clicking in Default B&W or Default Color column to 
the left of the copiers.  The default copier is automatically selected in the Copier dropdown list in 
the Job window.  When you enter a copy job, PrintSmith automatically assigns a default copier 
unless the selected stock has a preset copier selection. The user can change this default from the 
Change Copier Selection in the Job menu. 
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Managing Copier Definitions 
Selecting Copier Definitions 
Clicking once on an item in the copier list displays the definition in the bottom section of the 
window. 

Creating a New Copier Definition 
When the Copier Definitions command is first selected, the window opens with a blank copier 
definition. Enter a name, enter the pricing information, and click the Add button. New definitions are 
added to the end of the list. You can move a new definition to a different position in the list by 
dragging it. Refer to Organizing Copier Definitions, page 138, for additional information. 

Copying an Existing Copier Definition 
The easiest way to duplicate a copier definition is to select it, hold down the <option> key (Mac) or 
<alt> key (Win), and drag the copier you want to copy to a new location in the list. When you 
release the mouse, the definition is copied. Enter a new name and save the changes. 

An alternative method is to select the copier and click the Clear button. This action sets up a new, 
untitled definition using exactly the same pricing set up as the definition you wanted to copy. Type 
in a new name and click the Add button. 

You can also use the Edit menu commands to copy and paste definitions. Make sure you click on 
the Change button before pasting in your new copier definition. Failure to do so results in pasting 
over whatever copier definition is highlighted. New definitions are added to the end of the list. You 
can move a new definition to a different position in the list by dragging. Refer to the Organizing 
Copier Definitions section, page 138, for additional information. 

Changing an Existing Copier Definition 
Selecting an item in the copier list displays the definition in the bottom section of the window. You 
can change any of the menu selections or data fields and click the Change button or the Save 
command in the File menu. 

Deleting a Copier Definition 
To delete a copier definition, select the definition and click the Delete button. When first setting up 
your pricing system, you can safely delete any copier definition. After you are up and running, use 
caution when deleting definitions. You can still delete any copier definition, but you should 
understand that if the definition has been used by other parts of the pricing system or by the 
estimator, you might wish to use an alternate strategy such as moving it to the end of the list and/or 
renaming it. 

When you create a copier job a copier definition is selected. When the job is saved, the fact that a 
particular copier was used is also saved. The copier definition itself does not become part of the 
job. When the job is copied to a new job or changed in any way, PrintSmith uses the copier 
definition in the pricing system to adjust the prices. PrintSmith can find the definition if you’ve 
changed the name or location in the copier list, but not if it was deleted. When this happens, 
PrintSmith warns you that the definition is missing and prompts you to select a new one. 

If you attach a copier definition to a stock definition and the copier definition has been or will be 
deleted, PrintSmith automatically selects the default copier. This may be confusing to the user and 
generates a different price. 
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If you make major changes to the pricing system, you may want to call attention to the fact that 
deleting a copier definition changed pricing. When you use an old job that was priced with the “old” 
pricing system the Estimator warns you and recommends selecting a definition. 

Organizing Copier Definitions 
To change the position of a copier definition in a list, drag the listing to the desired position in the 
list. Repeat this operation as often as you like until all of the copiers are in the order you want.  

Copier Pricing Styles 
There are seven pricing methods available. Selecting a pricing method determines how copier jobs 
are priced for that definition.  

 
These seven pricing methods represent three styles: Cost Plus, Flat Rate, and Matrix pricing. 
There are several variations possible with each style. The following guidelines will help you choose 
the pricing style best suited for any pricing requirement. When you choose a pricing method, the 
definition window changes to display pricing specifications for that method. It’s important to 
remember that all of this information can reside in the same definition simultaneously, even if it isn’t 
being used. For example, all copier definitions house machine specifications that are very useful in 
recording actual or estimated costs.  Even if they aren’t used to generate prices, job costing still 
uses the information. 

Note:  You can capture your costs for copying by entering machine specifications even if you 
decide not to use the cost plus pricing method. Job Costing uses this costing information 
and, when used with our optional Downloader and Report Writer, you can perform even 
more extensive cost analysis on the resulting data. 
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Cost Plus Pricing Style 
This pricing method is suited for two different kinds of pricing. The first and most obvious generates 
prices based on actual costs to purchase, maintain, and run the machine. A markup is applied to 
these actual costs plus stock to produce a retail price. 

The second is Copy Range Pricing style. This is similar to a matrix pricing style using the matrix as 
a step table. For example, you would use Copy Range pricing if you want: 

• the first 10 copies to be priced at 5¢ per copy and the rest at 3¢ 

• 20 copies would be 80¢; 50¢ for the first 10 and 30¢ for the last 10. 

• This can be an effective way of providing quantity based pricing as the unit price on the job is 
4¢. 

It is easy to set up and is fairly safe because you clearly identify the lowest price you’re willing to 
charge and charge a premium for short run work. It is also very easy to explain to your customer 
and can give them the impression you are cheaper than the competition, even if that’s not the case. 

These two different ways of implementing pricing are actually complementary, you can use both 
together. For example, you could set up the cost plus specifications to cover your actual costs and 
use the copy range to provide desired profit levels on a job. 

Flat Rate Pricing Style 
This pricing method is generally used for short run situations such as convenience copies or 
special purpose like engineering copies where you might charge by linear inches or square area 
instead of by clicks. 

Matrix Pricing Style 
This style encompasses the Copies and Originals, Copies per Original, and Total of all Copies 
methods. These methods are suitable any time you want the unit price to change based on the 
length of the job where the Copy Range method described in the Cost Plus Style (above) is too 
limited. Each method differs in the way the matrix is used to derive the price. Each definition has its 
own unique matrix, which ranges in size from 1 to 20 columns depending on pricing specifications. 
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Elements of Copier Definitions 
In the sections that follow, we examine each pricing style in detail and describe the purpose of each 
field and how it is used to generate pricing. But first, here are the parts of the definition window 
common to all copier definitions. 

Field Definition 
  

Name Up to 50 characters identifying the copier. 

Copies/Minute The number of copies per minute the machine is rated for, or your actual throughput, 
whichever is less. 

Machine Name Select the Machine Name from a dropdown list.  Machine names are defined in the 
Production Presses table.  The Machine Name displays on the Job Ticket. 

Machine ID A number, from 1 to 255, identifying the machine. If you use more than one copier 
definition for each actual machine, you should identify the machine with a number. The 
Work In Progress report uses this to sort jobs by the machine they will be produced on 
rather than the definition to price the job. 

Add Charges 
button 

You can add up to 10 charges to a copier definition. These charges are automatically 
added to the job when this copier is selected. 

Output 
Description 

Describe the output for this printing process.  This appears on the Job Ticket. 

Integrated device 
option 

Select this option if the device is integrated with the Fiery. 

Production 
Location 

The Production Location field supports the Tracker Module.  Production Locations are 
defined in the Production Locations table. 

OEM Device ID For Fiery integration, the ID by which the device is identified. 

Method Menu This is used to select the pricing method of the copier. 

Sales Cat Menu Select a sales category for tracking jobs revenue priced with this copier definition. 
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Cost Plus Pricing 
When the Cost Plus method is selected, the Copier Definition window is designed to directly enter 
your costs for copying, even if you are using complicated lease/purchase/maintenance contracts. 

 
 

Field Definition 
  

Open Days/Year The number of days your business is open during the year. If you’re normally 
open 5 days a week, the number is 5 x 52 or 260 days (minus any holidays). 

Open Hours/Day The number of regularly scheduled business hours. This should include 
scheduled overtime and second shifts. 

Monthly Payment Your monthly payment for the copier. If you own the copier, enter 0. 

Monthly Maintenance Your monthly maintenance charge. Most vendors have standard maintenance 
charges to which they may or may not add Click Charges. The basic 
maintenance charge goes here. If you do your own maintenance, enter a 
reasonable periodic charge for your costs in maintaining the machine. Don’t 
include toner or other consumables. Do include replacement parts if you’ve 
budgeted for them. 

% Time In Use Your estimate of the percentage of time the machine is usually in use. If you’re 
open for 8 hours a day and the machine is usually in use for 4 hours, enter 
50%. 

Labor/copy Additional charge for labor for each copy. 
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Field Definition 
  

Toner/Copy Additional charge for toner for each copy. 

Developer/Copy Additional charge for developer and other consumables for each copy. 

Copy Markup Markup to be applied to the effective copy rate. The effective copy rate is the 
total of the machine cost per copy plus labor, toner and developer. If you’ve set 
up costing using the copy range, this is also added to the effective copy rate. 

Machine Cost Per Copy PrintSmith based on the previous factors calculates this figure. The formula is: 

 
Copy Range Three different quantities/cost combinations can be entered. This is useful for 

entering the different click cost schedules offered by copier vendors and for 
adjusting stock cost at different quantity levels. 
Stock cost is calculated from the stock definition and marked up using the 
standard stock markup in the stock definition. This may be marked up again if a 
markup is specified in the copy range table. Special order and customer stock 
use the default stock cost entered in the Stocks and Sizes Preference panel. 
Enter this information into all copier definitions regardless of the pricing method 
used since PrintSmith uses this data as the basis for calculating costs in the 
costing system. 

  

 

Modifying Stock Calculations and Second Side Pricing 
In all other pricing methods there are options for determining how stock is calculated and how the 
second side is priced. You can use these options and adjust second side pricing with the cost plus 
method by temporarily changing the pricing method to Copies and Originals, making your selection 
and returning to the Cost Plus pricing method. Only the Side 2 factor, the Price 2 sided by menu 
and the Stock Price Is menu are used, all other settings are ignored. It is important to designate the 
proper calculation of stock cost to avoid unexpected pricing. Normally, the marked up stock cost is 
used. 

Note:  Special Order and Customer Stock cannot use copier 1 and copier 2 because there is no 
stock definition. The stock cost entered in the job is used. An alternative is to create 
custom stock definitions for Special Order and Customer Stock and disable the customer 
stock and special order buttons in the Job Selection window.  

All side 2 pricing options are valid although Use First Side Rate and Use Second Side rate are 
identical because the rate is always the same. The click charge is doubled, but not the stock cost. 
All other selections affect both click charges and stock charges. 
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Flat Rate Pricing 
In this pricing method, the click charge is unaffected by quantity – one copy has the same unit price 
as a million, 100 copies of one original is the same as one copy of 100 originals. This may be 
useful for pricing on a convenience copier; however, it is difficult to be competitive with this type of 
pricing. 

 
 

Flat Rate Field Definitions 
Field Definition 

  

Rate/Copy This is the flat amount charged for each copy. 

Stock Markup If you override the stock markup by enabling Use Copiers stock markup, 
this markup is used. 

Side 2 Factor Used for pricing 2 sided copies with a factor for the second side. The price 
for single copies is determined, and then multiplied by this factor. 
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Calculating Stock Cost 
The stock selection and stock cost in the job are ignored when the stock price is “included in rate”. 
Only the copy rate is used for pricing. 

Marked Up Stock Cost adds the cost of the stock to the rate per copy. The stock cost is marked up 
using the markup in the stock definition unless Use Copier’s stock markup is turned on in which 
case it uses the Stock Markup shown to the left of the button to mark up the cost of the stock. For 
special order and customer stock, the stock markup or customer stock markup is used respectively. 

If stock price is From Copier 1 In Stock Definition or From Copier 2 In Stock Definition the rate is 
taken directly from the stock definition and is not marked up. If Use Copiers Stock Markup is turned 
on, the rate is marked up before it is used. 

Calculating 2 Sided Copying 
Side two can be calculated using: 

• side 2 factor, which multiplies the side 1 price by the side 2 factor field 

• not changing the price 

• by using the first side rate (which doesn’t add in stock a second time) 

• by counting as more originals 

 

Matrix Pricing 
Matrix pricing uses a matrix in the copier definition to generate a “click” charge, to determine a 
volume based discount, or for Copy Range (stepped) pricing. The three matrix based pricing 
methods differ primarily in the size of the matrix and how the quantities in the job are used to 
lookup the cost or discount factor in the matrix. 

To edit the matrix for a copier definition, click the Edit Matrix button. You determine what type of 
matrix by selecting the Matrix Is Copy Cost, Matrix Is Discount Table, or Matrix Is Step Table 
button. 

 
This area is used to edit the matrix and also determine whether the contents of the matrix are to be 
treated as click charges or discount factors. 
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Copier Matrix Types 
The type of copier matrix used depends on the pricing method selected in the definition. 

The examples below demonstrate the standards. 

Single Column   Use Side 2 Rate 

   
 

These two types of matrices can be used for Copies per Original and Total Of All Copies pricing 
methods. 

Copies and Originals 
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Copies and Originals Using Second Side Rate 

 
Copies per Original and Total of All Copies use the single column version, while the 10-column 
version is used for Copies and Originals. Both of these basics are available in a two sided version 
when you select Using Second Side Rate for 2 sided pricing. 

Note:  Changing the pricing method or matrix type does not change the data in the matrix. If you 
enter data for all 10 columns for one and two sided copying this information is retained 
even if it is no longer used. 

 

Matrix Types 

Selected Method Matrix 
  

Copies And Originals The rate is located based on the number of copies row and the number of 
originals column. There are 10 columns (20 on a 2 sided matrix) available 
for pricing. The first column with a zero for the number of originals marks 
the last column in the matrix. 

Copies Per Originals This method uses a single column pricing matrix (which may have 1 or 2 
sides). The rate is looked up in the matrix using the number of copies. The 
Originals field is not used in the lookup. 

Total Of All Copies This method also uses a single column matrix. The total number of copies 
(ordered x sheets x sets) made determines the rate in either a 1 or 2 sided 
matrix. 

Square Area And Originals This method is used to support large format pricing based on the square 
area of the original being copied. You would use this method if you develop 
a unit price for job based on the size of one piece and then multiply it by the 
number of pieces. This is a matrix pricing style. The matrix looks the same 
except that instead of Number of Copies it shows Total Square Area. 

Total Of Square Area This method supports large format pricing. A unit price based on the total 
square area of the job is multiplied by the number of units of area. For 
example, a job with 100 square units would look at 100 on the matrix and 
multiply the rate by 100 calculating the retail price. This is a “matrix” pricing 
style. The matrix looks the same except instead of “Number of Copies” it 
displays “Total Square Area”. 
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Matrix is Copy Cost 
If you price copies using a cost table which varies by quantity and/or number of originals, and 
choose to add a premium on certain types of stock, this is they type of matrix to use. 

The stock price is derived from the stock definition and is marked up using either the stock markup 
or the copier definition’s stock markup when Use Copier’s stock markup is selected. 

The click charge is marked up using the copier markup. The stock charge and click charge are 
added together resulting in a final price. 

Matrix is Discount Table 
If you price copies by setting a standard price for each stock which then is discounted based on the 
quantity and/or number of originals, you should use this style. The base rate in the copier definition 
is the basic click charge for a single copy of one original. 

Matrix is Step Table 
If you price each range of copies separately and add them up, use this step style of matrix. 

Example of a step table: If the first 3 entries in the table were 100 at .06, 200 at .05, and 300 at .04 
and the quantity to price were 250. It would be calculated as follows: 

100 x .06 = 6.00 

100 x .05 = 5.00 

50 x .04 = 2.00 

Total = 6.00+ 5.00 + 2.00 = 13.00 

This is similar to the copy range table available in the Cost Plus method except there are 14 ranges 
and many more options for handling multiple originals, stock pricing and two sided copying. The 
stock charge is calculated using the same rules as Copy Cost Matrix. 

Stock Price 
The stock component of the copy price is determined using the following rules: 

Stock Price Is Resulting Stock Charge 
  

included in rate No separate stock charge is calculated. 

marked up stock cost The cost for each sheet is marked up using the stock cost (or standard 
stock or customer markup for special order and customer stock). This 
can be overridden using Use Copier’s stock markup option. 

from Copier 1 in stock 
definition 

Only works with “in stock” papers and adds the up charge listed in the 
copier 1 field from the stock definition, otherwise it defaults to “marked 
up stock cost”. This value is only marked up when “Use Copiers stock 
markup” is selected. 

from Copier 2 in stock 
definition 

The same as copier one except for value taken from stock definition. 

  

 

The discount factor is looked up in the matrix and multiplied by the total of the base rate and the 
stock price. This is the click charge for this quantity. 
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Using Matrix Based Pricing 
If the matrix is a copy cost matrix, the price per copy is calculated: 

(cost x markup) + (stock cost x markup) 

If the matrix is a discount table, the price per copy is calculated: 

(rate x discount factor) 

If the matrix is a step table, the price is calculated in a somewhat more complicated fashion. 

There can be as many as 15 rows and 10 columns in the matrix and may have separate columns 
for single and double sided copying. Any bottom row containing 0 in the Number of Copies column 
is the last row used in the lookup. In the Copies and Originals (10 column) matrix, the bottom 
column with a 0 in Number of Originals is the last column used. 

There is no interpolation between intermediate values. If the quantity being looked up is greater 
than the number of copies in a row, the next row is used. Likewise, if the number of originals being 
looked up (Copies and Originals only) is greater than the quantity atop the column, the next column 
is used. 

 

Pricing for 2 Sided Copies 

 Definition 
  

Price 2 sided by not 
changing price 

The Price 2 Sided By Not Changing Price option means there is no 
difference in price between one sided and two sided copying 

Price 2 sided by using first 
side rate 

The Price 2 Sided By Using First Side Rate Option doubles the price for 
clicks (but not for stock which is added only once) using a single sided rate 
matrix. 

Price 2 sided by using 
second side rate 

The Price 2 Sided B By Using Second Side Rate option uses a 2 sided 
matrix. The rate looked up in the matrix is from the side 2 column on a two 
sided job. This click charge is doubled and added to the stock charge. 

Price 2 sided by counting 
as more originals 

The Price 2 Sided By Counting As More Originals option has the effect of 
doubling the number of originals prior to performing the lookup. This does 
not affect the stock charge, which is not doubled. This is equivalent to 
pricing a single sided job as twice the amount ordered except for the stock 
charge. It would price 100 two sided the same as 200 one sided copies and 
add a stock charge for 100 sheets. 

Price 2 sided by using side 
2 factor 

The Price 2 Sided By Using Side 2 Factor option calculates the price for 
single sided copying and multiplies it by the factor specified in the 
definition. 
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Adding Charges to Copier Definitions 
Charge definitions offer much flexibility and can be attached to a copier definition. In order entry, 
when you select a copier, any preset charges are automatically added to the job. If you change to a 
different copier, the charges attached to the old copier are discarded. 

To add charges to a copier definition, click the Add Charges button. The Charge Selector window 
opens. 

          
The window is divided into two areas, the top section is used for making new selections, and the 
bottom displays current selections and is used to remove preset charges from the list. The top part 
of the window presents a hierarchy. At the top level are the charge commands. Below each charge 
command is a list of the categories defined in the command window. Below each category are the 
charge definitions themselves.  

Up to 10 preset charges are displayed in the bottom of the window. You can remove a preset 
charge by selecting it and clicking the Remove button. If you change a charge definition that is 
preset in a copier definition, PrintSmith uses the latest definition when the charge is added to a job. 

Click the Close button when you have finished your selections. 

 

Strategies for Using Preset Charges 
The biggest advantage in using preset charges is having ability to quickly generate complex quotes 
in a more consistent manner. Often, complex quotes can be delegated to less knowledgeable 
employees with a much greater degree of confidence. It also can serve as a tickler – the most 
common charges automatically add to each job and the user can delete any charges that don’t 
apply to the situation. It’s easier to remove unnecessary elements in a job than to anticipate what 
you might have forgotten. 

There are many different strategies for defining copier definitions and deciding which charges 
should be preset. Be consistent in your use of preset charges. Adding stapling should be attached 
to all copier definitions that are used for multiple originals. There are some operations you can 
easily add to a few select copiers. You could set up a Carbonless copier definition, which includes 
charges for padding. Another copier definition for hand-collated Carbonless jobs which include the 
hand collating. Keep it simple and make it easy for your staff to use. 
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Using Copy Range Pricing 
The copy range table can be used to generate a pricing curve, or to set up pricing for special click 
costs at various quantities. The following table shows how PrintSmith uses this to adjust prices: 

Qty Cost/Copy Effect 
   

1 .03 Starting at first copy and ending with Qty from next line (1-99 in this example), 
adds 3¢ per copy 

100 .02 Starting with 100th copy and ending with Qty from next line (100-499 in this 
example), adds 2¢ per copy. 

500 .01 Starting with 500th copy and any additional copies, adds 1¢ per copy. 

   

 

Using the above table with a copier definition with no other costs: 

1 copy would cost $0.03 

100 copies would cost $2.99. (99 x 0.03) + (1 x 0.02) 

1000 copies would cost $15.98. (99 x 0.03) + (400 x 0.02) + (501 x 0.01) 
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Stock Definitions 
A stock definition controls the information regarding the papers used in your operation; how much 
they cost, what size you purchase, what size you normally run, and what equipment you normally 
run it on. 

In this section we will achieve the following objectives: 

• Searching the Stock Index 

• Changing Stock Prices 

• Testing Pricing 

• Printing Price Lists 

There are three areas you need to review in each stock definition; Stock Description, Specification 
& Pricing and Options. Optionally, stock can be added as an inventory item. 

Select Pricing > Stock Definitions from the main menu.  The Stock Picker window opens giving 
you the option to search for and select a stock. 

Searching the Stock Index 
The stock index can be expanded to search the fields in the top description area of the window. 
When data is entered, the list narrows to just those selections that match. The group designation is 
table and can be customized. 

 

Sort by 
column 
headers 

Filter by 
inventory 
options 

Inventoried 
items in bold 

Stock information is displayed in columns. Column information can be sorted and displayed by 
clicking on any column title. Scrolling up and down is much faster due to live updates. Pop up 
menus are also available for most fields in the description area. These menus are controlled and 
customized in the Table Editor. 
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Stock Definitions are available on WorkStations. Stock records are locked and unavailable to 
others when selected in the Stock Definition window. When you update the pricing folder in order 
for PrintSmith Portable to work properly, the file is copied into the portable system. 

To print a listing, select a particular stock. Select File > Print from the main menu. The stock list 
printed is based on the Group to which the stock belongs. Paper is the default group. Select a stock 
from each group and print a listing. 

 
Review all stock definitions and either customize them with your information or delete them. 

Deleting All Stocks 
If you would like to delete all of the stocks entered and start over, quit PrintSmith and remove the 
Stocks file from the Prices folder. Restart PrintSmith. When you select Stock Definitions from the 
Pricing menu, you receive an error message about the missing file: “The Stock Index file is 
damaged...OK to repair the Stock Index file?” Click the Yes button to continue and you can now 
create a new stock list. 

Note:  This should never be done on a system that is being used - only during initial set up. 
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Deleting Multiple Stocks 
It is possible to delete multiple stocks simultaneously from within the Stock Picker window.  The 
Delete Set button in the Stock Definitions window changes the Select button to a Delete button in 
the Stock Picker window.  Use the Shift key + mouse to select a contiguous range of stocks or the 
Cmd/Ctrl key + mouse to select a non-contiguous range of stocks, then delete. 

Viewing Stock Definitions  
To view a stock definition, select the stock from the list and click the Select Stock button. The 
Stock Definitions window opens. 

 
Stock Descriptions 

The top section of the window contains the following fields, which are visible from either panel: 

Group 

This is a convenient way to group stocks by their overall attributes. Stock Group is controlled by the 
Stock Group Table in the Table Editor, making it possible to change the name of groups and add 
many more stock groups. We recommend that you refrain from changing the name and use of the 
first five groups as importing stocks from vendors relies on them to some degree. If you do change 
them, importing stocks from vendor catalogs still works, but the group in which newly imported 
stocks are placed may not be what you expect. 

Class 

The Stock Picker does not use this field. It has been retained for use with the original Stock Lister.  
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Metric 

The system used for measuring metric stocks in much simpler and straightforward than the system 
used in the US. The principal difference is a common basic size (A0). The effect of this difference is 
that there is no need to calculate M Weight and the Basic Size is always the same. Enabling the 
Metric option removes those fields from the stock definition and changes the thickness 
measurement to “Microns” (one millionth of a meter). 

Envelope 

Selecting the Envelope option makes the M Weight field editable.  Since envelopes are 
manufactured products, they do not have an M Weight from the manufacturer. 

Name 

As PrintSmith sorts the list alphabetically, it is important to pay attention to extra spaces and 
misspellings. Limit the name to a description. We have separated the fields for weight, color, finish 
and size. The Stocks and Sizes Preference panel allows you to decide how to combine the name, 
weight and finish in those cases where the stock description is presented as a singled data element 
(stock order, invoice window, job ticket, etc.) 

You may wish to modify the names of your existing stock definitions to remove text that is now 
captured in other data fields. At a minimum, the weight and finish should be removed. 

Finish 

This field contains a finish description such as wove, linen or laid. The text of each available finish 
is stored in the Stock Finish table in the table editor. You select the finish from a pop up list that 
appears when this field is selected. 

Weight 

This contains the basic weight of a stock. This field is used to calculate the M Weight, and Carton 
Weight of the stock. If you store the weight as part of the stock name, we strongly recommend 
removing it and storing the weight only in this field. 

Color 

If you plan to import stock catalogs from vendors or order stock electronically, you should add a 
color to each stock definition. Enter the full “mill” color for each stock. In other words, if the mill 
color is “Avon Brilliant White” use that color rather than simply “White”. 

Each color in the stock database is stored in the Stock Color table in the Table Editor, which you 
control. In this table, each mill color (25,000 are supported) is associated with a Generic Color. In 
the above example, “Avon Brilliant White” would have a generic color of “White”. This allows you to 
find the stock using either the mill color or the generic color. 

Generic Color 

Each stock definition should have a generic color. This considerably enhances the power of the 
Stock Picker. When a stock is selected which does not have a generic color assigned, PrintSmith 
checks the Stock Color table to see if there is a generic color for that stock color. 

If it finds one, it automatically assigns it to the stock definition. If the stock color in the table does 
not have a generic color, it will ask you to select one and will update both the Stock Color table and 
the Stock Definition with your selection.  
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Grade 

This field is used to indicate the stock grade description; #1 Coated, #1, #2, #3, etc. You select the 
grade from a pop up list that appears when this field is selected. This table is the Stock Grade in 
the Table Editor. 

Coated 

This field tracks whether or not a stock is coated and on how many sides. Enter a 1 for stock 
coated on one side or a 2 for stock coated on two sides. 

Last Updated 

This field displays the date of the last change to any part of the stock definition you are viewing. 

Last Price Change 

This field displays the date of the last change to the stock definition which affected the costs or 
prices of the stock. This could be the result of using the Change Prices function or changing blank 
pricing in the Stocks and Sizes preference panel, not just changing the price directly in this window. 

 

Specification and Pricing Panel 
Vendor 

This field is used to identify the vendor of the stock. The Vendor Table in the Table Editor controls 
it. If you purchase the same stock from multiple vendors, you should create additional stock 
definitions for each vendor. 

Stock # 

Enter the stock number used to order this stock from the indicated vendor. You can enter letters 
and numbers, up to 31 characters. 

Note:  It is possible to search the stock file for a stock with a particular stock number. To do this 
type “/” or “?” followed by the stock number while in a blank stock record. 

Stock Type 

This identifies the type of paper: Business, Book, Cover, Index, and Tag. In non-metric stocks, this 
is a critical piece of information because it determines the basic size of the stock, which determines 
the M Weight, the Carton Weight and the CWT (hundred weight) Price. The Basic Sizes Table 
controls the contents of this menu. Generally, you should not modify this table unless you are 
certain of the changes. This table already includes all the common stock types and associated 
sizes. 

This table was first introduced in version 6.1. Unfortunately, the entry for “Wedding Bristol” had a 
size of “22.5 x 28”. This is incorrect and should be changed to “22.5 x 28.5”. 

Basic Size 

Basic Size corresponds to the Stock Type selection. This field cannot be edited and simply shows 
the size associated with the selected Stock Type in the Basic Sizes table. This size is used to 
calculate both the M Weight and the CWT price. 
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Parent Size 

The size of the stock you purchase from the vendor. For envelopes, use the Sizes Table in the 
Table Editor to set up common text descriptions such as #10. This also applies to international 
sizes: A2, A4, A6, etc. 

A quick way to enter a size from the numeric keypad is “17/28”. PrintSmith automatically expands 
this to “17 x 28”. 

M Weight 

This is the scale weight in pounds of 1,000 sheets of paper of a given size. The given size in 
PrintSmith is the Parent size in each stock definition. That parent sheet is compared to the basic 
paper size to determine the comparative weight or estimated M weight. The calculation for stock 
with a basis weight of 20 pounds in a 17 x 22 parent sheet that has a basic size of 17 x 22 can be 
calculated as follows: 

 
Thickness 

This field defines the thickness of the paper in one of 4 measurements: caliper, points, plies, or 
microns. Microns is used exclusively for metric stocks while the other three types of measurements 
are interchangeable and are used for certain types of stocks as follows: 

Thickness 

Measurement Definition 
  

Caliper Caliper is the thickness of a paper measured in thousandths of an inch, traditionally 
applied to most printing papers which are between 0.001 and 0.008 inch thick. 

Points One point is the equivalent of 0.001 inch, traditionally used to indicate heavy card stock 
such as coated covers. 12 point cover is 0.012 inch thick (12 points x 0.001in.) 

Ply Ply is traditionally used to indicate thickness of card or chipboard. A sheet of 6-ply board 
is 0.024 inch thick (multiply the ply value by 3 and add 6 to that result). 

Micron Micron the standard unit of thickness measurement for metric stocks. A micron is one 
millionth of a meter. 

  

 

Sheets/Carton 

The Sheets per Carton field is the number of sheets of the Parent Size in a single carton. This can 
also be used to specify the number of parent sheets in a skid. 
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Carton Weight 

If the Stock Type is properly selected or the stock is a metric size, and the Basis Weight is known, 
PrintSmith is able to calculate the M Weight. The M Weight is used to determine the weight of a 
carton (or skid). The formula for calculating the carton weight is: 

 
These two fields define the order information for a particular stock. The carton weight for 1,000 
sheets equals the M weight. If the carton holds only 500 sheets, the carton weight is half that 
amount. 

Minimum Order 

For stocks that can be ordered in any quantity, enter a 1 in this field. If the stock has a minimum 
order, such as ream wrapped stock that can only be ordered in sets of 500, enter 500 in this field. 
This ensures that the stock order and job ticket properly reflect the amount of stock to be ordered. 
In addition, it allows you to pass on the cost for ordering more stock than absolutely needed to your 
customer. 

Example: In the Production Data window in the Estimator, if a job requires 200 sheets and the 
minimum order in the stock definition is 250, 250 displays in the Sheets Purchased field. Note 
that although the number of sheets purchased may be greater than needed for the job, 
production charges are based on the number of sheets used in the job, not the full quantity 
purchased. 

 

Charge Customer for Entire Order 

Enabling this button for a particular stock, tells the Estimator to add the cost of the entire stock 
order to the stock charge of the job. This cost is marked up in the usual manner, but the additional 
sheets are not included in the charge for printing or copying. Using the previous example, the job’s 
stock cost reflects the 250 sheet minimum purchase. 

Costing Units 

This is the quantity in which the stock is priced. Usually this is 1,000 since most stocks are priced in 
lots of 1,000. Envelopes often come 500 to a box and priced in that way. You can also break roll 
stock into sheets to price rolls. For example, if a roll costs $300.00 and 25,000 sheets can be cut 
out of the roll, you would enter 25,000 here and $300.00 as the cost of the stock. 

# sheets/set 

Used to define carbonless stock in pre-collated sets. If you have a 3 part carbonless stock, for 
example, you would enter 3 in this field. The Estimator can then automatically make the correct 
calculations based on the number of sheets in a set. 
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Cost Is in Sets 

This feature is intended primarily to enhance carbonless pricing. When enabled, it indicates that the 
cost entered is for sets, not individual sheets. Changing the setting of this button automatically 
changes the cost of the stock. For example, a 2 part carbonless set is priced at $200.00 per 1000 
sets with this button turned on. Turning it off changes the price to $100.00, because the price is 
now based on half as many sheets. The Estimator handles pricing for this stock correctly 
regardless of which setting you choose. We recommend setting it to match how each of your 
vendors specifies the stock. 

Qty Breaks 

This is the maximum quantity of parent sheets for each column in the price table. For example, 
entering 1000, 2000, and 3000 in the first three columns tells PrintSmith to use the first column for 
the stock cost and markup for quantities up to and including 1000. The second column is used for 
quantities from 1001 to 2000. The third column is used for quantities greater than 2000. Enter a 
quantity in this field for any column you want to use or PrintSmith assumes that it is not used. 

Cost 

Cost of the stock and the number of pieces you can buy at that price. Normally this is the cost per 
1000. Envelopes usually come in boxes of 500. In that case, use 500 for the units. 

CWT 

CWT stands for Hundred Weight Price. This field contains the cost for 100 pounds of paper 
regardless of size. Hundred weight pricing is a convenient way to compare paper prices for 
different stocks in different sizes. Although there is some variation within a given stock family for 
different size stocks, the CWT price is generally similar. You have a choice of entering either the 
CWT price or the Cost. Entering one calculates the other providing there is sufficient information 
available in the stock definition to make the calculation. 

In order to calculate the CWT price, the Basic Size and Weight must be known and be correct. 

Markup 

The stock markup is used by the Estimator to mark up the cost of the stock. If the markup in the 
first column does not appear to be overridden (overrides are shown in the outline face on 
Macintosh and underlined italic on Windows), you are actually looking at the standard stock markup 
defined in the Stocks and Sizes Preference panel. 

Normally you will not alter it. Change it if you want a particular stock to be marked up differently 
from the standard stock markup you specified in Pricing Preferences. Enter a markup rate in 
columns 2 through 6 when the markup you want to use is different from the first column. Leave the 
markup field empty across the row unless the rates in columns 2 through 6 are different from the 
first. 

Note:  If you change the system default stock markup in Pricing Preferences, you change the 
markup for all stock definitions except those, which have been overridden. 
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List/M 

Used to specify an additional price per thousand sheets for use with the List pricing method 
because list pricing does not factor in the stock cost when generating a price. The amount (plus or 
minus) entered in this field is divided by 1000 and multiplied by the quantity ordered and added to 
the price of the job. 

Example: A price schedule is used for a stock, which costs $10.00 per thousand. You want to 
use it for a stock that costs $11.00 per thousand. You could enter $1.00 in “List/M” and 
PrintSmith would add 1.00 to each thousand ordered. 

Price Expires 

This information is only provided as part of importing stock prices from a third party stock vendor. It 
tells you whether the price shown in the stock definition is valid. If the price has expired, you 
receive a warning message that the price has expired, however, you can still use the stock. 

Although we have defined this field as part of the Generic Vendor stock import data format, we 
know of no paper vendors that have implemented it. This intention of this field is to support the idea 
that the paper price quoted by the vendor will be honored until the expiration date of the price in 
stock definition. If your paper vendor supports importing into PrintSmith, you may want to ask them 
when they’ll support this feature. 

Comments 

Use this to keep track of notes related to the stock and ordering process. 
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Pricing Options Panel 
The Pricing Options panel is used set up specifications used by the Estimator to price jobs using 
this stock definition. 

 
 

Normal Run Size 

This specifies the most common run size when you create a job using this stock definition. It is also 
used as both the run and finish size when generating a price list with the Price List button or the 
Generate Price Book command in the Pricing Menu. PrintSmith automatically calculates the 
number of sheets that can be cut out of the selected parent sheet. If you do not specify a run size, 
PrintSmith assumes that it is the same size as the parent size. 

Cut/100 

Cut charge for each 100 parent sheets. This charge is added to the stock cost and is useful when 
the vendor charges for cutting parent sheets to the size you’ve entered in Parent Size. The cut 
charge is calculated including estimated waste and is added to the cost of the stock after the stock 
has been marked up. The cut charge itself is not marked up. 

Note:  For best results, add a Pre Press cutting charge instead of using Cut/100 since a charge 
is much more “intelligent” about how many cuts and lifts are needed. 

Min. Cut Chg 

Used in conjunction with Cut/100 to specify a minimum charge for cutting. If theirs is no Cut charge 
specified, the minimum is added to the stock for all quantities. 
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Select Press for Printing 

The Select Press for Printing allows you to preset a press definition for use with a particular stock. 
When you select a stock definition that has a preset press, PrintSmith assigns the press to that job 
and adds any charges that are preset in the press definition. Selecting a stock definition without a 
preset press assigns the “default” press, the first press in the definition list. 

PrintSmith is designed so that you can use the press definition as a way of defining a production 
environment. If you know a stock is always used in a particular production environment, you can 
create a press definition and preset the press for each stock definition to which it applies. Some 
good examples are carbonless forms and envelopes. 

Use the press pop up menu to select a press. The first item in the press menu is “<use default>”. 
Select this if you do not want a preset press. The default press is the one you set in the Press 
Definitions window. 

Select Schedule for List Pricing 

To use list pricing with more than one price schedule, you must tell PrintSmith which price schedule 
to use with each stock. To select a price schedule, click this button and select the schedule from 
the list of the currently defined price schedules, which is displayed. If you select a stock in the 
Estimator, which does not have a preset schedule, PrintSmith warns you and uses the default price 
schedule, which is the default List price schedule. 

When a price schedule has been assigned to a stock, its name is displayed to the right of the 
button. To remove a preset schedule, click “Select Schedule” and then “Cancel” when the schedule 
list is displayed. 

Pricing for Blank Sheets 

Blank pricing has six prices for six different quantity breaks, each of which can be based on the 
cost of the stock at a different markup. As shipped, these quantity breaks are 1, 10, and 100, but 
you can change the quantity breaks and markups to anything you like in each definition. 

You may also change the system default values using the “Stocks and Sizes” preference panel. 

PrintSmith calculates the price for blank stock at the defined quantities using the standard markups. 
If you change the quantities in the stock definition, PrintSmith calculates the price using the 
quantities you entered with the markups from the Stocks Preference panel. 

Auto Calculate Blank Stock 

The blank stock pricing style relies on pre-calculated prices that are based on the cost of the stock. 
This button turns automatic calculation on and off for the stock shown in the window. Turning this 
button off and then on causes auto-calculation to be performed for the current stock definition. 

The Auto-Calculate button allows you to specify, for each stock, whether or not you want PrintSmith 
to maintain these rates for you automatically. We recommend that you leave this button turned on 
unless you have very specific pricing targets for blank stock that do not depend on the stock cost. 

Any change to the stock price triggers automatic calculation. The price is calculated for the run size 
based on the parent size. 

Notes:  Changing blank stock preferences do not recalculate blank sheet pricing. You can use the 
Change Prices command to update prices for all stocks. 
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Adjust Copier Matrix and Select Default Copier 

PrintSmith supports several pricing models for copying. One of the important options in these 
pricing models is the ability to specify how stock is priced. In some models the price is taken 
directly from the cost of the stock. In others it may be necessary for each stock to have a stock 
price for copying that differs from its actual marked up cost. 

The Copier 1 and Copier 2 rates are provided to allow you to have different stock costs for copying 
on each stock definition. The rate that is used for pricing depends on the copier definition used for 
the job. Because each copier definition can use either of these fields you should decide how each 
is to be used. For example, a common method of using these fields is to use Copier 1 for black and 
white copies and Copier 2 for color copies. 

Note:   “Copier 1” and “Copier 2” are actually based on the name of the two copying pricing 
methods. These pricing method names can, and often are changed. This section may look 
somewhat different on your system. 

Each stock can have a preset copier for each of the two copier pricing methods. To preset a default 
copier, select the copier from the pop-up menu. When a stock with a preset copier definition is 
selected in a copier job, PrintSmith assigns the copier to that job and adds any charges that are 
attached to the copier definition. Select “<use default>” to remove a preset copier. 

Add Charges 

Each stock definition can have up to 10 preset charges. This button allows you to edit the preset 
charge list. When charges are already assigned to the stock definition, the number of charges is 
displayed as “(1) Charges…” the number in parentheses indicates the number of preset charges. 
See Adding Charges to Stock Definitions on page 166. 

Import One Stock 

Use this button to import a single file containing a single stock definition, which displays in the 
window for immediate editing. The data file must contain a single stock record that was exported 
from the XPEDX Printer’s Product Guide or other paper vendor. The location of the file and file 
format must be set up in the Import Stock Catalog command.  
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Inventory Panel 
The Inventory panel is used to set up stock as inventory items. 

  

Stock inventory 
information 

Recent 
inventory 
changes 

Show Entire History 

 

Stock is standard inventory item 

Selecting this option activates the Inventory tab fields so that the stock can be entered as an 
inventory item. 

Stock on Hand 

The amount of stock that is currently in inventory. 

Committed 

The amount of stock committed to current jobs that have not yet been run. 

Note:   Committed stock can be manually entered or automatically calculated.  As stock is 
selected and assigned to a job, the committed number increments.  Stock committed prior 
to the stock being defined as a standard inventory item does not affect the inventory 
count. 

Available 

The amount of stock that is available.  This field is not editable and is the difference between Stock 
on Hand and Committed. 

On Order 

The amount of stock currently ordered. 

Target Level 

The desired amount of stock to keep in inventory. 
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Reorder Point 

The “trigger-point” at which new stock should be ordered. 

Min. Order Qty. 

The minimum amount that can be ordered at one time. 

Stock Expires 

Enter the expiration date of the stock, if applicable.  The default value is <never>. 

Bin Location 

An identifier for the stock storage location. 

Shell Item 

If this item is a shell item created by the shop for use in another job, check this box and optionally 
Assign Customer Account. 

10 Most Recent Inventory Changes 

A static list of the 10 most recent inventory changes.  Clicking the Show Entire History button 
opens the complete Inventory History window. 
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Changing Prices 
If you want to increase or decrease prices across the board or on all or some stocks, select Pricing 
> Change Prices from the main menu. 

Stock Definitions 

 
 

Enter the criteria to change prices. Example:  You could update all stock records from the Paper 
Group and enter Dixon in the Vendor field and auto update by 10%. 
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Adding Charges to Stock Definitions 
Charge definitions add a tremendous amount of flexibility to the PrintSmith Estimator. The six 
charge definition commands are: Pre Press, Bindery, Production, Merchandise, Mailing Services, 
and Miscellaneous. Select any six of those charges and “attach” them to a stock definition. When 
you select a stock, the preset charges are automatically loaded. If you change to a different stock, 
the charges that are attached to the old stock are discarded and a new set of charges is loaded. 

To add charges to the preset charge list, click the Add Charges button. The Charge Selector 
window opens. 

          
The window is divided into two areas, the top section is used for making new selections, and the 
bottom displays the current selections and is used to remove preset charges from the list. You can 
preset up to six charges, which display in the bottom of the window. Remove a preset charge by 
selecting it and clicking the Clear button. When a charge is attached to a stock, PrintSmith 
remembers how to find the charge, not what was in the definition. If you change a charge definition, 
PrintSmith uses the latest definition when the charge is added to a job. 

Click the Close button when you have made your selections. 

Note:  The Change Prices command also supports adding charges to groups of stock definitions 
automatically. 

Strategies for Using Preset Charges 
The biggest advantage to using preset charges is it gives you the ability to quickly generate 
complex quotes in a more consistent manner. In the case of stocks, you could add a pre press or 
bindery cutting charge to always charge for cutting (as long as there was no minimum or setup 
charge in either definition.) Another example is to attach carbonless padding to all carbonless stock 
definitions, as it is rare for carbonless stock to leave the shop unpadded. It makes sense to attach 
this charge because this is a function that occurs most of the time. These types of preset charges 
can also be set up as hidden charges and will not print on customer documents. 
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Other Prices 
Use this command to raise or lower prices on Presses, Copiers, charges and list price schedules. 
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Importing Stock Catalog 
An important feature is the ability to import stock definitions and update prices from a vendor’s 
electronic price catalog. At this point, PrintSmith works best with XPEDX. XPEDX has developed a 
Printer’s Product Guide that can be used to find and export stock definitions and prices on an 
individual stock. In addition, they have developed an export utility that can export large groups of 
stock into a file that PrintSmith is able to read and update of all the XPEDX stocks in the stock file. 

The window has three panels. The first panel controls the overall process. The remaining panels 
are used to verify the import process based on the selected interpreter. 

Settings 
The Settings panel is used to control the import process. 

 
Use xpedx Interpreter 

Select this option when importing data from the xpedx pricing catalog. See the xpedx panel for the 
expected file format. Generally, this file must be created using the xpedx Export Utility that creates 
a file named “data.txt”. Normally, the file is in the catalog folder although this can be changed in 
their program. The program and documentation for the export utility should be available through an 
xpedx representative on both the Macintosh and Windows platform. 

Use Generic Interpreter 

Select this option when importing data from any other pricing catalog. See the Generic panel for the 
expected file format. 

Verify Each Stock 

Before adding or importing a stock definition a window is opened which asks if you wish to save 
changes either to a new definition or an existing one. 

Import File 

This is the location of the file containing the stock data to import. Once set, this file name is 
remembered and shouldn’t need to be reselected. 

Note:  This must be performed before doing anything in the interpreter panel. 
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Browse 

Use this button to find the file to be used for importing. 

Adjust Bracket by Percent or Amount 

The bracket price being imported can be changed during the import process by either a percentage 
or a fixed dollar amount. Increase the price by entering a positive amount or decrease the price by 
entering a negative amount. Whether the adjustment is a fixed amount or percentage is determined 
by the button selection. 

Expanded Price Brackets 

You used to only be able to import one price bracket, which you had to select. The stock import 
now supports up to five price brackets and different adjustments can be made to each. If you select 
just one bracket, bracket four for example, it places the stock cost in the fist price column in the 
stock definition. If you were to import bracket two and bracket four, for example, these brackets 
would import into the stock definition’s first and second price columns, respectively. 

No Broken Cartons 

When this button is selected, the “Min. Order” field in the stock definition is set to the value of Lot 
Count when importing using either the Generic or Xpedex interpreter. 

Metric 

This setting allows imported metric information and automatically turns the metric button on in the 
stock definition. 

Update Prices 

Click here to use the imported data to update existing stock definitions. Locate stock definitions by 
vendor name and stock number (“Stock #” in stock definition window). Stocks in the import file, 
which are NOT in the stock definition, are not added. 

Import All 

Click here to use the imported data to create new stock definitions. This is identical to updating 
prices except that it adds stocks if unable to locate an existing one. 
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Customer Information 
In this chapter 

Accounts 172
Contacts 186
Adding Contacts to Accounts 189
Searching for a Customer 189
Prospects 189

 

Another task in setting up PrintSmith is adding customer information. PrintSmith manages a great 
deal of customer information. It identifies who they are, where they are, sales this year, last year, 
this month, money owed, cash, check, charge, etc.  Before it can manage the information, you 
need to enter your customer information. 

Note:  You only need to enter customers that have an outstanding account balance to get 
started; others can be added as needed. 

If you already have your customer list in an electronic format (i.e. on Disk), PrintSmith can import 
that information directly for a small fee.  

Prospect information can be imported into PrintSmith. See Import Prospect Template, page 179, for 
information on how to import Prospects. Once in PrintSmith, prospects are easily converted to 
customers. 

Note:  If you have your customer list in ASCII format, PrintSmith can import that data. Contact 
PrintSmith for information on conversions. 
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Accounts 
Select AR > Accounts from the main menu. The Account Picker window opens. Your new 
installation of PrintSmith does not have any customers other than <<<WALK-IN>>>. Click the 
Cancel button to get to a blank customer account window. 

Note:  You can also use the shortcut commands <command> + <a> on Macintosh or <control> + 
<a> on Windows. 

 
Note:  PrintSmith can handle over 60,000 customers and prospects. Enter in all potential 

customers and contacts. You can search for customers by name, account number, 
reference number, phone or part of a phone number and master billing account. 

The Customer window opens. Since no customer was selected from the Account Picker window, 
PrintSmith assumes you are entering a new Customer. The window title reads Customer: New 
Customer.  Click on the Address tab to reveal the contents of that panel. 

 

Resize this 
window by 
dragging the 
expander in the 
bottom right 
corner. 
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Address 
The Address panel contains the account name or title, external reference number, invoice and 
statement addresses, and their associated contact information. 

There are four “editor” fields, an address and contact editor field for the invoice address and for the 
statement address. When you create a new customer account, the information in the contact field is 
used to automatically create contacts for that account. This is the only time you can create contacts 
from the Customer Account window. Changing the contact data in this window also edits the 
information in the Contact Manager window. 

Contact List 

Once you have entered contact information, a Contact List pop up menu is found under each of the 
contact editor fields. This is used to select the default contact for each of the two types of contacts 
supported (Invoice and Statement). 

The last item in the contact menu in this window is always the Edit command. Selecting this 
command opens the Contact Manager window and displays the default contact for editing. Unless 
you need to modify marketing information for a contact, it’s generally much easier to edit default 
contacts from the Customer Account window. 

Default Contacts 

It is possible to create a customer account without an assigned contact. In fact, the “Walk-In” 
account cannot have any contacts. We strongly recommend always creating a contact at the same 
time as you create the account so mailing lists, labels, reports and other marketing activities have 
contact information. Once a contact has been assigned to an account, the assignment is fairly 
permanent in the sense that there must be an assigned contact. You can change the default 
contact and you can select the same contact for both the invoice and statement contacts. You 
cannot change an account so that it no longer has a contact assigned. 

The Contact Manager does not allow you to delete a default contact. 

Statement Address 

The Statement Address is the billing address where statements are mailed. This address 
information could optionally be shown on the invoice or estimate. 

Note:  If the statement address is the same as the invoice address, no further action is 
necessary. When the account is filed, the invoice address information is copied over to the 
statement address. 
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Credit Control 
The Credit Control panel contains the data used to set credit limits, finance charges, account type 
and account status. 

 
 

Credit Limit 

Enter a dollar amount representing the maximum a customer is allowed to charge to their account. 
If it is 0.00, the system credit limit is used (you set the system limit using the “Credit” Preference 
panel). The system credit limit displays immediately to the right of this field. If there is no default 
limit and the field is empty, Unlimited Credit displays to the right of the field because there is no 
system credit limit. This field uses the default limit unless another number is entered. If the 
preference default is zero then they have no credit limit. 

Due Days from Posting 

Although calculated and tracked, this feature is not fully implemented. Except for the history detail, 
no other direct use is made of the due date. This field is available for use with Downloader and 
Report Writer. When an invoice is picked up, this field is used to calculate the number of days 
before the payment is due. If a date isn’t specified here, the “Aging Periods” Preference panel is 
used to calculate the account status based on the number of days indicated there. “Avg. Days to 
Pay” show’s the customer’s average payment period. The history detail shows the due date on 
items posted. 

Monthly Finance Charge Percentage 

The Monthly Finance Charge Percentage field is the percentage PrintSmith uses to calculate 
finance charges during statement generation. If zero%, the system default finance charge rate is 
used (defined in the Credit/Defaults Preference panel). When the default rate is used, it is 
displayed to the right of this number as shown in the previous screen shot. This field uses the 
default rate unless another has been entered or “Never calculate finance charges” is checked. 

Note:  This is the actual rate used each time you calculate finance charges when generating 
statements. It is not an annual rate. 
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Finance Charges YTD 

Records the total amount of finance charges posted to the account in the current year. 

Never Calculate Finance Charges 

Used if you never want to generate a finance charge for this account. This button is only needed 
when there is a system finance charge and you never want to generate a finance charge for this 
particular account. 

Automatic Discount Percent 

Enter a percentage only if you want this customer to always be given a discount or a markup. To 
set up a markup, enter a negative percentage. Discount percentage provide customers with a 
percentage (%) off each invoice. Additionally, a negative percentage (- %) can add money to each 
invoice created for that customer. 

Current Balance 

The total amount owed to you by this customer, including Merchandise Charges or POS Charges. 

Account Status 

Provides a description of the current status of the account as of the last aging (although you can 
change it here on a case by case basis). Frequent reference is made to accounts being 30, 60, or 
90 days past due. There are three aging classifications whose standard values are 30, 60, and 90; 
they can be changed as needed in the “Aging Periods” Preference panel. 

Account Status 
Status Meaning 

  

New When an account is first created and has never been aged, it is considered a new account. 

Current The account is current if all amounts owed are within the allowable limits. 

Past Due The account has open items picked up more that 30 days ago. (Settings for aging are 
variable; your aging may be different.) See page 49 for details. 

Delinquent The account has open items picked up more than 60 days ago. 

Inactive As of the last aging, the customer had not ordered anything within the inactive period 
specified in the Credit/Default Preferences panel. The system checks to see if the customer 
has had any activity. Estimates, invoices or payments made cause the customer to be active. 

Frozen The account aging process can automatically freeze accounts with open items picked up 
more than 90 days ago. Once an account has been frozen, no more invoices can be created 
and no charges can be accepted. An account is normally unfrozen manually or automatically 
during the aging process. 

  

 

You can choose the account status or let PrintSmith update and maintain the account status. All 
customers are new when first entered. PrintSmith updates this information when an account aging 
is performed. You have choices to make in the account aging process. It is recommended that the 
status buttons are left alone as you set up the system. 
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Account Type 

The account type determines what types of transactions are accepted for this account. 

Account Type 
Type Meaning 

  

Full Deposit When an invoice is opened or filed with a balance due, a reminder notice is displayed 
to remind the user that this customer must pay in advance. This notice can seem 
obnoxious but serves as a warning to proceed with caution. In addition, cash register 
transactions (POS) must be paid in cash. Deposits can be paid with cash, checks, or 
credit cards. 

Cash Only Customer must pay with cash. Checks and credit cards are not accepted. Charges are 
not permitted to accounts receivable. 

Cash /Check / 
Credit Card 

Customer must pay with cash, check, or credit card. They may not make any charges 
to accounts receivable. 

Charge Account Customer may make charges to their account. There are no restrictions on payment 
type. 

  

 

When entering a new account, the payment method automatically defaults to Checks. Once your 
customer has undergone your credit process and you have established a credit limit, the account 
can be changed to Charge status with the appropriate credit limit entered. 

Settings 
The Settings panel contains a variety of settings that control or modify how the account is used 
throughout the system. 

 

Name of master 
account would be 
shown here. 

This button creates the 
ImportProspectFormat.txt 
file. 

The Import icon is used 
to import the customer 
information. 
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Select Master Account 
The Master Account section is used to assign the account to a master account. Any account can be 
selected as a master account. There are two ways; click the Select Master Account button and 
select the customer account; or, if you know the account number, type the account number into the 
edit field. 

Master accounts are very useful for companies where there are multiple contacts. For example you 
might have three departments at Xerox. All three do business with you but payment comes from 
Xerox AP. Set up 4 accounts in this scenario, the 3 departments all have Xerox AP as the master 
billing account. 

 

General Options 
Sales Rep 

Choose Sales Rep from the popup list. This list comes from the Sales Rep table in the Table Editor. 
This information is copied into the “Sales Rep.” field in the Account Info window in the Estimator 
when the account is assigned to a document. 

Business Type 

Business type is a 4 character field for use in sorting your customer list. The Customer List report 
and Mailing Labels both provide options for sorting by business type. SIC codes work and ABC 
method of ranking are possible ways to sort. 

Shipping Method (Ship Via) 

This popup list allows you to define the default shipping method for a customer using the same 
table in the Account Info window. Setting a default shipping method automatically defaults that 
method in a document when that customer account is assigned. The prompt on the shipping 
method field is the same as the title of the Table. Changing the table title Ship Via changes the 
prompt. This holds true on invoices as well, so you can use this for something entirely different if 
appropriate for your business. 

PO Required on Invoices 

If customers require a Purchase Order, you need to check this box. PrintSmith warns you to enter 
PO, and will not allow you to pick up an invoice for this customer without one. When enabled, a 
reminder notice displays if no PO number has been entered on the invoice. It doesn’t prevent the 
invoice from being created although it cannot be picked up. The notice also displays when an 
estimate is converted to an invoice and each time the document is opened until a PO number is 
entered. 

Do NOT Generate Statements 

If enabled, the statement generator ignores the account when generating statements. You can still 
generate a statement for any account by specifically indicating that account. If a statement would 
offend a customer, check the Do NOT Generate Statements option for this customer. This option is 
useful for sub accounts of a master billing account that never responds to a statement. 

Account Is Commissioned 

The Account Is Commissioned option is used with the Report Writer to generate commission 
reports. Other than this function, PrintSmith does not use it. 
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Always File Originals 

This setting now resides in the account set up. The user can change the default when an invoice is 
created. 

 

Selecting the Standard Document Preferences 
Some customers may have unique quoting and billing requirements. For these customers, you can 
specify the document preferences to use when creating invoices and estimates. For example, if you 
enter in a negative discount percentage (a markup) you might consider selecting a document 
preference that hides customer discount. 

Default Invoice and Default Estimate 

Select the document preference to use when creating invoices and estimates for this account. 

 

Tax Setup 
Tax Table ID 

A two character ID identifies the tax table when you require a different tax rate for a particular 
account. PrintSmith won’t let you enter an ID unless there is already a tax table defined for that ID. 
Generally, you’ll find it much easier to select the desired tax table using the Tax Table menu. 

Tax Table Menu 

This menu provides a quick and easy way to select a defined tax table. Selecting a tax table from 
the menu automatically inserts the correct tax table ID in the field. 

Tax Code 

Use tax codes to categorize sales for tax reporting purposes. If a particular customer must be 
coded in a particular way, enter the tax code here and PrintSmith copies it to the document when 
this account is assigned to the document. 

Note:  There are no rules or requirements in using tax codes. The only function of a tax code is 
to create a separate line in the tax detail report within the same tax table. 

Resale 

Used to record the customer’s tax exemption ID or license number. Entering text in this field only 
serves to record the tax or license number in the account and on documents created for this 
account. 

Note:  The only way to make an account tax exempt is to use the Tax Exempt button. 
Certificate Expires 

Enter the date the customer’s tax exempt certificate expires, if any. 

Tax Exempt 

When the Tax Exempt option is enabled, documents created for this account do not have sales tax. 
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Security Level on This Account 
Account level security codes prevent access to employees who otherwise have access to the 
Account History, Customer Accounts, and Post Payments commands. Accounts are only 
accessible in those commands by users whose access level is equal to or greater than the access 
level in the account. 

Note:  Accounts can be assigned to documents even if the user’s access code prevents them 
from viewing account history and the customer account. 

 

Import Prospects 
This function allows you to build a database of customers based on criteria of your choice. It is 
useful for building lists of inactive customers, mass mailings, and special announcements about 
your shop. 

 

Import Prospect Template 
Creates a file showing the order of the data expected by the Import Prospects function. The format 
expected is: 

“Full Name”, “Street 1”, “Street 2”, “City”, “State”, “Zip”, “Contact Name”, “Phone Number”, “Fax 
Number”, “External Reference Number”, “Sales Rep. or Empty”, “Resale Number or Empty” 
<return> 

The file can use the comma delimited form shown above or a tab delimited form shown in the 
export example. 

 

Preset up to 10 charges 
Up to 10 preset charges can be applied to accounts for Invoices and Estimates and another 10 for 
Jobs.  Clicking the Add Charges button opens the Charge Selector window, where charges can be 
selected.  The number of charges added is displayed in the button. 

Notes:  Preset Charges can be viewed by clicking the Charges button. The Charge Select window 
opens. Charges can be added and removed from this window following the same 
processes as in previous versions of PrintSmith.  Invoice level charges cannot be hidden. 
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Sales Info 
The Sales Info panel contains mostly sales statistics. You can use this panel to change the sales 
representative (this can also be done in the “Settings” panel) and to perform an instant aging of the 
account. 

  

Shows the 
relation between 
aging categories 
as of the last 
aging. 

Account Aging 

Shows the account balances as of the last aging. These balances can be updated at any time by 
clicking the Age Now button. 

Account Status 

Show the current status of the account. Normally PrintSmith as part of the aging or statement 
generation process sets this automatically. It can also be changed manually in the Credit Control 
panel. 

POS Charges 

The outstanding balance of Cash Register department transactions charged to this account. You 
use the Post POS Charges command from the POS menu to convert this balance into an open 
item. 

Current Balance 

The total amount owed to you by this customer. It also includes Merchandise Charges. 

Age Now 

Clicking this button performs an instant aging of the account using the current date as the aging 
base date. See Account Periods, page 49, for a more complete description of the aging process. 
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Sales Ranking 

The standing of this account’s sales volume in relation to your other accounts the last time you ran 
the Sales Ranking by Year report and saved the ranking. View the Customer List Report from the 
Reports menu. 

Note:  We recommend you print out and save the sales ranking at the end of each year. 
Sales Rep. 

This information is repeated in the “Settings” panel. This information is copied into the “Sales Rep.” 
field in the Account Info window in the Estimator when the account is assigned to a document. 

Sales Statistics 

Sales statistics include invoices picked up for this customer that do not include tax. 

Sales Statistic 
Statistic Meaning 

  

Sales Total sales volume for this account in the current month, current year and prior year. 

# Orders The number of invoices for this account in the current month, current year, and prior 
year. 

Average Order The average amount of all invoices in this account in the current month, current year, 
and prior year. 

Quotes: Orders The ratio of estimates to orders. This helps to identify accounts for which you are 
continually entering estimates but rarely getting jobs. The number of estimates may not 
be exact. PrintSmith counts an estimate only when you are filing a new estimate. If the 
account is in use in another window or WorkStation, it won’t be counted. Changing the 
account on an existing estimate isn’t included either. 

  

 

Created 

The date the account was entered into PrintSmith. 

Last Billed 

The date a statement was last generated for the account. 

Last Payment 

The date the last payment was received for the account and entered via the Post Payments 
command. 

Last Aged 

The date the account was last aged. 

Last Invoice 

The date the last invoice was created. 

Last Estimate 

The date the last estimate was created. 
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Log 
The Log panel provides access to the customer contact log. There is an enlarged edit field that 
shows the maximum length of the text. 

 
Records the date, time, user name, and comments in a log for the customer account. It can be 
used for anything you wish. Add a new entry by typing the text and clicking the “Add” button. Delete 
an existing entry by clicking on the entry and then clicking the “Delete” button. Log entries are 
automatically made when text is entered in the Notify Customer window, which resides within the 
Pending Document Window. These entries also contain the text “(Notified)”. 

Note:  Only the last 500 entries per customer account are shown in the log. 
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Notes 
Used for notes that appear based on different functions. 

 
Account Selection Notice 

Notes, for specific customers, can be retained to display when the customer account is selected 
while creating an estimate or invoice. Additionally, these notes are placed on the invoice or 
estimate automatically. 

This text block serves two purposes: 

• Notify the user of something special about the account whenever the account is assigned to a 
document. 

• Place these notes in the special instruction field of a document 

When you copy a document for an account or assign an account to a document, a window opens 
displaying this notice and asks if you wish the text copied in to the “Special Instructions” field. 

Note:  There is a limit of 2,000 characters in this text block. 
Notes to Insert in Each Job 

Any text in this text block is automatically copied to job ticket notes whenever a new job is created 
in a document to which the account is assigned. It isn’t copied to job ticket notes for existing jobs so 
assigning the account to a document that already has jobs won’t insert this text in the job ticket 
notes of those jobs. 

Notes to insert in each job are printed on all job tickets for this customer only. You can use these 
notes for accounts whose jobs are always handled in a certain way. For example, you might have a 
customer for whom you won’t start production unless a proof has been signed, or to whom you 
always return the artwork. You can make note of this here and 

PrintSmith automatically puts this in job ticket notes, which are printed on the job ticket. 
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Notice to Place on Statements 

The text in this block is placed on statements generated for this account (unless this feature is 
disabled in the Statement Generator). 

You can use this to customize collection notices for an account or to remind them of upcoming 
repeat orders. 

Notes to place on statements are one of three custom notes that can appear on statements. This 
note would be specific to the customer account and would appear ONLY on this account’s 
statement. 

Note:  These notes are all designed for small blocks of text for the specific purpose described. 
They should not be used for lengthy messages or as a record keeping repository – use 
the contact log for that. The maximum practical amount of any text block is 2,000 
characters. 

 

Marketing 
This window records useful marketing information. 

 
The Customer and Prospect buttons are used to control whether the account is a prospect or 
customer account. If a customer can’t be changed to a prospect, the buttons are disabled. 

The rules governing this are as follows: 

• Account has a balance or an open item in history. 

• Account has Pending Invoices. 

• Account is a Master Account or a Sub-account. (Note: this relationship only works with 
customers). 
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Personal Account 

The Personal Account option should be used to mark accounts that are a person rather than a 
company. 

For example, if you have an account for "Tom Jones" and Mr. Jones prints Christmas cards and 
personal stationery, the account should be a personal account. An account for a Dr. Jones would 
usually not be marked as a personal account as the relationship is probably a business to business 
relationship. This setting is used by the mailing label command to segregate personal accounts for 
targeted mailings. It is also available in the Report Writer. 

Do Not Mail 

This button is used by the Mailing Labels command. Enabling this feature removes the account 
from labels or mail merge files generated with the Mailing Labels command. This button may also 
be used with the Report Writer to control output. 

The rest of the information is data that you can use to design a marketing campaign in any way you 
see fit. This window, together with the Report Writer can generate some powerful reports. 

Number of Employees 

Enter the number of employees in the company. This is useful for targeting companies based on 
their size. 

Annual Revenue 

Enter the annual amount of revenue of the account or your annual budget target expected from 
them. This can help target companies based on their revenue stream. 

Business Type 

This information comes from the business type table. The information stored comes from the ID of 
the table element, not the text. This means that you can change the text in the table and 
immediately see this change reflected in all accounts. 

Marketing Dates 

This is a group of five dates that can be used for any customer related purpose. The first date is 
shown as “Follow-up”. This is just a suggested use to give you some ideas as to how it can be 
used. To make best use of the dates, they should be labeled properly. The label for each date is 
stored in the “Marketing Date Labels” table. 

Marketing Tags 

Ten fields that, like Business Type, store the ID of the associated table. The two Lead Source fields 
both use the same table - Lead Source. The remaining 8 fields each have their own dedicated table 
whose name matches the prompt on the field.  
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Contacts 
Although default contact information can be effectively managed via the Customer Account 
command, you may wish to specify marketing information for default contacts or create additional 
contacts, perhaps with different addresses. Select AR > Contacts from the main menu. This is a 
command used for managing contacts. 

Address 
The Address panel is the main data entry area for all contact information. 

 
ID# 

The ID Number is a unique identifier for the contact record. PrintSmith automatically assigns this 
number when the contact is created. 

Name 

The contact name is used to place the contact in alphabetical order in the contact list and to show 
the contact in the Contact List pop up menus. It is always derived from the last name and first name 
of the contact. You can change this name if you wish, but this is not generally recommended 
because if you change any of the contact data in the Contact Editor, the text in the Name field is 
replaced by the last and first name of the contact. 

Acct# 

The Account Number field is the customer account to which a contact is assigned. 
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Account 

The Account field shows the name of the account to which the contact is assigned. Below the 
account name the status of the contact is displayed. If nothing is displayed, the contact is assigned 
to a customer but is neither the shipping nor the billing contact. It may also show <shipping 
contact>, <billing contact>, or <default contact>. Default Contact means that the contact serves as 
both the shipping and billing contact. If the contact is not yet assigned to a customer or prospect, it 
shows “--- not assigned---”. It is also possible that you may see “--MISSING CUSTOMER 
ACCOUNT ---” if the account to which the contact is assigned to was deleted. Contacts not 
assigned to accounts can’t be used in the Estimator. 

Sales Rep 

The Sales Rep field is the sales representative assigned to the contact. It is useful for report 
generation. 

Created 

This is the date that the contact record was initially created. 

Last Used 

This is the date the contact was last used in the Estimator. 

Change Account 

This button is disabled when a default account is selected. PrintSmith always tries to ensure that 
each account has at least one contact, so that marketing activities that are centered on contacts 
don’t inadvertently leave out accounts because there’s no contact. 

There is only one way to change a default contact assignment and that is by using the Customer 
Account command and selecting a different contact using the contact menu. Normally, when an 
account is created, the default contact is created at the same time. 

Use Contact Address 

When enabled, an address editor field becomes available where you can enter an address that is 
specific to this contact. If you select a contact with a separately defined address in the Estimator, 
the contact address is used instead of the account address. 

Default contacts always use the account address, even if you’ve set them up with a separate 
address. 

Shipping Address 

You can create up to 100 shipping addresses for each contact. When an invoice is created and a 
Contact is selected, all of that Contact’s shipping addresses are available in a pop up menu in 
shipping charges.  

To organize the Shipping Address list, simply drag and drop the items into the order you want. The 
buttons located below the Shipping Address list are used for controlling the content of the address 
list. 
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Marketing 
The Contacts Marketing panel operates in the same way as described for an Account.  See page 
184. 

 
 

Summary 
Click the OK button and file the customer account or contact. Repeat this process for each 
customer account and then proceed with your set up. You can enter customers at any point in time. 
It is a great exercise to spread out over several sessions. 
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Adding Contacts to Accounts 
Here are 3 ways to add contacts to any accounts. 

• While creating a document (invoice or estimate) - select the Account, while in the Account Info 
window - select File > New from the main menu or use the shortcut of Command N (Mac) 
Control N (windows).  When you execute this command you'll notice that most of the 
information in the Edit Contact window has been cleared; the phone numbers stay and are 
easy to modify. Add the contact information and close the window. The contact list now shows 
**NEW CONTACT***. Clicking the OK button creates a contact and adds it to the account. Use 
this method too for adding new Accounts on the fly. Create a document, enter the information 
and then select Create Acct/Prospect under the Invoice menu to create a new account and 
new contact. 

• Select AR > Accounts from the main menu. Click on Cancel in the account picker. Enter in 
the Account and Default Contact information. File the account. If you want to add additional 
contacts to this account, click Get, locate the Account and then select the Edit command in the 
Contact list. Click File and you are ready to enter new contact information that will be 
associated to the selected Account. 

• Select AR > Contacts from the main menu. Click on Cancel in the contact picker. Enter the 
Contact information and click Change Account to assign the contact to the appropriate 
account. File the contact. 

Searching for a Customer 
The customer index is searchable. To perform a search, select the data for which you want to 
search from the drop tab at the bottom of the window, type the data you want to search for, and 
click the Find button. 

To find the next occurrence, click the Find button again. To find the previous occurrence hold down 
the <shift> key and click the Find Next button. 

Found items are selected and the Select button is highlighted. Selected items can be opened by: 
pressing the <return> key, clicking the Select button, or simply double-click on the item. 

Prospects 
To access your Customers and Prospects, select Invoice > Create Invoice from the main menu. 

In PrintSmith, Customers are defined as persons with whom you have created invoices. Prospects 
are persons who haven’t done business with you, but you are seeking to turn into Customers. 
When an invoice is created for a Prospect, that Prospect is moved from your Prospects list to your 
Customers list. The differentiation between Customers and Prospects helps to keep your Customer 
database populated with only true Customers. As customers become inactive, they can 
automatically be turned in to prospects based on account aging. 

Your Customers list and Prospects list are both accessible from the Account Picker. 
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Glossary 
Account 

A customer.   Multiple contacts can be assigned to the customer account, and a customer account 
can be assigned to a Master Account.  Select AR > Accounts to manage accounts. 

Access Group 

A security setting which lists all PrintSmith commands available to members of the group.  Access 
Groups are defined in Admin > Security Setup and are assigned to users in Admin > User 
Definitions. 

Bleed 

Extension of a printed image beyond the final trim size of the page. 

Brokered 

An indication for jobs that are sent out for production. 

Caliper 

Paper thickness in thousandths of an inch. 

Charges 

Pricing items associated with printing or duplicating a job.  Charges can be grouped as Pre Press, 
Bindery, Production, Merchandise, Mailing Services, and Miscellaneous.  Charges can be defined 
by selecting Pricing > Charge Definitions. 

Contacts 

Individuals assigned to an account.  Multiple contacts can be set for an account, and selected from 
the Contact List in the Customer Account window.  Select AR > Contacts to manage contacts. 

Costing Method 

Four different costing methods (No Cost, 100% Cost, Unit Cost, Time and Materials) can be 
applied to charges in the Charge Definitions window. 

Cut/100 

A cut charge for each 100 parent sheets.  Set in Pricing > Stock Definitions. 

CWT 

Hundred weight price.  Set in Pricing > Stock Definitions. 

Document 

Refers to an invoice or estimate. 

Folio edge 

Amount of space reserved on an edge of the run sheet for a booklet maker. Used when folding 
signatures to offset the imposed image, leaving one edge of the folded signature overhanging the 
other. 
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Global preference 

Global preferences are set at the Master WorkStation and affect all connected WorkStations.  To 
open Preferences, select Admin > Preferences. 

Gripper edge 

The amount of space required on one feed edge of the run sheet for the press to pick up the paper. 
The size of the gripper edge normally comes from the Press Definition. If not specified there, the 
Paper Calculator Preference panel is used. This amount can be changed on an individual job in the 
Paper Calculator window. 

Gutter 

The space between multiple images on a sheet, most often used to add space in a folded piece. 

Impression 

Set of images produced by one rotation of a plate cylinder. 

Interpolation 

The estimation of a value between two known values. 

IP 

Internet Protocol address, a 32 bit value that is unique to each network device. 

List/M 

Used in Stock Definitions to specify an additional price per thousand sheets for use with the List 
Pricing Method, since list pricing does not factor in stock cost when generating a price. The amount 
(plus or minus) entered is divided by 1000, multiplied by the quantity ordered, and added to the 
price of the job. 

Local preference 

Local preferences only affect an individual WorkStation and are not changed when the pricing 
system is updated.  To open Preferences, select Admin > Preferences. 

M Weight 

Scale weight in pounds of 1,000 sheets of paper of a given size.  Entered in Pricing > Stock 
Definitions. 

Master Account 

A Master Account can be used to link together several sub-accounts.  For example, if three 
departments within a company do business with you, but all payment comes from the Accounts 
Payable department, setup four accounts and set the Accounts Payable department as the Master 
Account.  Master Account is set in the AR > Accounts > Settings tab. 

Master Station 

The main PrintSmith WorkStation in a multi-user system.  The Master Station can act as a stand-
alone or other Workstations can connect to it. 

Micron 

The standard unit of thickness measurement for metric stocks. A micron is one millionth of a meter. 
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Pending List 

New invoices and estimates are placed here.  This window allows you to manage recent estimates, 
work in progress, and completed jobs awaiting pickup or delivery.  To open the Pending List, select 
POS > Pending Document Window. 

Ply 

Traditionally used to indicate thickness of card or chipboard. A sheet of 6-plyboard is 0.024 inch 
thick (multiply the ply value by 3 and add 6 to that result). 

Point 

A unit of thickness for paper equaling 1/1000 inch. 

Prospect 

Persons who haven’t done business with you, but you are seeking to turn into Customers. 

Speed table 

The speed of the press based on quantity produced. 

Stock 

Material to be printed. 

TCP 

Transmission Control Protocol. A transport layer protocol that is part of theTCP/IP protocol suite 
and provides a connection-based, reliable data stream. 

Washup 

To remove ink from a press, washing the rollers and blanket. 

Waste chart 

A calculation of the amount of spoilage based on run length.  The default Waste Chart can be 
accessed by selecting Pricing > Waste Chart. 

White space 

The unused part of the run sheet when the image area is smaller than the run size.  Set in the 
Paper Calculator. 

Work and tumble 

After printing one side of a sheet, turning it over (from the gripper to the tail) using the same guides 
and plate for the second side. 

Work and turn 

After printing one side of a sheet, turning it over (from left to right) using the same side guides and 
plate for the second side. 

Workstation 

A PrintSmith installation on a multi-user system that connects to a Master Station.  Global 
preferences set at the Master Station affect the WorkStation, but some local preferences can be 
set. 
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